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Preface

Purpose
This document describes the installation, function, maintenance, and
troubleshooting methods of the iManager NetEco 1000S V100R003C00 monitoring
software.

Intended Audience
This document is intended for:

● Inverter maintenance personnels
● Electronic technicians with related aptitude

Product Models
This document describes how to use the following Inverter monitoring software:
● SUN2000
● SUN8000

Symbol Conventions
The symbols that may be found in this document are defined as follows:

Symbol Description

Indicates an imminently hazardous situation which,
if not avoided, will result in death or serious injury.

Indicates a potentially hazardous situation which, if
not avoided, could result in death or serious injury.

Indicates a potentially hazardous situation which, if
not avoided, may result in minor or moderate
injury.
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Symbol Description

Indicates a potentially hazardous situation which, if
not avoided, could result in equipment damage,
data loss, performance deterioration, or
unanticipated results.
NOTICE is used to address practices not related to
personal injury.

Calls attention to important information, best
practices and tips.
NOTE is used to address information not related to
personal injury, equipment damage, and
environment deterioration.

 

Change History
Changes between document issues are cumulative. The latest document issue
contains all the changes made in earlier issues.

02 (2019-12-30)
This issue is the second official release for the iManager NetEco 1000S
V100R003C00. Compared with 01(2019-06-30), this issue includes the following
changes.

Navigation Tree Change Description

Operation and Maintenance >
NetEco 1000S Web Client Operation

For details, see 4.1 NetEco 1000S
Web Client Operation.

 

01 (2019-06-30)
This issue is the first official release for the iManager NetEco 1000S V100R003C00.

Draft C (2018-12-20)
This issue is the third release of the iManager NetEco 1000S V100R003C00 beta
version. Compared with Draft B(2018-09-20), this issue includes the following
changes.

Modified
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Navigation Tree Change Description

Operation and Maintenance >
NetEco 1000S Web Client Operation
> Managing Devices

For details, see 4.1.4.6 Remotely
Controlling an Inverter.

Operation and Maintenance >
NetEco 1000S Web Client Operation
> Managing Devices

For details, see 4.1.4.8 Remotely
Controlling a PID Device.

 

New

Navigation Tree Change Description

Operation and Maintenance >
NetEco 1000S Web Client Operation
>FAQs

See 4.1.9.24 How Do I Disable the
Display of the Remote Control
Function?.

 

Draft B (2018-09-20)
This issue is the second release of the iManager NetEco 1000S V100R003C00 beta
version. Compared with Draft A (2018-05-30), this issue includes the following
changes.

Modified

Navigation Tree Change Description

SubscriberPersonal Data For details, see 1 SubscriberPersonal
Data.

Installation and Commissioning >
NetEco 1000S Installation and
Commissioning

For details, see 3.1.5 Logging Out of
the NetEco 1000S Client.

Installation and Commissioning >
NetEco 1000S App Installation and
Commissioning

For details, see 3.2.4 Logging In to
the NetEco 1000S App.

Operation and Maintenance >
NetEco 1000S Web Client Operation
> Getting Started > Logging Out of
the NetEco 1000S

For details, see 4.1.1.2.1 Logging Out
of the NetEco 1000S Client.

Operation and Maintenance >
NetEco 1000S Web Client Operation
> Historical Data Query

For details, see 4.1.6.1 Querying
Alarm Logs.
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Navigation Tree Change Description

Operation and Maintenance >
NetEco 1000S Web Client Operation
> System Management

● For details, see 4.1.8.1.1 User
Categories.

● For details, see 4.1.8.1.2
Registering a User.

● For details, see 4.1.8.1.3 Adding a
User.

Operation and Maintenance >
NetEco 1000S App Operation

● For details, see 4.2.1 Registering a
User.

● For details, see 4.2.2 Logging In to
the NetEco 1000S App.

● For details, see 4.2.3 Creating a PV
Plant.

● For details, see 4.2.4 Connecting
Devices.

 

Deleted

Navigation Tree Change Description

Operation and Maintenance >
NetEco 1000S App Operation

Deleted chapter How Do I Disable the
TLSv1?, since TLSV1 is disabled in the
NetEco 1000S APP.

 

Draft A (2018-05-30)
This issue is the first release of the iManager NetEco 1000S V100R003C00 beta
version.
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1 SubscriberPersonal Data

This section describes the content involved in subscriber personal data, as well as
the principles and methods of collecting and using the data.

Definition of Subscriber Personal Data
Subscriber personal data is the data that can be used alone or together with other
information to identify subscriber entities.

Declaration on Use of Subscriber Personal Data
The NetEco 1000S inevitably uses subscriber personal data, such as the user
account, the email address, mobile number, company information, access IP
address, the IMEI/MEID of a mobile phone, MAC address of a tablet, IDFV
identifier of an iOS device as well as login and operation logs. You are obligated to
take considerable measures, in compliance with applicable laws, regulations, and
subscriber privacy policies of the countries concerned, to ensure full protection for
subscriber personal data.

Principles for Collecting Subscriber Personal Data
Abide by the following principles when using the NetEco 1000S to collect
subscriber personal data:
● Minimize service data you want to collect, and do not collect service-

irrelevant data.
● Do not collect communication content-related data, such as short messages,

multimedia messages, emails, and voice calls.
● Obtain an authorization in written form from the customer before the data

collection. A standard authorization includes the name of the product or
operation requiring authorization, as well as the purpose, content, scope,
validity period, and other conventions of the authorization.

● After the involved task is complete, delete raw data in a timely manner. Do
not save the raw data or dump the data into the database through database
backup.
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Principle for Using Subscriber Personal Data

NO TICE

● Use the collected subscriber personal data within the scope and validity period
of the authorization. Only authorized users can use the data, and logs must be
maintained for future query.

● The original network data cannot be transferred out of the network in a
sensitive country and must not be transferred out of the country or region
where the server is located.
Personal data is stored on the NetEco 1000S server. If the NetEco 1000S server
that a user accesses is not in the country or region where the user is located,
the user's personal data will be transferred out of the country or region where
the server is located. Inform the user of the location of the NetEco 1000S server
so that the user selects the correct NetEco 1000S server, avoiding transferring
personal data out of the country or region where the server is located.

Abide by the following principles when using the U2000 to process subscriber
personal data:

● Minimal use
Do not use communication content or service-irrelevant personal data.

● Clear purpose
Use personal data only for network optimization and quality guarantee.

● Secure protection
Access to personal data is controlled, and sensitive personal data is encrypted
for storage.

Subscriber Personal Data Used by the NetEco 1000S
Due to reasons, such as problem locating, the NetEco 1000S may collect, or
require subscribers to set, certain subscriber personal data to provide support for
problem analysis. Different functions require different data that will be processed
in different ways. For details, see Table 1-1.

NO TICE

To ensure the full implementation of the product functions, perform operations
according to the instructions in the product. Because laws and regulations in
different countries have different requirements on privacy protection, the personal
data list may not cover all the information contained in the privacy statement
required by laws and regulations of your country.
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Table 1-1 Subscriber personal data

Usag
e
Scen
ario

Collecte
d
Persona
l Data

Collecting
Source
and
Method

Purpose and
Security
Protection
Measure

Retention
Period
and
Strategy

Destructi
on
Measure

Export
Method
(Interface,
Command,
etc.) and
Implementat
ion Plan
(Anonymizat
ion,
Pseudonymiz
ation, etc.)

Export
Guide

Regis
terin
g or
creati
ng an
accou
nt or
modi
fying
accou
nt
infor
mati
on

User
name,
email
address,
and
compan
y
informat
ion

When a
user
registers
or creates
an
account or
modifies
account
informatio
n, the
data is
entered on
the web
user
interface
(WebUI)
or app
(the email
address
cannot be
modified).

Used to
register or
create an
account or to
retrieve a
password.
The data is
sent to the
NetEco server
over HTTPS.
The data is
encrypted in
AES128-CBC
mode and
saved in the
database.
The system
administrator
or a user who
has the
permission to
manage the
account can
access the
data. Some
information
is
anonymized
on the UI.

The data
is retained
until the
system
administra
tor or a
user who
has the
permission
to
manage
the
account
deletes
the
account.

The user
name,
email
address,
and
company
informatio
n are
deleted
when the
account is
deleted.

The user
name, email
address, and
company
information
are deleted
when the
account is
deleted.
The personal
data is
exported in
plaintext.

On the
user
manag
ement
page,
click
Export
to
export
the
person
al data
of the
target
accoun
t.
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Usag
e
Scen
ario

Collecte
d
Persona
l Data

Collecting
Source
and
Method

Purpose and
Security
Protection
Measure

Retention
Period
and
Strategy

Destructi
on
Measure

Export
Method
(Interface,
Command,
etc.) and
Implementat
ion Plan
(Anonymizat
ion,
Pseudonymiz
ation, etc.)

Export
Guide

Creat
ing a
PV
plant

Country,
city,
address,
zip code,
and PV
plant
picture

When
creating or
modifying
PV plant
informatio
n, a user
enters the
data on
the WebUI
or app.

Used to
maintain PV
plant
information.
The data is
sent to the
NetEco server
over HTTPS.
The data is
encrypted in
AES128-CBC
mode and
saved in the
database.
The system
administrator
or a user who
has the
permission to
manage the
PV plant can
access the
data.

The data
is retained
until the
system
administra
tor or a
user who
has the
permission
to
manage
the PV
plant
deletes
the PV
plant.

The
country,
city,
address,
zip code,
and PV
plant
picture are
deleted
when the
PV plant is
deleted.

The personal
data is
exported in
plaintext.

On the
Basic
Inform
ation
tab
page,
click
Export
to
export
the PV
plant
person
al data.
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Usag
e
Scen
ario

Collecte
d
Persona
l Data

Collecting
Source
and
Method

Purpose and
Security
Protection
Measure

Retention
Period
and
Strategy

Destructi
on
Measure

Export
Method
(Interface,
Command,
etc.) and
Implementat
ion Plan
(Anonymizat
ion,
Pseudonymiz
ation, etc.)

Export
Guide

Quer
ying
logs

User
name
and IP
address

The data
is
collected
from the
user
equipment
.

Used to
identify the
user
equipment
used to
perform an
operation.
The data is
uploaded to
the log server
over HTTPS.
The logs are
stored in
plaintext and
can be
viewed by
security audit
personnel.

The
retention
period of
the
personal
data is the
same as
that of
logs. The
personal
data is
deleted
together
with the
logs.

The user
name and
IP address
are
deleted
when logs
are
deleted.

The personal
data is
exported in
plaintext.

On the
log
manag
ement
page,
click
Export
to
export
the
person
al data
in the
queried
user
logs.

Settin
g the
notifi
catio
n
serve
r

User
name,
mobile
number,
and
email
address

Users
enter the
data on
the page
for setting
email
server and
SMS
server
parameter
s.

Used to send
notifications
by email or
SMS. The
data is used
to maintain
PV plant
information.
The data is
sent to the
NetEco server
over HTTPS.
The data is
encrypted in
AES128-CBC
mode and
saved in the
database.
The system
administrator
can access
the data.

The data
is retained
until a
user resets
the email
server and
SMS
server
parameter
s.

The data
is deleted
from the
database
when a
user resets
the email
server and
SMS
server
parameter
s.

Export is not
supported.

N/A
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Usag
e
Scen
ario

Collecte
d
Persona
l Data

Collecting
Source
and
Method

Purpose and
Security
Protection
Measure

Retention
Period
and
Strategy

Destructi
on
Measure

Export
Method
(Interface,
Command,
etc.) and
Implementat
ion Plan
(Anonymizat
ion,
Pseudonymiz
ation, etc.)

Export
Guide

Settin
g
remo
te
notifi
catio
n
rules
for
alar
ms
and
repor
ts

Recipien
ts' email
addresse
s and
mobile
numbers

Users
enter the
data on
the WebUI
when
creating a
remote
notificatio
n rule.

Used for
receiving
alarm and
report
information.
The data is
sent to the
NetEco server
over HTTPS.
The data is
encrypted in
AES128-CBC
mode and
saved in the
database.
The system
administrator
or a user who
has the
permission to
manage the
rule can
access the
data. Some
information
is
anonymized
on the UI.

The data
is retained
until the
system
administra
tor or a
user who
has the
permission
to
manage
the
remote
notificatio
n rule
deletes
the rule.

The
recipients'
email
addresses
and
mobile
numbers
are
deleted
when the
remote
notificatio
n rule is
deleted.

You can
select
whether to
export the
data in
plaintext.

On the
alarm
or
report
page,
click
Export
to
export
a
target
remote
notifica
tion
rule.
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Usag
e
Scen
ario

Collecte
d
Persona
l Data

Collecting
Source
and
Method

Purpose and
Security
Protection
Measure

Retention
Period
and
Strategy

Destructi
on
Measure

Export
Method
(Interface,
Command,
etc.) and
Implementat
ion Plan
(Anonymizat
ion,
Pseudonymiz
ation, etc.)

Export
Guide

Settin
g
acces
s
contr
ol
polici
es for
mobil
e
termi
nals

Identific
ation
code of
a mobile
terminal
: IDFV
identifie
r of an
iOS
mobile
terminal
, IMEI/
MEID of
a mobile
phone,
or MAC
address
of a
tablet

The data
is recorded
in the
system by
a user or
collected
from a
user's app
device.

The data is a
service
configuration
parameter
used to
control the
access rights
of mobile
terminals.
The data is
sent to the
NetEco server
over HTTPS.
The data is
encrypted in
AES128-CBC
mode and
saved in the
database.
The system
administrator
can access
the data.
Some
information
is
anonymized
on the UI.

The data
is retained
until the
system
administra
tor deletes
a mobile
terminal
access
control
policy on
the mobile
terminal
access
control
page.

The
identificati
on code of
the mobile
terminal is
deleted
when the
access
control
policy of
the mobile
terminal is
deleted.

The personal
data is
exported in
plaintext.

On the
mobile
termina
l access
control
page,
click
Export
to
export
the
identifi
cation
code of
a
target
mobile
termina
l.
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2 Description

2.1 Product Description

2.2 Security Management Description

2.1 Product Description
For details, see iManager NetEco 1000S V100R003C00 Product Description.pdf.

2.2 Security Management Description
The NetEco 1000S provides various security features and mechanisms to protect
the NetEco 1000S system and the entire operations support system (OSS) network
from attacks and eavesdropping.

2.2.1 Networking Security
Networking security provides policies such as security domain division and firewall
isolation to protect the OSS network.

2.2.1.1 Security Domain Planning

This section describes how to plan security domains. During the initial stage of
networking, system administrator need to divide an OSS network into multiple
subnets based on security domains, separate trusted domains from non-trusted
domains, and properly plan IP addresses. This ensures the security of the OSS
network and NetEco 1000S servers.

Figure 2-1 shows the security domains on an OSS network. The four OSS security
domains are interconnected. Devices in the OSS server domain and device domain
are essential to the OSS network and require the highest security protection level.
Security domains other than the OSS server domain and device domain belong to
subnets that are used for access. Therefore, security risks brought about by these
subnets to the OSS server domain and device domain must be fully considered
before and during the design of security policies for these subnets. Possible
security risks include eavesdropping and network attacks.

iManager NetEco 1000S
User Manual 2 Description

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 8



Figure 2-1 Security domains on an OSS network

OSS Server Domain

The OSS server domain comprises devices (mainly OSS servers such as NetEco
1000S servers and Trace Servers) that are crucial to the entire OSS network. After
connecting to the NetEco 1000S, this domain operates and maintains the entire
network and even controls the network. Therefore, this domain requires the
highest level of security protection. It must be isolated from other domains and
access to devices in this domain must be restricted.

Device Domain

The device domain comprises all NEs managed by the NetEco 1000S, specifically
the units of NEs including SUN, Optimizer, EMI, SmartLogger, PID, PLC, and Meter.

The NEs managed by NetEco 1000S are at the same security level.

OSS Terminal Domain

The OSS terminal domain comprises PCs only for O&M operations on the OSS
network. These PCs may be placed either in central offices where NetEco 1000S
servers are located or in remote equipment rooms where only NEs are located.
This domain comprises of NetEco 1000S clients, and LMTs. These terminals are
applicable only to mobile network devices' O&M services.

The OSS terminal domain and OSS server domain work in similar network
environments, but devices in the OSS terminal domain have lower security levels.
Security policies in this domain depend on customer requirements and network
environments. For example, customers determine whether to install firewalls
between the OSS terminal domain and the OSS server domain or between the
OSS terminal domain and the OSS device domain. By default, customers provide
the VLAN policy.
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Remote Terminal Domain
The remote terminal domain comprises terminals that remotely access the OSS
network, for example, using LANs or dial-up connections. If authorized customers,
device vendors, or third parties want to remotely access to the OSS network,
security control must be implemented because: 1. Uncertainties exist in the
environments where remote O&M terminals are located. 2. Remote O&M
terminals often attempt to access the OSS network through public networks.
Users are advised to disable the access between this domain and the OSS server
domain and provide remote access through a secure VPN channel as required.

2.2.1.2 Firewall Deployment
During OSS network deployment, firewalls must be deployed between the entities.

Firewalls should be deployed between the following entities:

● The OSS server domain and the device domain
● The OSS server domain and the OSS terminal domain
● The device domain and the OSS terminal domain

Policies for deploying firewalls contains: configuring the firewall port and
configuring the IP access.

2.2.2 Platform Security
This section describes operations for enhancing platform security, including
operating system hardening, database hardening, antivirus solution deployment.
These operations increase the security levels of operating systems and databases
and provide a secure and reliable platform for OSS service applications.

In terms of security risks on operating systems, provide security hardening
solutions for increasing the security levels of operating systems and databases.
Figure 2-2 describes the security policies for operating systems and databases.

Figure 2-2 Security policies for operating systems and databases

● OS hardening: You are advised to perform security hardening on the PC
running the NetEco software according to Policies for MySQL Database
Hardening in 2.2.2.1 Operating System and Database Hardening.

● Database hardening: The MySQL database is automatically installed when
you install the NetEco software and has been hardened upon delivery. For
details about the hardening policies, see Policies for MySQL Database
Hardening in 2.2.2.1 Operating System and Database Hardening.

● Antivirus software: The NetEco software does not contain the antivirus
software for the OS upon factory delivery. You need to install the mainstream
commercial antivirus software on the OS of the NetEco.
Third-party antivirus software is integrated into Huawei products to protect
Windows against virus and worm threats.
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2.2.2.1 Operating System and Database Hardening

Security hardening policies are based on the features of NetEco 1000S service
applications. The policies can increase the security levels of operating systems and
databases.

Policies for Windows Hardening

Main policies for Windows hardening are as follows:

● Set auditing and user account policies.
– Auditing policies:

Set events to be audited, such as events about user account login and
management success and failure.

– User account policies:
Set attributes for user account passwords, such as shortest and longest
storage duration, length, and complexity.

– Policies for locking user accounts:
Set thresholds for user account locking, locking duration, and time for
resetting the account-locking timer.

– Event log settings:
Set logs that user Guest cannot query, event log size, and storage mode.
Event logs include application logs, security logs, and system logs.

● Security options:
For example, user account, auditing, network security, and network access.

● More security protection polices:
For example, shared folder deletion, registry settings, user rights assignment,
firewall settings, and directory permission settings.

For details about the hardening policies and suggested measures, see 2.2.2.2 Windows OS
Security Hardening.

You are advised to use the mainstream commercial Windows hardening tool to harden the
Windows OS.

Policies for MySQL Database Hardening

The policies for hardening the MySQL database are as follows:

● Installation and configuration
– Control the user who can access the MySQL.user table.
– Control the access to the MySQL database.
– Set the maximum number of allowed login attempts.
– Close default ports.
– Record user login.
– Change the password of the database administrator and delete empty

passwords.

iManager NetEco 1000S
User Manual 2 Description

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 11



– Add the password complexity check for database users.
– Set the timeout interval for database connection.

● Permission minimization management
– Manage authorization with the GRANT option.
– Forbid users other than the database administrator to access the objects

in the MySQL database.
– Set the OS rights for the MySQL installation path.
– Set the OS rights for the MySQL parameter file.
– Set the OS rights for the MySQL log file.
– Forbid the remote login of database administrators.
– Forbid database access from another PC.
– Delete the default test database.

The user administrator in the MySQL database hardening policies is the system
administrator of MySQL database.

Database security hardening has been performed for NetEco 1000S V100R003C00 upon
factory delivery.

2.2.2.2 Windows OS Security Hardening
When the NetEco 1000S software runs on Windows, perform security hardening
for the Windows OS to improve the NetEco 1000S security.

Prerequisites
You have obtained the SecureCAT SetWin.exe installation package for the
security hardening tool and the SetWin_2K12R2_CIS_V1.1.0.inf configuration file
from Huawei technical support engineers.

Context
The NetEco 1000S can run on Windows 7, Windows 10 or Windows Server 2012.

This section describes how to perform security hardening for the Windows Server
2012 OS. To learn the detailed security hardening policy for Windows 7 and
Windows 10, see Windows OS Security Hardening Policy.pdf.

Procedure

Step 1 Copy SecureCAT SetWin.exe and SetWin_2K12R2_CIS_V1.1.0.inf to the Windows
Server 2012 OS to be hardened.

Step 2 Double-click SecureCAT SetWin.exe to install the security hardening tool.

After the installation is complete, the SetWin icon is displayed on the desktop.

Step 3 Right-click the SetWin icon and choose Run as Administrator from the shortcut
menu.

The home page of the SetWin tool is displayed, as shown in Figure 2-3.
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Figure 2-3 SetWin home page

Step 4 Click Language on the menu bar.

The tool supports Chinese and English (default). After changing the language,
restart the tool for the change to take effect.

Step 5 Choose Configuration > Import Configuration File.

In the displayed Open File to import dialog box, select the
SetWin_2K12R2_CIS_V1.1.0.inf file saved in Step 1.

Step 6 When the "Import successful" message is displayed, click OK.

Step 7 Back up the OS.

1. Choose Policy > Roll back.
A message is displayed, prompting you to confirm that the user password
meets the requirements.

2. Click Yes.
A dialog box is displayed for you to save the backup file.

3. Set a name for the backup file and click Save.
It is recommended that the backup file be named after the current date.

Step 8 Optional: Configure the security hardening policy.

Set security hardening items in the left navigation tree on the Policy tab page.
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NO TICE

● If you perform security hardening remotely, choose SetWin Policies > Security
Settings > Security Options > Network Security in the left navigation tree
and clear LAN Manager authentication in the right pane. If LAN Manager
authentication is not cleared, remote access to the OS will fail after security
hardening.

● The item Rename administrator account is under SetWin Policies > Security
Settings > Security Options > Accounts. After security hardening, the system
administrator will be renamed SWMaster. If you do not want the system
administrator user to be renamed, clear Rename administrator account.

Step 9 Choose Policy > Execute.

The message shown in Figure 2-4 is displayed.

Figure 2-4 Confirming password complexity

Step 10 Click Yes.

The message shown in Figure 2-5 is displayed.
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Figure 2-5 Confirming policy execution

Step 11 Click Yes.

When a browser is displayed, click Allow blocked content. The browser displays
the execution status of each security hardening item. If an item fails to be
executed, view the operation logs and solve the problem. If the problem persists,
roll back the operation by following instructions provided in Exception Handling.

When the "Execution completed" message indicating completion of security
hardening is displayed, click OK. A dialog box is displayed, prompting you whether
to restart the OS for the policy to take effect. Do not restart the OS because you
still need to configure the firewall port.

Step 12 Configure the firewall port.

1. Open the control panel.
2. Choose Windows Firewall > Advanced settings.

The Windows Firewall with Advanced Security page is displayed.
3. In the left navigation tree, right-click Inbound Rules and choose New Rule.

The New Inbound Rule Wizard page is displayed.
4. In the Rule Type pane, select Port and click Next.
5. Select Specific local ports and enter

8010,80,8443,443,27200,33000,16100,27250,11000-11500,2121 in the text
box.

6. Click Next until you go to the pane for setting a rule name.
Set a rule name.

7. Click Finish.
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If the created rule is displayed in the Inbound Rules pane and the rule state is , the rule
has taken effect.

Step 13 Restart the OS to complete security hardening.

----End

Exception Handling

If the security hardening operation fails or you want to cancel it, perform the
following steps to roll back the operation:

Step 1 Right-click the SetWin icon and choose Run as Administrator.

The login page is displayed.

Step 2 Enter the user name and password and click Yes.

After performing security hardening, you must enter the user name and password
of the administrator to log in to the tool.

If Rename administrator account is selected for the security hardening policy in
Step 8 in Procedure, the user name of the system administrator is automatically
changed to SWMaster. The password remains unchanged.

Step 3 Choose Policy > Roll back.

The Open Rollback File dialog box is displayed.

Step 4 Select the file backed up in Step 7 in Procedure.

The rollback automatically starts. When the rollback is complete, you will be asked
whether to restart the OS for the configuration to take effect. Determine whether
to restart the OS based on the actual situation.

----End

2.2.2.3 Antivirus Solutions for Operating Systems

This section describes the antivirus solutions for operating systems to prevent
viruses from attacking NetEco 1000S software and virus spreading.

The NetEco 1000S software does not contain the antivirus software for the OS
upon factory delivery. You need to install the mainstream commercial antivirus
software on the OS of the NetEco 1000S.

● Update the antivirus software to the latest version in time.
● Enable the firewall.
● Enable the anti-DoS attack function.
● Enable the anti-port-scanning function.

The preceding measures are some common functions of the antivirus software. To ensure
your information security, you must enable these functions in time.
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2.2.3 Application Security
This section describes application security solutions dedicated to service
applications, such as user management, session management, and log
management.

2.2.3.1 User Authentication and Authorization Management
The system administrator must authenticate users and manage authorities so that
only authorized users can log in to the system and perform operations. This
ensures system security.

Users need to enter correct user names and passwords to log in to the NetEco
1000S. After user authentication succeeds, the NetEco 1000S authenticates user
operations and users can perform only the operations that they are allowed to
preform.

Role-based User Management Policies
● The NetEco 1000S system provides six types of roles: system administrator,

managers, installers, guest users, customers, and OpenAPI users.
● Role system administrator needs to classify users into the corresponding roles

based on the management mode.
● Role system administrator is unique and cannot be added, modified or

deleted.

User Information and Password Policies
● User information policies

User information managed on the NetEco 1000S includes the user name,
description, account validity, password, password validity period, user type.

● Password policies
Password policies include:
– Password complexity policy: Complex passwords are required to reduce

possibility of password cracking. Security administrators can set the
password complexity policy on the NetEco 1000S client. For details about
password complexity requirements, please see 4.1.8.1.8 Setting a
Password Policy.

– Password update policy: Security administrators need to pose restrictions
on password updates, such as password update period, message
prompting for a new password, and password validity period, to ensure
that users update passwords timely.

Authority Management Policies
Five types of roles provided by the NetEco 1000S system have different rights. You
can set user rights by specifying roles for users. For details about the role rights,
please see 4.1.8.1.1 User Categories.

Idle Logout Time
The NetEco 1000S supports automatic client automatically logged out. If a user
does not perform any operations during the preset period, the NetEco 1000S client
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automatically logged out. When the user attempts to log in to the NetEco 1000S
client again, the user name and password are required.

2.2.3.2 Log Auditing
System administrator can audit operations and activities performed by NetEco
1000S users and check for any illegal user operations.
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3 Installation and Commissioning

3.1 NetEco 1000S Installation and Commissioning

3.2 NetEco 1000S App Installation and Commissioning

3.3 Planning Operating System Users and Their Initial Passwords

3.4 Communication Matrix

3.1 NetEco 1000S Installation and Commissioning
This section describe the installation and commissioning procedures of NetEco
1000S.

3.1.1 Installing Hardware

Direct Connection Using the RS232 Cable

Direct connection using the RS232 cable: It is applicable only to local
commissioning. In this case, you can search for Inverter based on serial port
addresses.

Direct connection using the the RS232 cable applies only to the Windows 7 OS. The
following serial port-related functions are available only in the Windows 7 OS:

● Searching for Devices Based on Serial Port Addresses

● Setting Parameters for the SMS Modem

● Setting Communication Parameters

You can connect the RS485 serial port on the Inverters to the idle RS232 serial
port on the PC by using the RS232 cable (RS485 needs to be converted to RS232
through the signal converter). You can also connect multiple Inverters to one
RS485 bus which is connected to the PC serial port.

● The serial port number is the one used for connecting the monitoring PC and
a device.
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● The address of the RS485 bus is the RS485 Com Address of the Inverter. For
details about how to obtain this address, see the corresponding User Manual
on the monitored device side.
Contact Huawei technical support engineers to obtain the User Manual on
the monitored device side.

NO TICE

It is recommended that no more than six inverters be connected to the bus for
better monitoring performance.
If new physical or logical serial ports are added on the PC on which the NetEco
1000S is running, you need to restart the NetEco 1000S. Otherwise, the newly
added ports cannot be automatically identified by the NetEco 1000S.
Currently, the serial-port connection mode does not support security
authentication, which may introduce security risks. You are advised to use network
cables for connection.

Connection by Using Network Cables
Connection by using network cables: It is applicable to remote Inverter monitoring.
In this case, you can search for target device based on IP addresses.

● Connection using the SmartLogger: Connect the inverter, EMI, PID, PLC, or
Meter to the SmartLogger and then connect the SmartLogger to the
monitoring PC through an IP network.
The IP address is that of the SmartLogger. For details about how to obtain the
IP address, see the corresponding Smart Logger User Manual.
Contact Huawei technical support engineers to obtain the Smart Logger User
Manual.

● Direct connection to the FE: Inverters that support direct connection to the FE
can be directly connected to the FE and can access the NetEco 1000S through
the client.

● 4G distributed: Inverters that support the 4G module can connect to the
NetEco 1000S through the 4G network.

3.1.2 Installing the NetEco 1000S Software

Preinstallation Check
Before installing the NetEco 1000S software, check whether the PC meets the
requirements listed in Table 3-1.
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Table 3-1 Preinstallation check item

Check
Item

Description

Software
package

Contacted Huawei technical support engineers to obtain the
software package
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zi
p or
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterpr
ise.zip. Contact the Huawei technical support engineers and
obtain the signature files
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zi
p.asc or
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterpr
ise.zip.asc
● For carriers: To obtain the software package, Huawei technical

support engineers can choose Support > Software > Network
Energy > PV Inverter > Smart PV Plant System > iManager
NetEco 1000S > V100R003C00 at http://
support.huawei.com/carrier/.

● For enterprises: To obtain the software package, Huawei
technical support engineers can choose SUPPORT > Network
Energy > Energy Common > iManager NetEco 1000S at
http://support.huawei.com/enterprise.

NOTE
● If the Windows Server 2012 OS is used, obtain the

iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zi
p installation package and
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zi
p.asc digital signature file.

● If the Windows 7 or Windows 10 OS is used, obtain the
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip
installation package and
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip.asc
digital signature file.

You can check the integrity of the software package by referring
to 4.1.9.7 Verifying OpenPGP Signature.
NOTE

Software package integrity check is related to the software security. You
must perform the check to ensure the software security.

Hardware Minimum configuration:
● Standard edition: CPU: 1*quad-core 2.4 GHz; memory: 4 GB;

hard disk: 250 GB
● Enterprise edition: CPU: 1*octa-core 2.4 GHz; memory: 12 GB;

hard disk: 600GB

iManager NetEco 1000S
User Manual 3 Installation and Commissioning

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 21

http://support.huawei.com/carrier/
http://support.huawei.com/carrier/
http://support.huawei.com/enterprise


Check
Item

Description

Recommended configuration:
● Standard edition: CPU: 1*quad-core 3.6 GHz; memory: 4 GB;

hard disk: 500 GB or above
● Enterprise edition: CPU: 2*octa-core 3.6 GHz; memory: 16 GB;

hard disk: 2TB or above

Software Operating system:
● Standard edition: Windows 7 professional edition, Windows 7

enterprise edition, Windows 10 professional edition, or
Windows 10 enterprise edition

● Enterprise edition: Windows Server 2012 standard edition
NOTE

The NetEco 1000S supports the Chinese, English, German, French, and
Japanese operating systems. For the Chinese, German, French, and
Japanese operating systems, only the NetEco 1000S with the same
language can be installed. For the English operating system, there is no
requirement on the language of the NetEco 1000S.

Web browser: Internet Explorer 11 or Chrome 50.

● The antivirus software that can be updated properly must be
installed on the PC.
NOTE

For some antivirus software in the market such as 360, ensure that the
installation path of the NetEco 1000S is added to the whitelist of the
antivirus software. Otherwise, the NetEco 1000S functions may be
affected.

● You are not advised to install other applications.
● You are not allowed to install the MySQL database.
● Services that are unnecessary or have potential security risks

must be disabled.
● Operating system patches must be updated in a timely

manner.

Only users in the system administrator group can install the
NetEco 1000S.
NOTICE

Only a fixed user in the system administrator group can install and
maintain the NetEco 1000S. Other users in the system administrator group
are not allowed to reinstall the NetEco 1000S. Otherwise, the database for
the installed NetEco 1000S will be initialized and all data will be lost.
You are not allowed to share the NetEco 1000S installation directory with
other system accounts or grant the NetEco 1000S permission to other
system accounts. Otherwise, security risks may occur.
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Procedure

NO TICE

● The path where the software package is decompressed consists of only letters
or contains letters, digits, and underscores (_). Otherwise, the installation fails.

● You are not allowed to install the software in a system volume.
● You are not allowed to share the NetEco 1000S installation directory with other

system accounts or grant the NetEco 1000S permission to other system
accounts. Otherwise, the software cannot be used.

● You are not allowed to change the OS time whereas installing the software.
● After the software is installed successfully, you are advised to remove the

software package. Otherwise, security risks may occur.

Step 1 After the software package is decompressed, double-click setup.bat in the folder.

During the installation, you can click Cancel in any window that has the Cancel button. A
Are you sure to cancel installation? dialog box is displayed.
● Click Yes to exit the installation.
● Click No to continue the installation.

The Select Setup Language window is displayed.

Figure 3-1 Select Setup Language

Step 2 Choose English, and click OK.

The Introduction window is displayed.

Step 3 Click Next.

The Copyright Notice window is displayed. Read the terms of the copyright notice
in the Copyright Notice window.
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Figure 3-2 Copyright Notice

Step 4 Select I agree, and click Next.

The Select Installation Directory window is displayed.

The default installation directory is D:\NetEco1000S\NetEco1000S.

Figure 3-3 Select Installation Directory
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Step 5 Specify an installation directory and click Next.

The installation directory consists of only letters or contains letters, digits, and underscores
(_). The installation directory length cannot exceed 50 characters.
If the specified installation directory does not exist, the following information is displayed.
The directory D:\NetEco1000S\NetEco1000S does not exit. Do you want to create it?

● Click Yes to create the specified installation directory.
● Click No to return to the last step to re-specify an installation directory.

The Set Currency and TimeZone Parameters window is displayed.

Figure 3-4 Set Currency and TimeZone Parameters

Step 6 Choose the currency and time zone you need, and click Next.

The Parameters Settings window is displayed.
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Figure 3-5 Parameters Settings

Step 7 Select whether to enable the Self-registration account and User authorization,
and click Next.

Table 3-2 lists the parameter details.

Table 3-2 Installation parameter details

Parameter Description

Self-registration
authorization

Two options are available:
● Enable: After the self-registration account is enabled,

users can register on the login screen of the
management system. User authorization must be
enabled when the self-registration account is enabled.

● Disable: After self-registration account is disabled, the
Register button is no longer displayed on the login page
of the management system. If you need to enable the
self-registration account function, enable self-
registration authorization according to 4.1.8.4.9 Setting
Self-Registration Account.

User
authorization

Two options are available:
● Enable
● Disable
After user authorization is enabled, the Privacy Policy and
Terms of Use will be displayed upon the user's first login.
The user needs to read and agree to them before the user
continues accessing the management system.

 

The Select Software Components window is displayed.
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Step 8 Select NetEco 1000S for installation and click Next.

The Confirm Installation window is displayed.

Step 9 Confirm the installation settings and click Next.

The installation status window is displayed.

The Installation Completed window is displayed after the installation process
reaches 100%.

Step 10 Click Finish.

When the software is installed successfully, the NetEco 1000S shortcut menu is
available under Start > All Program.

----End

3.1.3 Starting NetEco 1000S Services
This section describes how to start the NetEco 1000S services. Before logging in to
the NetEco 1000S, you need to start the NetEco 1000S services. Otherwise, the
login will be fail.

Procedure

Step 1 Choose Start > All Program > NetEco 1000S > NetEco 1000S Service to start the
NetEco 1000S services in the operating system.

● When the service is starting, the icon  is displayed in the lower right
corner of the taskbar of the desktop.

● After being started, the icon  is
displayed in the lower right corner of the taskbar of the desktop.

----End

Related Operations

Stop NetEco 1000S services.

Right-click the NetEco 1000S service icon in the lower right corner of the taskbar
of the desktop and choose Exit from the shortcut menu.

3.1.4 Logging In to the NetEco 1000S Client
This section describes how to log in to the NetEco 1000S before using the service
functions supported by NetEco 1000S.

Prerequisites
● You have started the NetEco 1000S services. For details about how to start the

services, see 3.1.3 Starting NetEco 1000S Services.
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● You have obtained the user Account/Email and password for logging in to the
NetEco 1000S.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Open the web browser.

NO TICE

The web browser must be Internet Explorer 11 or Chrome 50. Otherwise, some
browser problems may occur when users query data.

Step 2 Enter IP/domain name in the address bar, and press Enter.

A page similar to Figure 3-6 or Figure 3-7 that warns you of the risks will be
displayed when you try to access the NetEco 1000S login page.

Figure 3-6 Website Security Certificate window (Internet Explorer)
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Figure 3-7 Website Security Certificate window (Chrome 50)

● When using the Internet Explorer, click Continue to this website (not
recommended) in Figure 3-6.

● When using the Chrome, choose Advanced > Proceed to IP or domain name
(unsafe) in Figure 3-7.

The Login window is displayed, as shown in Figure 3-8.

Figure 3-8 Login

Step 3 On the Login page, select a language to be used by the NetEco 1000S from the
drop-down list box.

Step 4 Enter Account/Email and Password, and click Login.
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NO TICE

If the User Authorization page is displayed here, select Agree to the Privacy
Policy and Agree to the Terms of Use before clicking OK to continue the
operations.

The System Initial Password page is automatically displayed after the password
expires. Change the password and log in to the NetEco 1000S using the new
password.

NO TICE

● To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every
six months). If the password is lost, stolen, or cracked, the user shall be liable
for any loss incurred.

● The password cannot be the user name or the reversed user name.
● The length ranges from 8 to 32 characters.
● The password contains three of the following:

– Lowercase letters
– Uppercase letters
– Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

----End

3.1.5 Logging Out of the NetEco 1000S Client

Procedure

Click Logout in the user name drop-down list from the main menu to log out. The
Login page is displayed.

3.1.6 Logging Out of the NetEco 1000S Services

Prerequisites

You have logged out of the NetEco 1000S client. For detailed operations, see 3.1.5
Logging Out of the NetEco 1000S Client.

Procedure

Step 1 Right-click the NetEco 1000S service icon  in the lower right corner of the task
bar of the desktop and choose Exit from the shortcut menu.

iManager NetEco 1000S
User Manual 3 Installation and Commissioning

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 30



If the  icon is not displayed in the lower right corner in the Windows operating system,
perform the following steps to stop the NetEco 1000S services:

1. Start the task manager.

2. Click the Services tab.

3. Stop the NetEcoSUNService Service.

4. Stop the NetEcoSUNMysql Service.

----End

3.1.7 Remove the NetEco 1000S Software
This section describes how to remove the NetEco 1000S software.

Procedure

Step 1 Right-click NetEco 1000S in the lower right corner of the desktop and choose Exit
from the shortcut menu.

If the NetEco 1000S service is not started, skip this step.

Step 2 Choose Start > All Program > NetEco 1000S > Uninstall NetEco 1000S in the
operating system to start the uninstallation program.

The Select Software Components window is displayed.

Step 3 Select the NetEco 1000S component, and click Next.

Step 4 Click Yes.

The NetEco 1000S uninstallation progress is displayed in the window.

Step 5 Click Finish when the uninstallation is complete.

The Conformation dialog box is displayed.

Step 6 Determine whether to restart the operating system.

● If you click Yes, the operating system is restarted, and the NetEco 1000S
installation directory is deleted automatically.

● If you click No, the operating system will not be restarted, and you need to
manually delete the NetEco 1000S installation directory.

----End

3.2 NetEco 1000S App Installation and Commissioning
This section describes installation and commissioning procedure of NetEco 1000S
app.
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3.2.1 NetEco 1000S App Networking
This section describes the networking schemes when the NetEco 1000S app is
used on the mobile device.

The mobile device supports the following two typical networking schemes when
the NetEco 1000S app is used on the mobile device:

Customers are responsible for all network design and network-device-level security
planning.

● The mobile device is connected to the internal network of the NetEco 1000S
directly. Figure 3-9 shows the networking diagram.

Figure 3-9 Mobile device connecting to the internal network of the NetEco
1000S directly

NO TICE

The following requirements must be met when the mobile device is directly
connected to the internal network:
● You have configured a wireless router in the internal network.
● The mobile device is located in an area covered by Wi-Fi signals.

● The mobile device is connected to the internal network of the NetEco 1000S
through the virtual private network (VPN). Figure 3-10 shows the networking
diagram.

Figure 3-10 Mobile device connecting to the internal network of the NetEco
1000S through the VPN
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NO TICE

The following requirements must be met when the mobile device is connected to
the internal network through the VPN:

● The VPN device is installed on the customer's internal network.

● Parameters, including the network port and virtual gateway, of the VPN device
are configured through the serial port or network port on the PC.

Configuration methods and parameters of the VPN devices vary with the
vendors. For details, see the VPN device description.

● Mobile terminal VPN access is configured on the mobile device. For example,
choose Settings > Wireless&networks; > VPN > Add VPN network on a
Huawei mobile phone to configure the VPN access.

● Port 33000 of the NetEco 1000S server is opened.

3.2.2 Installing the NetEco 1000S App Software
This section describes the operating environment requirements of NetEco 1000S
app, how to download and install the NetEco 1000S app software.

Preinstallation Check

Before installing the NetEco 1000S app software, check whether the mobile device
meets the requirements listed in Table 3-3.

Table 3-3 Check items

Check
Item

Description

Operatin
g
environ
ment

When the NetEco 1000S app runs on a mobile device, the mobile
device must meet the following requirements:
● The mobile device must run the following OSs:

– Mobile phone or Pad running the OS later than Android 5.0
– Mobile phone or iPad running the OS later than iOS 6.0

● The mobile device is connected to the Internet properly. The rate
is 500 kbit/s and higher.

● There are sufficient space and power on the mobile device so that
new apps can be installed.

Software
package

The NetEco 1000S app software package has been obtained. If it is
not obtained, download it using the following methods:
● Mobile device running Android: Search for neteco on the Google

Play or Huawei AppGallery.
● Mobile device running IOS: Search for neteco on the APP Store.
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Procedure
1. Click the NetEco 1000S app software package, and then install the NetEco

1000S app software according to the system information.

After the installation is complete, the icon of the NetEco 1000S app is
displayed on the desktop of the mobile device.

3.2.3 Security Configuration for NetEco 1000S App
To ensure system security, you must perform the following configurations before
accessing the NetEco 1000S system through the NetEco 1000S APP.

Context

The identification number of the mobile terminal has been anonymized on the
NetEco 1000S APP screen to protect user's privacy.

Procedure

Step 1 Obtain the identification number of the mobile terminal.

Identification number of the iOS mobile terminal is the IDFV identifier. Identification
numbers of other mobile terminals are IMEIs/MEIDs of mobile phones or MAC addresses of
tablets.

● Method of obtaining the IDFV identifier: When using the iOS mobile terminal
to log in to the NetEco 1000S APP, click IDFV on the login page to view the
identifier.

● Method of obtaining the IMEI/MEID: Enter *#06# in the dial keyboard of your
mobile phone.

● Method of obtaining the MAC address: Choose Settings > WLAN > Advanced
settings on your tablet to view the MAC address.

The navigation path of Advanced settings may vary depending on the OS version.
Choose the corresponding path as required.

Step 2 Add the identification number of the mobile terminal to the NetEco 1000S.

1. Log in to the NetEco 1000S system through the web browser.

2. Choose System > User Management from the main menu.

3. Click Mobile Terminal, and then add the identification number of the mobile
terminal.

----End

3.2.4 Logging In to the NetEco 1000S App
Before using the NetEco 1000S app, you must log in to it.
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Prerequisites
● You have added the identification number of the mobile terminal in the

NetEco 1000S system. For details, see 3.2.3 Security Configuration for
NetEco 1000S App.

● You have installed the NetEco 1000S app software on the mobile terminal.
For details, see 3.2.2 Installing the NetEco 1000S App Software.

● You have obtained the user Account/Email and password for logging in to
NetEco 1000S app.

● The mobile terminal has been connected to the network.

Context
The NetEco 1000S app can be installed on mobile terminals running IOS 6.0,
Android 5.0, and later versions. The NetEco 1000S app supports the TLSv2
communication protocol.

Procedure

Step 1 Tap the NetEco 1000S app icon on the desktop of the mobile terminal to open the
login screen, as shown in Figure 3-11.

Figure 3-11 Login screen

Step 2 Optional: Specify the IP address or domain name of the NetEco 1000S server if
this is the first time that you log in to the NetEco 1000S app.

Step 3 Enter the user's Account/Email and password.

If you select Remember password, you can log in to the home page of the app next time
simply by tapping Login.
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Step 4 Tap Login.

NO TICE

If you are redirected to the User Authorization page, you need to select I have
read and agree to the Privacy Policy and Terms of Use before tapping OK to
proceed to the next step. To decide whether to enable the User authorization, see
3.1.2 Installing the NetEco 1000S Software for details.

After the login is successful, the home page of the NetEco 1000S app is displayed.

----End

3.3 Planning Operating System Users and Their Initial
Passwords

This section describes the user names and their initial passwords required during
the operation of the NetEco 1000S system.

Table 3-4 lists the user names and initial passwords required during the
installation and operation of the NetEco 1000S system, and their creation time.

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Table 3-4 Planning of user names and passwords

System or
Device

User
Name

Initial
User
Passwor
d

Description How to Change
the Password

MySQL adminis
trator

NetEco_1
23

Administrator who
managing the
MySQL database.

You are advised to
change the
password after you
install the NetEco
1000S for the first
time, and change
the password every
three months.
For details, see
4.3.1.1.2 Changing
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System or
Device

User
Name

Initial
User
Passwor
d

Description How to Change
the Password

dbuser NetEco_1
23

User used for NetEco
1000S system access
the MySQL database.

the Passwords of
MySQL Users.

NetEco
1000S

admin Changem
e123

User who operates
and maintains the
NetEco 1000S
system. You can
manage the NetEco
1000S users by
creating users.
NOTE

When you log in to
the NetEco 1000S for
the first time, the
system forces the user
to change the
password to make sure
the security of visiting
the system.

You are advised to
change the
password after you
install the NetEco
1000S for the first
time, and change
the password every
three months. For
details, see
4.1.8.1.6
Modifying the
Password of the
Current User.

emsco
mm

/EzFp
+2%r6@I
xSCv

User used for the
reauthentication of
the device and
NetEco 1000S.

You are advised to
change the
password after you
install the NetEco
1000S for the first
time, and change
the password every
three months. For
details, see 4.1.4.9
Changing the
Authentication
Passwords of the
SmartLogger and
NetEco 1000S.

ftpuser NetEco12
3

User ftpuser is used
by the NetEco 1000S
to transfer NetEco
1000S files. Normally,
during the
installation of the
NetEco 1000S, user
ftpuser is
automatically created
in the system, and
therefore you need
not create user
ftpuser manually.

You are advised to
change the
password after you
install the NetEco
1000S for the first
time, and change
the password every
three months.
For details, see
4.1.9.13 How Do I
Change the
Password of the
ftpuser user?.
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System or
Device

User
Name

Initial
User
Passwor
d

Description How to Change
the Password

plantco
ntroller

Modifym
e123

User used for the
Plant Controller
devices to transfer
files to the NetEco
1000S.

You are advised to
change the
password after you
install the NetEco
1000S for the first
time, and change
the password every
three months.
For details, see
4.1.9.17 How Do I
Change the
Password of the
plantcontroller
user?.

 

3.4 Communication Matrix
For details, see iManager NetEco 1000S V100R003C00 Communication Matrix.xls.
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4 Operation and Maintenance

4.1 NetEco 1000S Web Client Operation

4.2 NetEco 1000S App Operation

4.3 NetEco 1000S Maintenance

4.1 NetEco 1000S Web Client Operation
This section describes how to log in to the NetEco 1000S and how to perform the
operations to the NetEco 1000S on the web client.

Delivering a reset, shutdown, or upgrade command to the solar inverters or pid
device may cause power grid connection failure, which affects the energy yield.
Only professionals are allowed to set the grid parameters, protection parameters,
feature parameters, and power adjustment parameters of the solar inverters or pid
device. If the grid parameters, protection parameters, and feature parameters are
incorrectly set, the solar inverters or pid device may not connect to the power grid.
If the power adjustment parameters are incorrectly set, the solar inverters or pid
device may not connect to the power grid as required. In these cases, the energy
yield will be affected.

You are not allowed to change the OS time whereas the software is running.
When you need to change the OS time, you must log out the NetEco service first,
for details, see 4.1.1.2 Logging Out of the NetEco 1000S.

4.1.1 Getting Started

4.1.1.1 Logging In to the NetEco 1000S
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4.1.1.1.1 Starting NetEco 1000S Services

This section describes how to start the NetEco 1000S services. Before logging in to
the NetEco 1000S, you need to start the NetEco 1000S services. Otherwise, the
login will be fail.

Procedure

Step 1 Choose Start > All Program > NetEco 1000S > NetEco 1000S Service to start the
NetEco 1000S services in the operating system.

● When the service is starting, the icon  is displayed in the lower right corner
of the taskbar of the desktop.

● After being started, the icon  is
displayed in the lower right corner of the taskbar of the desktop.

----End

Related Operations

Stop NetEco 1000S services.

Right-click the NetEco 1000S service icon in the lower right corner of the taskbar
of the desktop and choose Exit from the shortcut menu.

4.1.1.1.2 Logging In to the NetEco 1000S Client

This section describes how to log in to the NetEco 1000S before using the service
functions supported by NetEco 1000S.

Prerequisites

You have obtained the user Account/Email and password for logging in to the
NetEco 1000S.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Open the web browser.
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NO TICE

The web browser must be Internet Explorer 11 or Chrome 50. Otherwise, some
browser problems may occur when users query data.

Step 2 Enter IP/domain name in the address bar, and press Enter.

A page similar to Figure 4-1 or Figure 4-2 that warns you of the risks will be
displayed when you try to access the NetEco 1000S login page.

Figure 4-1 Website Security Certificate window (Internet Explorer)

Figure 4-2 Website Security Certificate window (Chrome 50)

● When using the Internet Explorer, click Continue to this website (not
recommended) in Figure 4-1.

● When using the Chrome, choose Advanced > Proceed to IP or domain name
(unsafe) in Figure 4-2.

The Login window is displayed, as shown in Figure 4-3.
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Figure 4-3 Login

Step 3 On the Login page, select a language to be used by the NetEco 1000S from the
drop-down list box.

Step 4 Enter Account/Email and Password, and click Login.

NO TICE

If the User Authorization page is displayed here, select Agree to the Privacy
Policy and Agree to the Terms of Use before clicking OK to continue the
operations.

The System Initial Password page is automatically displayed after the password
expires. Change the password and log in to the NetEco 1000S using the new
password.
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NO TICE

● To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every
six months). If the password is lost, stolen, or cracked, the user shall be liable
for any loss incurred.

● The password cannot be the user name or the reversed user name.
● The length ranges from 8 to 32 characters.
● The password contains three of the following:

– Lowercase letters
– Uppercase letters
– Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

----End

4.1.1.2 Logging Out of the NetEco 1000S

4.1.1.2.1 Logging Out of the NetEco 1000S Client

Procedure
Click Logout in the user name drop-down list from the main menu to log out. The
Login page is displayed.

4.1.1.2.2 Logging Out of the NetEco 1000S Services

Prerequisites
You have logged out of the NetEco 1000S client. For detailed operations, see
4.1.1.2.1 Logging Out of the NetEco 1000S Client.

Procedure

Step 1 Right-click the NetEco 1000S service icon  in the lower right corner of the task
bar of the desktop and choose Exit from the shortcut menu.

If the  icon is not displayed in the lower right corner in the Windows operating system,
perform the following steps to stop the NetEco 1000S services:
1. Start the task manager.
2. Click the Services tab.
3. Stop the NetEcoSUNService Service.
4. Stop the NetEcoSUNMysql Service.

----End
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4.1.1.3 Getting to Know the NetEco 1000S Home Page
Figure 4-4 shows the home page of the NetEco 1000S client after the login. Table
4-1 describes items on the home page.

Figure 4-4 NetEco 1000S homepage

Table 4-1 NetEco 1000S homepage

No. Name Description

1 Menu bar Indicates the main menu of the system.

2 Operation
display area

Displays the GUI of the selected function.

3 You can click this icon to select a language to be used
by the NetEco 1000S client.

4 Current
logged-in
user

Displays the name of the current logged-in user.
● Click Basic Settings in the user name drop-down list

and change the user name and description on the
Basic Settings tab page. The installer and customer
can modify the upper-level administrator account.

● Click Plant List in the user name drop-down list and
choose whether to display PV plant information on
the Plant List tab page.

● Click Currency unit in the user name drop-down list
and set the currency for the PV system and the
exchange rate for each PV plant on the Currency
unit tab page

● Click Logout in the user name drop-down list to log
out of the NetEco 1000S.

5 Password
changing
icon

You can click this icon to change the current password.
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No. Name Description

6 Help icon ● You can click Help under this icon to open the
online help.
NOTE

The customer cannot access the online help.

● You can click About under this icon to check the
version information.

7 Alarm board
icon

Displays the number of the current alarms. Alarms of
different alarm severities are marked in different
colors.
You can click this icon to enter the Alarm window.
Table 4-2 lists the icon meaning.
NOTE

The customer cannot access the alarm board information.

8 User
Authorizatio
n icon

You can click this icon to open the User Authorization
page to view the Privacy Policy and Terms of Use.
NOTE

If the User authorization is disabled during the installation of
the NetEco 1000S, this icon will not be displayed.

 

Table 4-2 Alarm status images

Image Status

Critical

Minor

Major

Warning

 

4.1.2 Overview Management

4.1.2.1 Obtaining an Overview of the PV System

You can browse the PV system overview to have the general knowledge of all PV
plants on the NetEco 1000S

Prerequisites

You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In to
the NetEco 1000S Client.
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Procedure

Step 1 Choose Overview from the main menu, as shown in Figure 4-5.

If you can access only one PV plant, the Overview page displays the Overview tab page of
the PV plant by default. You need to click  to view the overview of
the PV system.

Figure 4-5 overview

Step 2 Perform the following operations on the Overview page.

If You Need To... Then...

View PV system KPIs. View the Daily Energy, Lifetime Energy, Total
Income, Number of Online PV Plant in the PV
System and CO2 Reduction of the PV system in
the upper part of the PV System Overview tab
page.
NOTE

If Set the exchange rate is displayed in the Total
Income pane, set the exchange rates for the PV
plants by referring to 4.1.3.3 Setting the PV System
Currency.

View the PV plant list. View the PV plant list in the lower part of the
PV System Overview tab page.
NOTE

Click any position of the target line on the PV plant
list to go to the Overview tab page of the target PV
plant.
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If You Need To... Then...

Create a new PV plant.
NOTE

This operation requires that the
current user is the installer or
customer.

1. Click Create PV Plant.
2. Set plant parameters.

NOTE
– The product feature you have purchased may

use personal information of users when
providing services or maintenance. Therefore,
you need to configure such information in
accordance with the requirements on personal
data in local laws and regulations.

– To set Device, you need to click , and then
enter the device SN and the total string
capacity of the directly connected inverter.

– The size of the photo in PV Plant Image must
be less than 5 MB and in .jpg, .png, or .gif
format. Otherwise, the upload will fail.

3. Click Save.

Set the PV system currency. 1. Click the icon or total income value in the
Total Income pane.
The Currency unit tab page is displayed.

2. Set the currency for the PV system and the
exchange rates for the PV plants, and click
Save.

 

----End

4.1.2.2 Exporting Report

You can create report export rules on the NetEco 1000S to export a customized
historical data report.

Prerequisites

You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In to
the NetEco 1000S Client.

Context

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

Procedure

Step 1 Choose Overview > Report.
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Figure 4-6 Report tab page

Step 2 Click Create Report on the Report tab page.

Step 3 Set parameters and click OK.

Step 4 Click  in the Operation column to execute the report export rules to export the
corresponding report.

When the execution progress is 100%, you can choose to open or save the
exported report at the bottom of the browser.

----End

Follow-up Procedure

● Click  in the Operation column to edit the report export rules to meet the
latest management requirements.

● Click  in the Operation column to delete the redundant report export rules
to ensure that the server has sufficient memory and runs properly.

4.1.2.3 Obtaining an Overview of a PV Plant

You can learn the device status and PV plant running information by querying the
overview of the PV plant.

Prerequisites

You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In to
the NetEco 1000S Client.

Procedure

Step 1 Choose Overview > PV System Overview.

If you can only access one PV plant, the Overview page displays the Overview tab page of
the PV plant by default.

Step 2 Click any position of the target line on the PV plant list. The Overview tab page of
the target PV plant is displayed.

Step 3 On the Overview tab page of the PV plant, you can view the overview
information about the plant.
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If You Need To... Then...

View all indicators of
the PV plant.

View the indicators of the PV plant on the Overview
tab page, such as Daily Energy, Lifetime Energy,
Current Power, Specific Energy, Income, and CO2
Reduction.

View the device energy
flow diagram.

View the details of devices in the PV plant in the left
part of the Overview page.

● Click  to view the inverter details and
inverter list.

● If optimizers are connected to the inverter, click

 to view the optimizer list.
● If a battery is connected to the inverter, click

 to view the battery details.
● If a power meter is connected to the inverter, click

 to view the meter details.

View the PV plant
information.

View the basic information about the PV plant on the
right of the Overview page.

View the current-day
power curve chart of
the PV plant.

View the power curves of the PV plant in the lower
left part of the Overview page.

View the bar chart of
PV plant energy yield
comparison.

View the historical data about the energy yields and
incomes of the PV plant in the lower right part of the
Overview page.

 

----End

4.1.2.4 Querying Index Values of Devices
You can query values of some indexes for some inverters and optimizers as
required to learn the running status of these indexes in a certain period.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer, guest user who has been assigned the

historical data query permissions, or customer.
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Procedure

Step 1 Choose Overview > PV System Overview.

If you can only access one PV plant, the Overview page displays the Overview tab page of
the PV plant by default.

Step 2 Click any position of the target line on the PV plant list. The Overview tab page of
the target PV plant is displayed.

Step 3 Choose the Analysis tab page.

Step 4 Select devices and indexes, set the query time, and click Query.

Step 5 The line chart of indexes for each inverter is displayed.You can also view the index
details of each inverter in the Indicator details area.

After clicking Query, you need to place the cursor on the line chart to view the index
details of each device in the Indicator details area on the right.

----End

4.1.2.5 Configuring PV Plant Information
This section describes how to modify the information about a plant on the NetEco
1000S if the information is inconsistent with that about the actual plant.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or customer.

Procedure

Step 1 Choose Overview > PV System Overview.

If you can only access one PV plant, the Overview page displays the Overview tab page of
the PV plant by default.

Step 2 Click any position of the target line on the PV plant list. The Overview tab page of
the target PV plant is displayed.

Step 3 Choose the Settings tab.

Step 4 Modify PV plant information on the corresponding tab page. See Table 4-3.
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Table 4-3 Modifying PV plant information under the main menu Overview

If You Need To... Then...

Modify the plant name,
country, city, postal code,
time zone, address, or
CO2 emission reduction
coefficient.

1. Choose the Basic Information tab.
2. Click Refresh to refresh the parameter

information.
3. Modify related information and click Save.
NOTE

You can click Export to export the PV plant personal data.

Modify the plant image. 1. Choose the Image tab.
2. Click Upload.

Modify data collection
time.

1. Choose the Data collection tab.
2. Click Refresh to refresh the parameter

information.
3. Modify related information and click Save.

Income
setting

Modify
the
electricity
price or
currency.

1. Choose the Income tab.
2. Modify Electricity price or Currency and click

Save.
NOTE

● If you want to update the income within historical
time segments (current day also included), change the
electricity price, click Update Income, and select a
historical time segment.

● If you need the income to be calculated based on the
new electricity price from current day on, click Save.

Set the
reference
values.

Incomplete historical energy yield data may lead to
an inaccurate income value. You can set reference
values to correct the income value.
1. Choose the Income tab.
2. Click Auto Calculate or manually enter Total

energy yield reference value and Electricity
price.

3. Click Save.

Permission
setting
NOTE

Only the
plant creator,
or plant
owner has
permission to
share the
plant or
change the
plant owner.

Share the
plant.

1. Choose the Permissions tab.
2. Click Share Power Station.
3. Enter the email address of the target user in the

Email address text box and click Confirm.

Change
the plant
owner.

1. Choose the Permissions tab.
2. Click Modify owner.
3. Enter the email address of the target user in the

text box and click Confirm.
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If You Need To... Then...

Delete
the plant.

1. Choose the Permissions tab.
2. Click Delete PV plant.
3. Click Yes in the displayed Warning dialog box.

Plant device
list
management

Export
the device
list.

1. Choose the Device tab.
2. Optional: Set Device name, Version, SN or

Device type, and click Query.
Target devices meeting the preset condition are
filtered out.

3. Click Export to export the target device list
queried.

Change a
device
name.

1. Change Device Name in the exported .xls file,
and save the file.

2. Click Import Names in the Device tab.
The Import Names dialog box is displayed.
NOTICE

Only .xls files can be imported. The file size must be
less than 2 MB. The file must contain the Device
Name and ESN columns, and the columns must not
be empty.

3. Click Browse, and select the .xls file saved in
Step 4.1.
NOTICE

During the Execution, the modification task will be
stopped if you close the Import Names dialog box.

4. Click Execution.
– During the Execution, you can click Stop to

stop unfinished modification task.
– If modifying device names fails, Details in

Import Names will provide the device whose
name fails to be modified and the failure
cause.

5. Click Close.

Replace a
device

1. Choose the Device tab.
2. Click Replace Device.

The Replace Device dialog box is displayed.
3. Select a device type, and enter the Old device

SN, New device SN and Device name. Then
click OK.
NOTE

Device name specified here is the name of the new
device to be displayed in the NetEco 1000S. Device
name must be different from the names of the
existing devices in the same PV plant.

4. Click OK, and complete the device replacement
as prompted.
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If You Need To... Then...

Add a
device

1. Choose the Device tab.
2. Click Add Device.
3. Specify the device SN, and click OK.

The device automatically connects to the plant.

Delete
devices

1. Choose the Device tab.
2. Select the target devices and click Delete

Device.
3. Click Yes in the Warning dialog box.

The Deletion succeeded dialog box is displayed.
4. Click OK.

 

----End

4.1.3 Managing the PV Plants

4.1.3.1 Creating a PV Plant
Create a PV plant in the NetEco 1000S before connecting the devices.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.

Context

The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Click  in the navigation tree on the left.

The Create PV Plant window is displayed, as shown in Figure 4-7.
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Figure 4-7 create PV plant

Step 3 Set plant parameters.

● To set Device, you need to click , and then enter the device SN and the total string
capacity of the directly connected inverter.

After the PV plant is created, the device automatically connects to the plant.

● The size of the photo in PV Plant Image must be less than 5 MB and in .jpg, .png,
or .gif format. Otherwise, the upload will fail.

Step 4 Click Save.

----End

4.1.3.2 Obtaining an Overview of a PV Plant

You can learn the device status and PV plant running information by querying the
overview of the PV plant.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 In the navigation pane on the left, choose PV System or a user-defined PV plant.

Step 3 In the displayed operation area, choose the Details tab.

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 54



Step 4 The overview of the PV plant is displayed.

If You Need To... Then...

View details about Daily
Energy, Lifetime Energy
Yield, Performance Ratio,
CO2 Reduction, Current
Power, Specific Energy,
Income, and Total
Irradiance.
NOTE

You can view details about
Income only on the Details
page of the PV system. If Set
the exchange rate is
displayed in the Income
pane, set the exchange rates
for the PV plants by referring
to 4.1.3.3 Setting the PV
System Currency.

The way of viewing each running information
about a plant is the same. Viewing information
about Daily Energy is used as an example:
1. Move the mouse pointer to the pane displaying

the information about Daily Energy. The View
Details link is displayed.

Figure 4-8 View Details

2. Click View Details.
Information about Daily Energy for each
device is displayed in the Details window.

View the information
about inverters accessed in
PV plant.
NOTE

If the value of Total string
capacity in inverter
information is displayed in
red, Total string capacity is
not configured for the
inverter. Configure it by
following the instructions
provided in 4.1.4.4 Modifying
the Information About a
Device.

On the Details tab page of the PV plant, you can
view the information about all the inverters
connected to the PV plant.

View the PV plant power
and total irradiance curve.

View the PV plant power and total irradiance
curve in the PV Plant Power Statistics area, as
shown in Figure 4-9.

Figure 4-9 PV plant power and total irradiance
curve
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If You Need To... Then...

Switch to the Performance
Data page.

Click MORE on the right of Details.

Switch the mode for
displaying power statistics.

Click Table or Graph in the lower area of the PV
Plant Power Statistics column.

● : The power statistics are displayed
in a table.

● : The power statistics are
displayed in a line chart.

 

----End

4.1.3.3 Setting the PV System Currency
You can set the PV system currency as required.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose PV System in the navigation tree on the left.

Step 3 Click the Details tab in the operation display area.
● The link Set the exchange rate is displayed in the Income pane.

a. Click Set the exchange rate.
The Currency unit tab page is displayed, as shown in Figure 4-10.

Figure 4-10 Currency unit

b. Set the currency for the PV system and the exchange rates for the PV
plants as required, and click Save.

● The Income pane displays the income of the PV system.

a. Place the cursor over the Income pane, and click the View Details link.
The Details dialog box is displayed.
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b. Click PV System Currency Settings in the upper right corner.

The Currency unit tab page is displayed, as shown in Figure 4-11.

Figure 4-11 Currency unit

c. Set the currency for the PV system and the exchange rates for the PV
plants as required, and click Save.

----End

4.1.3.4 Browsing the Device List of a PV Plant

This section describes how to browse the device list of a plant to learn the devices
in the plant.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer or guest user.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose PV System or a user-defined plant in the navigation tree on the left.

Step 3 Click the Device List tab in the operation display area.

Key information about all devices under the selected plant is displayed on the
Device List tab page, as shown in Figure 4-12.

Figure 4-12 Overview of Device Information

----End

4.1.3.5 Browsing Alarm Information About a PV Plant

This section describes how to browse alarm information about a plant to learn
about the current alarms for all devices under the plant.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose PV System or a user-defined plant in the navigation tree on the left.

Step 3 Click the Alarm tab in the operation display area.

The current alarms for all devices under the selected plant is displayed on the
Alarm tab page, as shown in Figure 4-13.

Figure 4-13 Overview of Alarm Information about a PV Plant

Step 4 Optional: Click an alarm name in the Alarm Name column to view the details.

Step 5 Optional: Click Export to export the queried alarm information into a CSV file.

----End

4.1.3.6 Modifying the Information About a PV Plant
This section describes how to modify the information about a plant on the NetEco
1000S if the information is inconsistent with that about the actual plant.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the plant whose information is to be changed in the navigation tree on the
left.

Step 3 Click the Settings tab in the operation display area.

Information about the selected plant is displayed on the Settings tab page.

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 58



In PV Plant Description area, Initialization time indicates the creating time of the plant,
and it is non-editable.

Step 4 Click Refresh in the upper right corner to refresh the parameter information.

Step 5 Modify PV plant information.

If You Need To... Then... The
User
Should
Be…

Modify the
plant
description.

Modify
the
plant
name,
descripti
on,
country,
city,
address,
or
postal
code.

Modify related information and click
Save.

installer
or guest
user

Report
Settings

You can configure the basic information
about the PV plant in the exported smart
I-V diagnosis report as required.
1. Click Report Settings.

The Report Settings dialog box is
displayed.

2. Configure the basic information about
the PV plant as required.

3. Click OK.
After the setting succeeds, the
modified basic information is displayed
in the consequent exported reports.

installer

Parameter
settings

Modify
the ratio
threshol
d,
electricit
y price,
currency
, or CO2
emissio
n
reductio
n
coefficie
nt.

Modify related information and click
Save.
NOTE

● If you want to update the income within
historical time segments (current day also
included), change the electricity price, click
Update Income, and select a historical
time segment.

● If you need the income to be calculated
based on the new electricity price from
current day on, click Save in the upper-
right corner of the configuration page.

installer
or guest
user
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If You Need To... Then... The
User
Should
Be…

Set the
referenc
e values.

Incomplete historical energy yield data
may lead to an inaccurate income value.
You can set reference values to correct
the income value.
1. Click Reference Value Settings.

The Reference Value Settings dialog
box is displayed.

2. Click Auto Calculate or enter a total
energy yield reference value, and
specify the electricity price.
NOTE

– The default value is the electricity price
set for the PV plant.

– The value of this parameter cannot be
modified. It is automatically calculated
by multiplying Total energy yield
reference value and Electricity price.

3. Click OK to save the modification.

installer

Set the
time
zone.

Change the time zone for the plant.
1. Click Time Zone Settings on the

Settings page of the plant.
The Time Zone Settings dialog box is
displayed.

2. Select the time zone for the plant from
the City drop-down list box.

3. Enable or disable the daylight saving
time from the Enable daylight saving
time drop-down list box.
NOTE

You can set the parameter only if the
selected time zone uses the daylight saving
time.

4. Click OK to save the setting.

Performance
ratio
configuration

Modify
the line
loss or
module
peak
power
tempera
ture
coefficie
nt.

Modify related information and click
Save.
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If You Need To... Then... The
User
Should
Be…

Select
an EMI.

Data from EMI selected here is used to
calculate the values of Performance
Ratio and Availability, as well as the EMI
values of PV Plant Overview, PV Plant
Analysis, and Data Export.
1. Click Select EMI.

The Select EMI dialog box is displayed.
2. Select a target EMI.
3. Click OK.

Update
the
historica
l
perform
ance
ratio.

1. Click Update Historical PR.
The Update Historical PR dialog box
is displayed.

2. Specify Start time and End time.
3. Click OK.

Specific Energy, Performance Ratio,
and Availability, as well as EMI values
of the PV Plant Overview, PV Plant
Analysis, and Data Export of the PV
plant within the time segments
selected are calculated based on the
latest parameters.

Availability
configuration

Modify
the PR
value
range,
Minimu
m
irradian
ce, or
Downti
me rate
threshol
d.

Modify related information and click
Save.
NOTE

● Availability is not calculated for the period
when the PR value is outside the
configured range.

● Availability is not calculated for the period
when the downtime rate exceeds the
configured threshold.

Update
historica
l
availabil
ity.

1. Click Update Historical Availability.
The Update Historical Availability
dialog box is displayed.

2. Set Start time and End time.
3. Click OK.

Modify communications
parameters.

Modify related information and click
Save.
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If You Need To... Then... The
User
Should
Be…

Modify the plant image. 1. Click Upload.
2. Select a plant image and click Open.
NOTE

The size of the plant image must be less than
5 MB, and the image can be saved only in jpg,
png, or gif format. Otherwise, the image fails
to be uploaded.

installer
or guest
user

Remotely
control
devices.

Power
on or
off
inverters
.

For detalis, please see 4.1.4.6 Remotely
Controlling an Inverter.

installer
who has
been
assigned
the
device
remote
control
permissi
ons

 

----End

4.1.3.7 Deleting a PV Plant

This section describes how to delete a PV plant that is created incorrectly or do
not need to be managed after network adjustment from the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the plant to be deleted in the navigation tree on the left.

Step 3 Click .

A confirmation dialog box containing the message Are you sure you want to
delete? is displayed.

A plant can be deleted only when no device exists under it. Otherwise,  is dimmed.
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Step 4 Click Yes.

A dialog box containing the message Deletion succeeded is displayed.

Step 5 Click OK.

----End

4.1.4 Managing Devices

4.1.4.1 Connecting Devices

This section describes how to connect the device to the PV plant in NetEco 1000S,
helping manage and monitor devices through the NetEco 1000S.

Context

The TLS protocol is used for the NetEco 1000S to communicate with the device.

NO TICE

The TLS protocol provides the following three versions:

● TLS1.0: This version has security risks.

● TLS1.1: This version is secure.

● TLS1.2: This version is secure.

In order to be compatible with the low version of the device, the NetEco 1000S
supports all of the preceding protocol versions by default. TLS1.0 has security risks.
For security purposes, you are advised to use TLS1.1 or TLS1.2.

The device may not support TLS1.1/1.2. You are advised to replace the device with
the one supporting TLS1.1/1.2 or upgrade the device to the version supporting
TLS1.1/1.2.

4.1.4.1.1 Connecting Devices After Quick Setting for a Residential Inverter

After you use the FusionHome app to perform quick setting, you can log in to the
NetEco 1000S and connect the corresponding device to the target PV plant so that
you can manage and monitor the device on the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer.

● The IP address of the NetEco 1000S has been registered with the device, and
the device has been successfully registered with the management system. For
details, see the FusionHome app user manual.
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Procedure

Step 1 Log in to NetEco 1000S.

The Device Settings > Selecting Devices page is displayed, as shown in Figure
4-14.

Figure 4-14 Selecting Devices

Step 2 Select the devices as required, and click Next.

The Device Settings > Setting PV Plants page is displayed, as shown in Figure
4-15.

Figure 4-15 Setting PV Plants

Step 3 Set the PV plants.
● Create PV plant.
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a. Click Create PV Plant.
The Device Settings > Create PV Plant page is displayed, as shown in
Figure 4-16.

Figure 4-16 Create PV Plant

b. Set PV plant parameters, and click Next.
The Device Settings > Setting Device Information page is displayed.

c. Set the device information, and click Next.
The Device Settings > Configuration Successful page is displayed.

d. Click Finish.
● Select PV plant.

a. Click Select PV Plant.
The Device Settings > Selecting Existing PV Plants page is displayed.

b. Select the target plant, and click Next.
The Device Settings > Setting Device Information page is displayed.

c. Set the device information, and click Next.

i. Set the device information.
ii. Optional: Replace the existing device by referring to Figure 4-17.

The old device has been deleted or is disconnected from the NetEco 1000S.
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Figure 4-17 replace device

iii. Click Next
The Device Settings > Configuration Successful page is displayed.

d. Click Finish.

----End

4.1.4.1.2 Connecting Devices Through the SmartLogger

This section describes how to connect the device to the PV plant in NetEco 1000S
through the SmartLogger, helping manage and monitor devices through the
NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● Devices access NetEco 1000S through SmartLogger. SmartLogger and NetEco

1000S must be in the same time zone. For details on how to set the time
zone of SmartLogger, see 4.1.4.4 Modifying the Information About a Device
or Smart Logger User Manual.

● You have set the IP address of NetEco 1000S on the web page of the
SmartLogger. For detailed operations, see Smart Logger User Manual.

● You have obtained the authentication passwords of the SmartLogger and
NetEco 1000S and the SN of the SmartLogger.

● You have created the target plant. For detailed operations, see 4.1.3.1
Creating a PV Plant.

Procedure

Step 1 Choose Monitor from the main menu.
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Step 2 Select the target plant in the navigation tree on the left.

Step 3 Click the Add Device tab in the operation display area, and then click Add Device
button.

Step 4 Enter the device SN and total string capacity (optional) of the inverter, and click
OK.

The SmartLogger and NetEco 1000S are connected through password authentication. The
authentication passwords on the SmartLogger and NetEco 1000S sides are /EzFp
+2%r6@IxSCv by default. You are advised to change the password every three months.

1. In the Add Device tab, click  in the Operation column of the SN.
The Set Device Authentication Password dialog box is displayed.

2. On the Set Device Authentication Password page, use the following methods to
change the authentication password:
– If you want to change the authentication passwords on the SmartLogger and

NetEco 1000S sides at the same time to ensure connection security:
Select Issue new authentication password to device, reset Password and
Confirm Password, and click OK.

– If the connection between the inverter and NetEco 1000S fails due to
authentication password inconsistency, and if you only need to change the
authentication password on the NetEco 1000S side:
Deselect Issue new authentication password to device, enter the password same
as the SmartLogger side, and click OK.

When the SmartLogger added to the PV plant accesses the NetEco 1000S, the
following prompt is displayed in the lower right corner of the NetEco 1000S.

Figure 4-18 Device access prompt

Step 5 Click Refresh in Figure 4-18 or re-select the target PV plant in the navigation tree
on the left to view the added SmartLogger and devices connected to it.

----End

4.1.4.1.3 Connecting the Directly Connected Inverter

This section describes how to connect the device to the PV plant in NetEco 1000S,
helping manage and monitor devices through the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
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● You have logged in as the installer.
● The IP address of the NetEco 1000S has been registered with the device, and

the device has been successfully registered with the management system. For
details, see the device user manual.

● You have obtained the authentication password between the inverter and
NetEco 1000S and the SN of the inverter.

● You have created the target plant. For detailed operations, see 4.1.3.1
Creating a PV Plant.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the target plant in the navigation tree on the left.

Step 3 Click the Add Device tab in the operation display area, and then click Add Device
button.

Step 4 Enter the SN and total string capacity (optional) of the inverter, and click OK.

The inverter and NetEco 1000S are connected through password authentication. The
authentication passwords on the inverter and NetEco 1000S sides are /EzFp+2%r6@IxSCv
by default. You are advised to change the password every three months.

1. In the Add Device tab, click  in the Operation column of the SN.

The Set Device Authentication Password dialog box is displayed.

2. On the Set Device Authentication Password page, use the following methods to
change the authentication password:

– If you want to change the authentication passwords on the inverter and NetEco
1000S sides at the same time to ensure connection security:

Select Issue new authentication password to device, reset Password and
Confirm Password, and click OK.

– If the connection between the inverter and NetEco 1000S fails due to
authentication password inconsistency, and if you only need to change the
authentication password on the NetEco 1000S side:

Deselect Issue new authentication password to device, enter the password same
as the inverter side, and click OK.

When the inverter added to the PV plant accesses the NetEco 1000S, the following
prompt is displayed in the lower right corner of the NetEco 1000S.

Figure 4-19 Device access prompt
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Step 5 Click Refresh in Figure 4-19 or re-select the target PV plant in the navigation tree
on the left to view the added inverter.

----End

4.1.4.1.4 Searching for Devices Based on Serial Port Addresses

This section describes how to search for Inverter devices based on serial port
addresses when Inverters are connected to the monitoring PC using serial cables.
The NetEco 1000S can automatically identify and add new devices after the
search. The serial-port connection mode applies to local commissioning and is not
recommended for remote connection.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● You have obtained the serial port number, start bus address, and end bus

address for an Inverter.
● The Inverter is in the same time zone as the NetEco 1000S. If they are not in

the same time zone, change the time zone of the Inverter by following
instructions provided in User Manual on the monitored device side.

● You have created the target plant. For detailed operations, see 4.1.3.1
Creating a PV Plant.

Context
If one of the following changes occurs on a device that has been added to the
NetEco 1000S, you need to search for the device again so that information about
the device can be updated on the NetEco 1000S.

● The connection mode between the device and the NetEco 1000S is changed:
Network cable-based connection is changed to the RS232 cable-based direct
connection.

● The RS485 Com Address of the device is changed.

NO TICE

Currently, the serial-port connection mode does not support security
authentication, which may introduce certain security risks. You are advised to use
network cables for connection. For details, see 4.1.4.1.2 Connecting Devices
Through the SmartLogger or 4.1.4.1.3 Connecting the Directly Connected
Inverter.

Procedure

Step 1 Enable the function of serial ports.

Navigate to the NetEco 1000S installation directory\WebRoot\WEB-INF\classes
directory, open the userManagement.properties file, change the value of
isStartCom to 1, and save the change result. Then, restart the NetEco 1000S.
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Step 2 Choose Monitor from the main menu.

Step 3 Click in the navigation tree on the left.

Step 4 Enter the serial port number, start bus address, and end bus address for the
Inverter device and select the PV Plant to which the device belongs by referring to
Table 4-4.

Table 4-4 Parameters for searching for devices based on serial port addresses

Parameter Description

Serial port No. Serial port number for connecting the device to
the PC.

Start bus address/End bus
address

Start bus address/End bus address of the RS485
Com Address.

PV Plant Name of the PV Plant to which the device
belongs.

 

Step 5 Click Search.

The added devices are displayed in the navigation tree on the left after the search.

NO TICE

To ensure NetEco 1000S system security, the NetEco 1000S shields the function of
serial ports by default. After completing the operation, disable this function
immediately.

Step 6 Disable the function of serial ports.

Navigate to the NetEco 1000S installation directory\WebRoot\WEB-INF\classes
directory, open the userManagement.properties file, change the value of
isStartCom to 0, and save the change result. Then, restart the NetEco 1000S.

----End

4.1.4.2 Browsing the Details About a Device
This section describes how to browse the details about a device to learn about its
running status, such as the basic information and real-time performance data.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.
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Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose the target device in the navigation tree on the left.

Step 3 Click the Details tab in the operation display area.

Basic information and real-time performance data of the selected device is
displayed on the Details tab page.

If a battery or meter is connected to the residential inverter, you can click the battery or
meter icon to view its details.

----End

4.1.4.3 Browsing Alarm Information About a Device
This section describes how to browse alarm information about a device to learn
about the current alarms for the device.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose the target device in the navigation tree on the left.

Step 3 Click the Alarm tab in the operation display area.

The information about all the current alarms of the target device is displayed in
the Alarm tab page. Figure 4-20 shows the information about all the current
alarms of an inverter.

Figure 4-20 The information about all the current alarms of the target device

Step 4 Optional: Click an alarm name in the Alarm Name column to view the details.
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Alarms that have not been browsed are highlighted in bold.

Step 5 Optional: Click Export to export the queried alarm information into a CSV file.

----End

4.1.4.4 Modifying the Information About a Device

On the Monitor tab page of the NetEco 1000S, you can configure the information
about the devices.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer.

● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Choose the target device in the navigation tree on the left.

Step 3 Click the Settings tab in the operation display area.

Device information about the selected device is displayed on the Settings tab
page.

Step 4 Modify configuration information about the selected device by referring to Table
4-5.

Table 4-5 Modifying device configuration information

Device
Type

If You Need
To...

Then...

SmartLo
gger

Change the
name and
description of
a SmartLogger

1. Choose the Device Information tab.
2. Click Refresh in the upper right corner of the

page. The latest parameter values will be
displayed on the NetEco 1000S for the
SmartLogger.

3. Enter the new name and description in the
corresponding text boxes.

4. Click Save in the upper right corner of the
Settings page.
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Device
Type

If You Need
To...

Then...

Switch to the
SmartLogger
web client

1. Choose the Device Information tab.
2. Click the Device address link under

Communication Parameter, as shown in
Figure 4-21.
Switch to the web client of the SmartLogger.

Figure 4-21 Device Address

NOTE
The switch to the web client is successful only when the
PC can be used to access the SmartLogger web client
directly.

Enable or
disable the
SmartLogger

Choose the Device Information tab.
The value of Connect indicates the status of the
SmartLogger. According to Figure 4-22, the
SmartLogger has started.

Figure 4-22 SmartLogger connection status

● To disable the SmartLogger:
1. Click Disable.

The message "After connection is disabled,
NetEco will disconnect and forbid
SmartLogger connection" is displayed.

2. Click OK.
The SmartLogger is disabled, and the value
of Connect changes to the value shown in
Figure 4-23.

Figure 4-23 SmartLogger connection status

● To restore the connection between the
SmartLogger and NetEco 1000S, click Enable.

Control an
inverter
remotely

For details, see Power on or off all inverters in
the same plant or SmartLogger in batches in
4.1.4.6 Remotely Controlling an Inverter.
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Device
Type

If You Need
To...

Then...

Modify the
time zone
parameters,
power control
parameters,
NetEco
communicatio
ns parameters,
or CO2
emission
reduction
coefficient of
the
SmartLogger

The methods for modifying time zone, active
power control, reactive power control, or NetEco
communications parameters, and CO2 emission
reduction coefficient are similar. The following
describes how to change the time zone parameter.
1. Choose the Time Zone Parameter tab.
2. Set the value of City as required.
3. Click Submit.

After Submitted successfully is displayed in the
Information column, the specified parameter is
delivered to the device side.

NOTE
Click Synchronize to synchronize the parameter values
configured on the SmartLogger to the NetEco 1000S.

Inverter Synchronize
the parameter
values of the
inverter to the
NetEco 1000S

Click Synchronize on the page for the parameter
values to be synchronized.

Change the
name and
description of
an Inverter

1. Choose the Device Information tab.
2. Enter the new name and description in the

corresponding text boxes.
3. Click Save in the upper right corner of the

Device Information page.
After the device name and description are
changed, the device name is delivered to the
device.

Change the
total string
capacity of
inverters

1. Choose the Device Information tab.
2. Enter the target value in the Total string

capacity text box.
NOTE

Click Batch Apply if you need to apply the configured
value of Total string capacity to multiple inverters.
Then select the target devices in the displayed dialog
box and click OK.

3. Click Save in the upper right corner of the
Device Information page.
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Device
Type

If You Need
To...

Then...

Set string
parameters of
an inverter

1. Choose the Device Information tab.
2. Click String Details Setup.

The String Details Setup page is displayed.
3. Select the strings to be configured in the String

Setup area.
4. Set parameters for the strings in the Panel

Setup area.
5. Click OK to save the settings.
NOTE

If you need to apply the string configurations to multiple
inverters, click Batch Apply. Then select the target
devices in the displayed dialog box and click OK.

Search for
devices

This button only exists on the configuration tab of
the host in the 4G distributed networking. When
the host is connected to the PV plant, you can
perform the following operations to add slave
devices to the target PV plant.
1. Choose the Device Information tab.
2. Click Search for Device.
3. Click OK in the displayed dialog box.

4. After a while, click  in the upper left corner
to refresh the device navigation area.
Slave devices in the 4G distributed networking
are successfully added to the PV plant.
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Device
Type

If You Need
To...

Then...

Modify the
power grid
parameters,
protection
parameters,
feature
parameters,
power
adjustment
parameters, or
NetEco
communicatio
ns parameters
NOTE

Only the
directly
connected
inverter
supports
modifying the
NetEco
communication
s parameters.

The methods for changing power grid parameters,
protection parameters, feature parameters, power
adjustment parameters, or NetEco communications
parameters are similar. The following describes
how to change the power grid parameters.
1. Choose the Grid Parameters tab.
2. Set the parameters as required.

NOTE
For details about the parameters, see User Manual on
the monitored device side.

3. Select the parameters to be modified.
4. Click Submit.

After Submitted successfully is displayed in the
Information column, the specified parameter is
delivered to the device side.

NOTE
If you need to apply the configurations to multiple
inverters, click Batch settings. Then select the target
devices in the displayed dialog box and click OK.

Correct the
total energy
yield of the
inverter

1. Choose the Adjust Total Energy Yield tab.
2. Set the value of the total energy yield as

required.
3. Select the parameters to be modified.
4. Click Submit.

After Submitted successfully is displayed in the
Information column, the specified parameter is
delivered to the device side.

NOTE
If you need to apply the configurations to multiple
inverters, click Batch settings. Then select the target
devices in the displayed dialog box and click OK.

Optimize
r

Change the
name and
description of
an Optimizer

1. Click Refresh in the upper right corner of the
page. The latest parameter values will be
displayed on the NetEco 1000S for the
Optimizer.

2. Enter the new name and description in the
corresponding text boxes.

3. Click Save in the upper right corner of the
Settings page.
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Device
Type

If You Need
To...

Then...

EMI Change the
name and
description of
an EMI

1. Click Refresh in the upper right corner of the
page.
The latest parameter values will be displayed on
the NetEco 1000S for the EMI.

2. Enter the new name and description in the
corresponding text boxes,

3. Click Save in the upper right corner of the
Settings page.

PID Change the
name and
description of
a PID

1. Choose the Device Information tab.
2. Click Refresh in the upper right corner of the

page.
The latest parameter values will be displayed on
the NetEco 1000S for the PID.

3. Enter the new name and description in the
corresponding text boxes.

4. Click Save in the upper right corner of the
Settings page.

Modify PID
parameter

1. Choose the PID Parameter tab.
2. Set parameters as required.
3. Select the parameters to be modified.
4. Click Submit.

After Submitted successfully is displayed in the
Information column, the specified parameter is
delivered to the device side.

NOTE
● For details about the parameters, see the User

Manual on the monitored device side.
● Click Synchronize to synchronize the parameter

values configured on the PID to the NetEco 1000S.

Meter Change the
name and
description of
a Meter

1. Click Refresh in the upper right corner of the
page.
The latest parameter values will be displayed on
the NetEco 1000S for the Meter.

2. Enter the new name and description in the
corresponding text boxes.

3. Click Save in the upper right corner of the
Settings page.

 

----End

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 77



4.1.4.5 Deleting Devices
This section describes how to delete devices that have been connected to the
NetEco 1000S and that do not need to be managed or have been damaged from
the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Click  in the upper part of the navigation tree.

Step 3 In the displayed Delete Device window, select the target devices and click OK.

Step 4 Click Yes in the Warning dialog box.

The Deletion succeeded dialog box is displayed.

Step 5 Click OK.

----End

4.1.4.6 Remotely Controlling an Inverter
This section describes how to control an inverter that has been connected to the
NetEco 1000S, including powering on and off the inverter, restarting the inverter
and starting the arc-fault circuit interrupter (AFCI) self-check.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer who has been assigned the device remote

control permissions.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure
● Control one inverter:

a. Choose Monitor from the main menu.
b. Select the target inverter in the navigation tree on the left.
c. Click the Details tab in the operation display area.

The page for inverter details is displayed.
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d. Issue the control commands to the inverter according to Table 4-6.

Table 4-6 Controlling one inverter

If You Need To... Then...

Power on the inverter
Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or
a later version. The system supports the
function of disabling the remote switch
function. For details see How Do I Disable the
Display of the Remote Control Function? in
User Manual.

Power off the inverter
Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or
a later version. The system supports the
function of disabling the remote switch
function. For details see How Do I Disable the
Display of the Remote Control Function? in
User Manual.

Start the AFCI self-check
Click .
NOTE

● If the AFCI controller ID on the inverter side
is set to 0, this button is not displayed in the
Details window.

● Only the inverter SUN2000 V2 supports the
AFCI self-check function.

Restart the inverter
Click .
NOTE

The inverter SUN2000 of some versions
supports the restart function.

 
● Power on or off all inverters in the same plant or SmartLogger in batches:

The method for powering or off inverters in the same plant or SmartLogger in
batches is the same. This section uses the method for powering or off
inverters in the same plant as an example.

a. Choose Monitor from the main menu.
b. Select the target plant in the navigation tree on the left.
c. Click the Settings tab in the operation display area.

The page for setting the plant is displayed.
d. Issue the control commands to all inverters in the current plant according

to Table 4-7.
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If the inverters are connected to the plant through the SmartLogger, issue the
control commands to the SmartLogger in the plant.

Table 4-7 Controlling inverters in batches

If You Need To... Then...

Power on all inverters Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or
a later version. The system supports the
function of disabling the remote switch
function. For details see How Do I Disable the
Display of the Remote Control Function? in
User Manual.

Power off all inverters Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or
a later version. The system supports the
function of disabling the remote switch
function. For details see How Do I Disable the
Display of the Remote Control Function? in
User Manual.

 

4.1.4.7 Remotely Controlling a SmartLogger

This section describes how to control a SmartLogger connected to the
NetEco1000S, including restarting the SmartLogger, starting the SmartLogger to
search for mounted devices, and deleting devices mounted under the
SmartLogger.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer who has been assigned the device remote

control permissions.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the target SmartLogger in the navigation tree on the left.

Step 3 Click the Details tab in the operation display area.

Step 4 Issue the control commands to the SmartLogger according to Table 4-8.
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Table 4-8 Remotely controlling the SmartLogger

If You Need To... Then...

Restart the SmartLogger If the SmartLogger needs to restart due to a
fault, you can perform the following operation:

Click .

Start the SmartLogger to
search for mounted devices

If the number of inverters mounted under the
SmartLogger is different from the actual one on
the NetEco1000S, you can start the SmartLogger
on the NetEco1000S to search for devices to
ensure that the number of inverters on the
NetEco1000S is the same as the actual one.

Click .

Delete devices mounted
under the SmartLogger

If the device mounted under the SmartLogger
needs to be deleted due to a fault or aging, you
can perform the following operation:

Click .

 

----End

4.1.4.8 Remotely Controlling a PID Device

This section describes how to control a Potential Induced Degradation (PID) device
that has been connected to the NetEco 1000S, including powering on and off the
PID device.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer who has been assigned the device remote
control permissions.

● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the target PID device in the navigation tree on the left.

Step 3 Click the Details tab in the operation display area.

Step 4 Issue the control commands to the PID device according to Table 4-9.
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Table 4-9 Controlling the PID device

If You Need To... Then...

Power on the PID device
Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or a
later version. The system supports the function of
disabling the remote switch function. For details see
How Do I Disable the Display of the Remote
Control Function? in User Manual.

Power off the PID device
Click .
NOTE

The NetEco 1000S is of V100R003C00CP1104 or a
later version. The system supports the function of
disabling the remote switch function. For details see
How Do I Disable the Display of the Remote
Control Function? in User Manual.

 

If the protocol version of a PID device is D3.0, the  button is available on the Details

tab page of the PID device. You can click  to restart the PID device.

----End

4.1.4.9 Changing the Authentication Passwords of the SmartLogger and
NetEco 1000S

The SmartLogger and NetEco 1000S are connected through password
authentication. To ensure connection security, you are advised to change the
authentication passwords of the SmartLogger and NetEco 1000S periodically (for
example, every three months).

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Context
● The authentication passwords on the SmartLogger and NetEco 1000S sides

are /EzFp+2%r6@IxSCv by default.
● The password must comply with the following rules:

The password cannot be the same as the account name.
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The password contains 16 characters, and it must contain four of the
following:
– Lowercase letters
– Uppercase letters
– Digits
– special characters

You can change the authentication password between the inverter directly connected to the
NetEco 1000S by referring to this section.

Procedure

Step 1 Choose Monitor from the main menu.

Step 2 Select the target plant in the navigation tree on the left.

Step 3 Click the Add Device tab in the operation display area, and then click  in the
Operation column of the SN.

The Set Device Authentication Password dialog box is displayed.

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Step 4 On the Set Device Authentication Password page, use the following methods to
change the authentication password:
● If you want to change the authentication passwords on the SmartLogger and

NetEco 1000S sides at the same time to ensure connection security:
Select Issue new authentication password to device, reset Password and
Confirm Password, and click OK.

● If the connection between the SmartLogger and NetEco 1000S fails due to
authentication password inconsistency, and if you only need to change the
authentication password on the NetEco 1000S side:
Deselect Issue new authentication password to device, enter the password
same as the SmartLogger side, and click OK.

----End

4.1.5 Managing Other Devices
This section describes how to use the NetEco 1000S to manage other devices.
Other devices are non-Huawei-developed devices, such as Plant Controller, Power
Meter, and Electricity Meter.
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4.1.5.1 Enabling the Other Device Access Menu

After the NetEco 1000S is installed, the Other Device Access menu is not enabled
by default. When adding other devices to the NetEco 1000S, you need to manually
enable this menu.

Context

Other devices are non-Huawei-developed devices, such as Plant Controller, Power
Meter, and Electricity Meter, Power Meter, and Electricity Meter is restricted. For
detailed technical solutions, contact Huawei technical support engineers.

Procedure

Step 1 Navigate to the following directory:

NetEco 1000S installation directory\WebRoot\WEB-INF\classes

Step 2 Open the userManagement.properties file, change the value of
isShowThirdEquipment to 1, and save the change result.

Step 3 Restart the NetEco 1000S services and log in to the NetEco 1000S client.

Choose Maintenance from the main menu. The Other Device Access menu is
displayed.

----End

4.1.5.2 Adding Other Devices

This section describes how to add other devices to the NetEco 1000S so that you
can check performance data of other devices through the NetEco 1000S. Other
devices are non-Huawei-developed devices, such as Plant Controller, Power Meter,
and Electricity Meter.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● You have enabled the Other Device Access menu. For details, see 4.1.5.1

Enabling the Other Device Access Menu.
● Communication between the Plant Controller and NetEco 1000S is normal.

Procedure

Step 1 Choose Maintenance > Other Device Access from the main menu.

Step 2 In the Other Device Access window, click Add Device.

Step 3 In the displayed Add Device dialog box, set related parameters.
● To add the Plant Controller, set related parameters according to Table 4-10.
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Before adding the Plant Controller, ensure that you have created a target PV plant, for
detailed operations, see 4.1.3.1 Creating a PV Plant.

Table 4-10 Plant Controller parameters

Parameter Description

Device Type Set this parameter to PlantControl.

Device Name Set this parameter as required. The specified name is
displayed in the Other Device Access page.

PV Plant Set this parameter to the PV plant to which the Plant
Controller belongs.

Device Mark Set this parameter to the value of PV Plant name
configured on the Plant Controller.

 

● To add the Electricity Meter or Power Meter, set related parameters according
to Table 4-11.

Before adding the Electricity Meter or Power Meter, ensure that you have added the target
Plant Controller.

Table 4-11 Electricity Meter or Power Meter parameters

Parameter Description

Device Type Set this parameter to ElectricityMeter or
PowerMeter.

Device Name Set this parameter as required. The specified name is
displayed in the Other Device Access page.

Plant Controller Set this parameter to the name of the Plant Controller
on which the Electricity Meter or Power Meter needs
to be mounted.

 

Step 4 Click OK.

The window shown in Figure 4-24 is displayed after the setting is saved.

Figure 4-24 Device list

Perform the following operations in the Figure 4-24 as required.
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If You Need To... Then...

Change the name, mark, or
description of a device.
NOTE

Only the Plant Controller supports
the changing of device mark.

Click  in the row of the target device.

Delete an added device.
Click  in the row of the target device.

 

----End

Follow-up Procedure
After the device is added, you can query the performance data of the device.

1. Choose Historical Data > Performance Data from the main menu.
2. Choose an Electricity Meter or Power Meter to be queried in the navigation

tree on the left.
3. Set query conditions in the operation display area, and then click Query.

The performance parameters of Electricity Meter or Power Meter are
displayed, the specific parameters are as follows:
– Power Meter: Active power, Reactive power, Power factor, Voltage

Uab, Voltage Ubc, Voltage Uca, Current Ia, Current Ib, Current Ic, Set
value reactive power limitation, Set value cos phi, Set value Q.

– Electricity Meter: Time, Energy Yield, Self-Consumed Energy.

4.1.6 Historical Data Query

4.1.6.1 Querying Alarm Logs
This section describes how to query alarm logs on the NetEco 1000S. You can set
query criteria to obtain the required alarm logs.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Alarm Log from the main menu.

Step 2 Choose a target device to be queried in the navigation tree on the left.

Step 3 Set query conditions in the operation display area, and then click Query.

All the alarm records that meet the query conditions are displayed in one or more
pages, as shown in Figure 4-25.
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Figure 4-25 Alarm Log

Clearance Type includes Automatic clear, NetEco overflow and NetEco
recovery.

Step 4 Optional: Click Export to export the queried alarm records into a CSV file.

----End

4.1.6.2 Querying Performance Data
This section describes how to query performance data on the NetEco 1000S.

4.1.6.2.1 Querying the Performance Data of the PV System

This section describes how to query the performance data of the PV System. You
can set query criteria to obtain the required performance data.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Performance Data from the main menu.

Step 2 Choose the PV System to be queried in the navigation tree on the left.

Step 3 Set search criteria and click Query in the operation display area. The window
shown in Figure 4-26 is displayed.
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Figure 4-26 Power statistics line chart

Step 4 Optional: To export queried data to the PC for viewing, click Export and save the
file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.2.2 Querying the Performance Data of a PV Plant

This section describes how to query the performance data of a plant. You can set
query criteria to obtain the required performance data.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Performance Data from the main menu.

Step 2 Choose a plant to be queried in the navigation tree on the left.

Step 3 Set query conditions according to the following table and click Query in the
operation display area.
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Table 4-12 Setting query conditions

Query Conditions Queried Data

Select Day and set the query
date.

● The PV Plant Power Statistics line chart
displays power of the selected PV plant.

● The Inverter Power Statistics in PV Plant
line chart displays power of five inverters in
the selected PV plant by default. To view
power of a specific inverter, click Select
Inverters to select the target inverter.

1. Select Month, Year, or
Total, and set the query
month or query year
separately.

2. Select the query counter
Energy yield, Specific
Energy, Performance
ratio or Meter
Measurement.

● PV plant power generation statistics and
inverter power generation statistics

● PV plant equivalent power generation
duration and inverter equivalent power
generation duration

● PV plant Performance ratio and inverter
Performance ratio

● Generated power in a electric meter of a PV
plant and Meter Statistics Performance Ratio

 

Step 4 Optional: To export queried data to the PC for viewing, click Export and save the
file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.2.3 Querying the Performance Data of a Device

This section describes how to query the performance data of a device. You can set
query criteria to obtain the required performance data.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Performance Data from the main menu.

Step 2 Choose a device to be queried in the navigation tree on the left.
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Step 3 Set query conditions in the operation display area, and then click Query.

All qualified performance data is displayed on one or more pages. Figure 4-27
shows the inverter performance data.

Figure 4-27 Querying the performance data of a device

Step 4 Optional: To export queried data to the PC for viewing, click Export and save the
file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

Follow-up Procedure
You can also perform the following operations on the performance data page of a
device.

Operation Steps Description

Display
performanc
e data in a
line chart

In the operation display area,
click Graph.

Display the queried
performance data in a line
chart.

Set the
vertical
coordinate
of the line
chart

1. Click .
The Select Counters dialog
box is displayed.

2. Enter the values for the Y1
and Y2 coordinates.

3. Click OK.

View the performance data
based on different
performance counters in the
line chart by setting the
vertical coordinate.

Display
daylight
saving time
(DST)

Select Show DST. After DST starts, DST marks
are displayed behind each
time in the Generated On
column.
For example, 2013-09-17
09:40:00 DST.
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4.1.6.3 Querying Report Data

You can query the energy yield of the PV plant, energy yield performance ratio of
the PV plant, income of the PV plant, plant or inverter availability, and the index
values of inverters in the NetEco 1000S system for data analysis.

Context

Report data can be emailed to users. For details about the sending rules, see
4.1.8.3.4 Setting Report Sending Rules.

4.1.6.3.1 Querying the Energy Yield of the PV Plant

This section describes how to query the energy yield of the PV plant to learn data,
such as the energy generated in a certain period, active power, and irradiation
strength.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Data Analysis from the main menu.

Step 2 Choose PV Plant Analysis > Energy Yield in the navigation tree on the left

Step 3 Click  to select the target plant in the operation display area.

A maximum of 5 plants can be selected.

Step 4 Set query conditions and click Query.

Step 5 Optional: To export queried data to the PC for viewing, click Export on the Table
tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.3.2 Querying the Energy Yield Performance Ratio of the PV Plant

This section describes how to query the energy yield performance ratio of the PV
plant to learn the power energy efficiency of the PV plant in a certain period.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer or guest user who has been assigned the
historical data query permissions.

Context

The PV plant performance ratio indicates the rated output loss of the PV plant
array caused by the following reasons: the temperature and irradiation are not
fully used, or system components are invalid or faulty. The performance ratio
reflects the overall operation of devices in the PV plant system from the PV
module side to the box-type input substation side in the recording time period.

Procedure

Step 1 Choose Historical Data > Data Analysis from the main menu.

Step 2 Choose PV Plant Analysis > Performance Ratio in the navigation tree on the left.

Step 3 Click  to select the target plant in the operation display area.

A maximum of 5 plants can be selected.

Step 4 Set query conditions and click Query.

Step 5 Optional: To export queried data to the PC for viewing, click Export on the Table
tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.3.3 Querying the income of the PV Plant

This section describes how to query the income of the PV plant to learn the
income generated in a certain period.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer or guest user who has been assigned the
historical data query permissions.
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Procedure

Step 1 Choose Historical Data > Data Analysis from the main menu.

Step 2 Choose PV Plant Analysis > Income in the navigation tree on the left

Step 3 Click  to select the target plant in the operation display area.

A maximum of 5 plants can be selected.

Step 4 Set query conditions and click Query.

Step 5 Optional: To export queried data to the PC for viewing, click Export on the Table
tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.3.4 Querying Plant or Inverter Availability

This topic describes how to query plant or inverter availability during a certain
period.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer or guest user who has been assigned the
historical data query permissions.

● Inverters have connected to the NetEco 1000S through the SmartLogger, and
there are at least 10 inverters connected to the same SmartLogger. For details
about how to connect an inverter, see 4.1.4.1 Connecting Devices.

● Total string capacity has been configured for inverters. For details, see
4.1.4.4 Modifying the Information About a Device.

● An environmental monitoring instrument (EMI) is connected to a plant.

● Availability parameters have been configured for a plant. For details, see
4.1.3.6 Modifying the Information About a PV Plant.

Context

Availability is a key counter for evaluating the performance and reliability of a
plant or inverter. At least 10 inverters connected to the same SmartLogger are
required for calculating availability.
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Procedure
● Query the plant availability.

a. Choose Historical Data > Data Analysis from the main menu.

b. Choose PV Plant Analysis > Availability in the navigation tree on the
left.

c. Click  to select the target plant in the operation display area.

A maximum of 5 plants can be selected.

d. Set query conditions and click Query.

e. Optional: To export queried data to the PC for viewing, click Export on
the Table tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool
should support UCS-2 Decoding Mode. Otherwise, data cannot be
decoded.

● Query the inverter availability.

a. Choose Historical Data > Data Analysis from the main menu.

b. Choose Inverter Analysis > Availability in the navigation tree on the
left.

c. Click  to select the target SmartLogger in the
operation display area.

A maximum of five SmartLoggers can be selected.

d. Set query conditions and click Query.

e. Optional: To export queried data to the PC for viewing, click Export on
the Table tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool
should support UCS-2 Decoding Mode. Otherwise, data cannot be
decoded.

4.1.6.3.5 Querying Index Values of Inverters

You can query values of some indexes for some inverters as required to learn the
running status of these indexes in a certain period.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer or guest user who has been assigned the

historical data query permissions.

Procedure

Step 1 Choose Historical Data > Data Analysis from the main menu.

Step 2 Choose Inverter Analysis > Comparative Analysis in the navigation tree on the
left.

Step 3 In the operation area, click  to select the inverters to be queried.

A maximum of 50 inverters can be selected.

Step 4 Set query conditions and click Query.

Step 5 click  to select the indexes to be queried.

When selecting indexes, you can select only one index for the Y1 and Y2 coordinates
separately, and indexes selected for the Y1 and Y2 coordinates must be different.

Step 6 Optional: To export queried data to the PC for viewing, click Export on the Table
tab page and save the file to the PC.

NO TICE

When a third-party editing tool is used to open the exported file, the tool should
support UCS-2 Decoding Mode. Otherwise, data cannot be decoded.

----End

4.1.6.4 Synchronizing Historical Performance Data
If there is no performance data of a device on the NetEco1000S because the
device is disconnected for more than 6 hours and historical performance data
cannot be automatically synchronized or the device logs have been obtained on
the WebUI of the SmartLogger, you can create a synchronization task on the
NetEco 1000S to synchronize the historical performance data of the device to the
NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
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● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.

● If a device is connected to the NetEco 1000S through the SmartLogger, the
SmartLogger version must be SmartLogger1000 V100R001C91 or later.

Context
● The SmartLogger saves historical performance data of the latest one month.
● The inverter saves historical performance data of the latest one year.
● The optimizer saves historical performance data of the latest two days.

The synchronization on the NetEco 1000S succeeds only when the SmartLogger,
the inverter directly connected to the NetEco 1000S, or the optimizer stores
historical performance data that needs to be synchronized.

NO TICE

When historical performance data is being synchronized on the device, if you
create another synchronization task for the device, the creation fails.

Procedure
● Synchronize historical performance data of the inverter.

a. Choose Historical Data > Synchronize Historical Data > Data
Synchronization tab page, as shown in Figure 4-28.

Figure 4-28 Synchronizing historical data

b. On the Data Synchronization tab page, click Create Synchronization
Task.
The Create Synchronization Task dialog box is displayed, as shown in
Figure 4-29.
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Figure 4-29 Creating a synchronization task

c. Choose a device for which you want to create a supplementary collection
task from the device navigation tree.

d. Set the time range as required.
The time range can be set to Today, Last three Days, Last seven Days,
Last thirty Days, or Customize.

e. Click OK.
The supplementary collection task is performed automatically after the
task is created.

● Synchronize historical performance data of the optimizer connected to the
inverter.

a. Choose Historical Data > Synchronize Historical Data > Optimizer
Data Synchronization tab page, as shown in Figure 4-30.

Figure 4-30 Optimizer Data Synchronization

b. On the Optimizer Data Synchronization tab, click Create
Synchronization Task.
The Create Synchronization Task dialog box is displayed, as shown in
Figure 4-31.
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Figure 4-31 Creating a optimizer synchronization task

c. Choose a device for which you want to create a supplementary collection
task from the device navigation tree.

d. Set the time range as required.

The time range can be set to Today, Last three Days, Last seven Days,
or Customize.

e. Click OK.

The supplementary collection task is performed automatically after the
task is created.

Follow-up Procedure

If the supplementary collection task fails to be executed, click  to execute the
task again.

You can click  to stop a synchronization task.

4.1.7 Device Maintenance

4.1.7.1 Upgrading a Device

This section describes how to upload a software package and remotely upgrade a
device through the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the system administrator.

● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.
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● You have contacted Huawei technical support engineers to obtain the
software package required for device upgrade and have checked the integrity
of the software package.

● You can check the integrity of the software package by referring to 4.1.9.7
Verifying OpenPGP Signature.

● Software package integrity check is related to the software security. You must
perform the check to ensure the software security.

Procedure

Step 1 Choose Maintenance > Software Management from the main menu.

Step 2 Click the Device Upgrade Management, Optimizer Upgrade Management,
Shutdown Box Upgrade Management, or Batch Upgrade Management tab.

● To upgrade the inverter, you can perform related operations on the Device Upgrade
Management tab page.

● To upgrade the optimizer connected to the inverter, you can perform related operations
on the Optimizer Upgrade Management tab page.

● To upgrade the shutdown box connected to the inverter, you can perform related
operations on the Shutdown Box Upgrade Management tab page.

● To upgrade inverters under the same SmartLogger (the version of the SmartLogger
must be V100R001C95SPC030 or later) at the same time, you can perform related
operations on the Batch Upgrade Management tab page. This function applies only to
the scenario where the device accesses the NetEco 1000S through the SmartLogger.

Step 3 Upload the device software package to be upgraded.

1. Click Software Package Management.
2. Click Upload on the Software Package Management page.
3. Click Browser to select the software package, and then click Upload.

After the upload is complete, information about the new software package is
displayed in the software package list.

To delete the uploaded software package, select the software version in the software
package list and click Delete.

4. Click Close.

Step 4 Upgrade the software package of the device.

1. Select the devices to be upgraded in the device list.

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 99



– You can filter out the list of target devices by device name or plant name.
– On the Batch Upgrade Management tab page:

n If the SmartLogger allows inverters to be selected for upgrade, a check box
will be displayed before an inverter under the SmartLogger. Select the check
box before a target inverter to upgrade.

n If the SmartLogger does not allow inverters to be selected for upgrade, a
check box will not be displayed before an inverter under the SmartLogger.
Select the SmartLogger to upgrade inverters in batches.

2. Click Select Version.
The Select Target Version dialog box is displayed, showing all upgrade
software packages for the device type.

– If the selected target device is an inverter, the Select Target Version dialog box
shows the software packages applicable to the protocol version of the selected
inverter.

– If the selected target device is an optimizer, the Select Target Version dialog box
shows the software packages applicable to the register address of the selected
optimizer.

– If the selected target device is a shutdown box, the Select Target Version dialog
box shows the software packages applicable to the register address of the selected
shutdown box.

– If the selected target device is a SmartLogger, the Select Target Version dialog
box shows the software packages applicable to the V version (VXX in
VXXRXXCXX) of the selected SmartLogger.

3. Select the target version in the Select Target Version window and click OK.
4. Click Upgrade above the device list.

The upgrade progress is displayed in the Upgrade Progress column of the
device list.
When you upgrade multiple devices at the same time on the Device Upgrade
Management tab, you can click Stop Upgrade to stop the upgrade task
whose Current Status is Waiting.
Click Details under Current Status. Details about the inverter upgrade are
displayed, as shown in Figure 4-32.

Figure 4-32 Inverter upgrade details
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When Loading completed. is displayed, the NetEco automatically activates the inverter,
and The inverter is going to activate automatically is displayed. If the device does not
meet activation requirements, the NetEco automatically activates the device after activation
requirements are met. After the device is activated successfully, the NetEco displays the
latest device version.

----End

4.1.7.2 Obtaining Device Logs
This section describes how to obtain device logs for device analysis and
maintenance.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Maintenance > Device Maintenance from the main menu.

Step 2 Click the Device Log, or Optimizer Log tab.

The Device Log, or Optimizer Log window is displayed.

Step 3 Select a device in the device list, and click Obtain.

When Finish is displayed in the Execution Status column, device logs are
synchronized to the NetEco 1000S.

● You can filter out the list of target devices by device name or plant name.

● You can click  in the Operation column to stop obtaining device logs.

Step 4 Click Download the log or  in the Log File column to download the device log
file to the local PC.

----End

4.1.7.3 Obtaining the Inverter Patrol Report
This section describes how to obtain the inverter patrol report to help technical
support engineers learn the running counter values and state of health (SOH) of
inverters and to provide reference for device maintenance and exception location.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
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● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Maintenance > Device Maintenance from the main menu.

Step 2 Click the Inverter Patrol tab.

The Inverter Patrol tab page is displayed.

You can filter out the list of target devices by device name or plant name.

Step 3 Start the inverter patrol.

1. Select the target inverter in the device list and click Start Patrolling or  in
the Operation column.

2. When the following information is displayed, click OK:
Are you sure you want to execute the task

You can click Stop Patrolling above the device list to stop the patrol task.

Step 4 Obtain the inverter patrol report.

1. Select the target inverter for which a patrol report has been generated and
click Batch Download Report.
A message asking you whether to open or save data is displayed at the
bottom of the browser.

2. Click Download the report or  in the Patrol report column to download
the patrol report to the local PC.

----End

4.1.7.4 Managing Device List
User can view and export the device version, SN, and communication address on
the Device Management page, as well as modify device names in batches.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 Choose Maintenance > Device Maintenance from the main menu.
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Step 2 Click the Device Management tab.

Step 3 Set Device name, Version No., SN, PV plant or Device type, and click Query.

Target devices meeting the preset condition are filtered out.

Step 4 You can perform the following operations in the Device Management tab.

If You Need
To...

Then...

Export the
device list

Click Export to export the target device list queried.

Modify device
names

1. Change Device Name in the exported .xls file, and save
the file.

2. In the Device Management window, click Import Names.
The Import Names dialog box is displayed.
NOTICE

Only .xls files can be imported. The file size must be less than 2
MB. The file must contain the Device Name and ESN columns,
and the columns must not be empty.

3. Click Browse, and select the .xls file saved in Step 4.1.
NOTICE

During the Execution, the modification task will be stopped if you
close the Import Names dialog box.

4. Click Execution.
– During the Execution, you can click Stop to stop

unfinished modification task.
– If modifying device names fails, Details in Import

Names will provide the device whose name fails to be
modified and the failure cause.

5. Click Close.

Switch to the
web client of
the
SmartLogger

For a device whose Device type is SmartLogger, you can
click the Device address link in the Communication address
column to switch to the web client of the SmartLogger.

 

----End

4.1.7.5 Replacing a Device

This section describes how to replace a device. If the device connecting to the
NetEco 1000S needs to be replaced due to a fault or aging, you can replace it with
a new one. Devices supporting the replacement include the inverter, EMI, Meter,
optimizer, and SmartLogger.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
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● You have logged in as the installer.
● You have added a device to the NetEco 1000S and the device state is normal.

For details, see 4.1.4.1 Connecting Devices.
● The old device has been deleted or is disconnected from the NetEco 1000S.
● The new device and the old device are connected to the same PV Plant.

Procedure

Step 1 Choose Maintenance > Device Maintenance from the main menu.

Step 2 Click the Device Management tab.

The Device Management window is displayed.

Step 3 Click Replace Device.

The Replace Device dialog box is displayed.

Step 4 Select a device type, and enter the Old device SN, New device SN and Device
name. Then click OK.

Device name specified here is the name of the new device to be displayed in the NetEco
1000S. Device name must be different from the names of the existing devices in the same
PV plant.

● If you attempt to replace an inverter, meter, or EMI, and the old and new
devices are not connected to the same SmartLogger, the following message is
displayed.
The devices are not connected to the same SmartLogger. Continue?

● If you attempt to replace an optimizer, and the old and new devices are not
connected to the same inverter, the following message is displayed.
Devices not connected to same inverter. Continue?

Step 5 Click OK, and complete the device replacement as prompted.

If you want to cancel the replacement, click Cancel.

----End

4.1.7.6 Querying NetEco Alarms

If the NetEco 1000S certificate has expired, the license has expired, or remote
notification emails fail to be sent, the NetEco 1000S will generate a corresponding
NetEco alarm. You can query NetEco alarms to learn the NetEco alarm
information for the NetEco 1000S and handle alarms accordingly.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
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Context

Check the NetEco alarm icon in the upper right of the home page of the NetEco
1000S client to determine whether a NetEco alarm exists. If a NetEco alarm exists,
view the detailed alarm information on the NetEco Alarm page.

● : A NetEco alarm is generated on the NetEco 1000S.

● : No NetEco alarm is generated on the NetEco 1000S.

Procedure

Step 1 On the home page of the NetEco 1000S client, click the NetEco alarm icon .

The NetEco Alarm page is displayed.

Step 2 Set Time and Clear Status, and click Query.

NetEco alarms that meet the conditions can be queried.

Step 3 Click Alarm Name for a NetEco alarm record to view the detailed alarm
information and troubleshooting advice.

NetEco alarms whose details are not queried will be highlighted in bold.

Step 4 Optional: Click Export to export the queried alarm information into a CSV file.

----End

4.1.7.7 Obtaining NetEco Logs

This section describes how to obtain NetEco logs. The logs help you learn the
operating status of the NetEco 1000S and locate problems when the NetEco
1000S is not running properly.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context

The NetEco records run logs automatically every day. When the system becomes
abnormal, the system administrator quickly obtains the corresponding logs
through the client to locate the problem.

Procedure

Step 1 Choose Maintenance > NetEco Maintenance from the main menu.

Step 2 Choose Trace Log tab or Other Logs tab.

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 105



● To obtain the trace log, you can perform related operations on the Trace Log tab page.

The trace log records the system run log. When the system becomes abnormal, you can
obtain the trace log to locate the problem.

● To obtain other logs, you can perform related operations on the Other Logs tab page.

Other logs record all logs except the trace log. These logs include database error logs,
configuration file modification logs, attack logs, FTP logs, and script logs. When
problems cannot be located using the trace log, you can obtain other logs to facilitate
problem location.

1. Click Refresh. The latest log information is displayed.

2. Select the log to be obtained.

You can enter the log name keyword, such as the date, in the File Name text box and
click Search to search for all logs whose names contain this keyword.

3. Click Download.

A message asking you whether to open or save the log is displayed at the
bottom of the browser. You can open or save the log as required.

----End

4.1.7.8 Smart I-V Curve Diagnosis

The smart I-V curve diagnosis function allows you to check the health status of
strings for the inverters connected to the NetEco 1000S.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer.

● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.

● String parameters have been configured for inverters. For details about how
to configure the parameters, see 4.1.4.4 Modifying the Information About a
Device.

● The inverter license controls the smart I-V curve diagnosis function. To ensure
that smart I-V curve diagnosis works properly, perform scheduled inspection
and import the inverter license file. For details, see 4.1.7.9 Managing Device
Licenses.

Procedure

Step 1 Choose Maintenance > Smart I-V Curve Diagnosis from the main menu.

The Smart I-V Curve Diagnosis page is displayed, as shown in Figure 4-33.
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Figure 4-33 Smart I-V Curve Diagnosis

The content in the red frame in Figure 4-33 is the conditions and suggestions for
smart I-V curve diagnosis. Read the content carefully and ensure that the
conditions are met. To minimize the content, click Operation Suggestion.

Step 2 Click Start Scanning.

The Settings of Task page is displayed, as shown in Figure 4-34.

Figure 4-34 Task Settings

Step 3 Set the I-V diagnosis task.

1. Set I-V diagnosis parameters, as described in Table 4-13.

Table 4-13 Description of I-V diagnosis parameters

Parameter Description

Task name Set this parameter to a string of a maximum of 64
characters.
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Parameter Description

Task type Value:
– Task On Plant-Level: The health check applies to

strings for all inverters connected to a PV plant.
– Task On Inverter-Level: The health check applies to

all strings for an inverter.

PV plant In the PV plant area, select the SmartLoggers or
inverters to be scanned.
– An unlimited number of SmartLoggers can be

scanned simultaneously.
– A maximum of 100 inverters can be scanned

simultaneously.

Cleaning status Specifies the cleaning status of a string. Select a value as
required.

Environmental
data

Select a mode from the drop-down list box.
Value range:
– Auto: The system will automatically calculate the

values of Irradiance and Temperature of panel.
– Manually: You need to manually enter the values of

Irradiance and Temperature of panel.

Irradiance This parameter is displayed only if Environmental data
is set to Manually.

Temperature Of
Panel

This parameter is displayed only if Environmental data
is set to Manually.

 

2. Click Save.

After a task is set, smart I-V curve diagnosis starts immediately, as shown in
Figure 4-35.

Figure 4-35 Executing a diagnosis task

● To stop a I-V diagnosis task, click  in the Operation column. After a
diagnosis task is stopped or the string diagnosis scanning is complete,  will
not be displayed on the page.

● After a diagnosis task is stopped or the string diagnosis scanning is complete,
and the Status of the task is Partially completed, Failed, or Terminated, you
can click  to restart the unfinished or failed task.

Step 4 View the diagnosis result and diagnosis details.
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1. Click  under Operation column in Figure 4-35.
The diagnosis task execution result is displayed, as shown in Figure 4-36.

Figure 4-36 Diagnosis result

Table 4-14 describes the parameters in the diagnosis result.

Table 4-14 Description of diagnosis parameters

Parameter Description

Task Status Status of the I-V diagnosis task

Health condition Health status of strings

Operation – Export the diagnosis details: Select the string
whose diagnosis details are to be exported and
click Export to export the diagnosis details in
batches.

– View the diagnosis details. For details, see Step
4.2.

 
2. View the diagnosis details.

a. Click Read The Details.
The diagnosis details are displayed, as shown in Figure 4-37.
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Figure 4-37 Diagnosis details

You can view the detailed parameters and current and power curves of
strings on the Read The Details page.

b. Click Export.
You can export the detailed information of strings.

Step 5 Query the intelligent diagnostic report.

1. Click  under Operation column in Figure 4-35.
The Diagnostic Report page is displayed.
– Query Information of Task.

The basic information of the string diagnosis task is displayed.
– Query Overview on Diagnosis.

The pie chart and detailed information of the diagnosis result are
displayed, as shown in Figure 4-38.

Figure 4-38 PV string diagnosis overview

For the overview parameter description, see Table 4-15.
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Table 4-15 PV string diagnosis overview

Parameters Description

Legend Corresponds to each legend in the pie chart.

Quantity Sum of the strings.

Ratio Proportion of the strings.

Description Description of health status for strings.

Following Advise Click  to display suggestions for each exception.

 
– Query List Of Defective Strings.

Information of all defective strings is displayed, as shown in Figure 4-39.

Figure 4-39 Defective string list

In the red frame, the optimal value, intermediate value, and average value of the
scanned normal strings are displayed as well as related parameter information of
corresponding strings.

2. Optional: Select a string under the Comparison column to display the I-V
curve comparison analysis diagram of the corresponding string, as shown in
Figure 4-40.

Figure 4-40 String I-V curve comparison analysis diagram

3. Click Return in the upper left corner of the page. The Smart I-V Curve
Diagnosis page is displayed.

Step 6 Optional: Export the smart I-V diagnosis report.

1. Click  under Operation column in Figure 4-33.
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The Smart I-V Diagnosis Report Export dialog box is displayed, as shown in
Figure 4-41.

Figure 4-41 Smart I-V Diagnosis Report Export

2. Select the reports to be exported as required, and click OK.

----End

4.1.7.9 Managing Device Licenses

The inverter license controls the smart I-V curve diagnosis function. You can
manage device licenses on the NetEco 1000S client, for example, loading device
licenses and viewing device license information. The NetEco 1000S supports
license management only for inverters.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the installer.

● You have added a device to the NetEco 1000S and the device state is normal.
For details, see 4.1.4.1 Connecting Devices.

Procedure

Step 1 On the main menu, choose Maintenance > Device License Management.

Step 2 In the navigation tree on the left, select the target device.

You can also specify parameters such as Device name, SN and License Status on
the License Details, License Application, License Loading, or License
Revocation tab page, and then click Query. The devices that meet the search
criteria are displayed.

Step 3 Perform operations according to Table 4-16.
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Table 4-16 License-related operations

Task Name Task
Description

Procedure

Querying
license
information

For routine
operation and
maintenance,
the license
validity and
function usage
are queried
routinely to
check whether
the license is
about to expire
and solve the
problems in a
time manner.
In this way, the
device can
function
properly.

Choose License Details to view the license
information of the target device.
1. Select the target device and click Refresh.

The license information is refreshed.
2. Click Device Name of the target device.

Then the function control information of the
device will be displayed in the lower part of
the page, as shown in Figure 4-42.

Figure 4-42 Function control information

3. Optional: Export license details.
– To save the license information about all

devices queried to the local PC, select
Export All from the Export Details drop-
down list box.

– To save the license information about a
specific device queried to the local PC,
select the target device in the displayed
operation area, and select Export
Selected from the Export details drop-
down list box.

NOTE
The license information file is saved as a .csv file.

Exporting a
license
application
file

The license
application file
contains the
content
required for
applying the
device license.
When you
need to apply
for a device
license, export
a license
application file
on the License
Application
page.

1. Choose License Application.
2. Export the license application file.

– To save the license application file of all
devices queried to the local PC, select
Export All from the Export License
Application File drop-down list box.

– To save the license application file of a
specific device queried to the local PC,
select the target device in the displayed
operation area, and select Export
Selected from the Export License
Application File drop-down list box.

NOTE
The license application file is saved as an .xls file.
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Task Name Task
Description

Procedure

Loading a
license

If the license
has not been
imported for
the device or
the license is
about to
expire, you
need to import
the new
license file to
the device,
ensuring that
the device
functions
properly.

1. Choose License Loading.
2. Click Upload License.

The Upload License dialog box is displayed.
3. Click Browse and select the license to be

imported.
The License file format should be either .dat
or .zip. The number of license file in .zip file
cannot exceed 6000.

4. Click Upload.
The license file is uploaded.

5. Load the license.
– To import the loaded license file to all the

devices queried, select Load Allfrom the
Load License drop-down list box.

– To import the loaded license file to a
specific device queried, select the target
device in the displayed operation area,
and select Load Selected from the Load
License drop-down list box.

Revoking a
license

Before a device
is replaced, the
current device
license needs
to be revoked
so that the
revocation
code can be
generated and
used for
applying for a
new device
license. After
the monitoring
board or
device is
replaced, you
can import the
new license file
to the device,
and then the
device
functions
properly.

1. Choose License Revocation.
2. Select the device whose license needs to be

revoked.
3. Click Revoke License.
4. In the displayed Warning dialog box, enter

the password of the user and click OK.
5. Optional: Export the revocation code file.

– To save the revocation code file of all
devices queried to the local PC, select
Export All from the Export Revocation
Code File drop-down list box.

– To save the revocation code file of a
specific device queried to the local PC,
select the target device in the displayed
operation area, and select Export
Selected from the Export Revocation
Code File drop-down list box.

NOTE
The revocation code file is saved as an .csv file.

 

----End
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4.1.8 System Management

4.1.8.1 Managing User Information
This section describes how to manage user information. The user management
function allows you to manage the information about and operation rights of
users.

4.1.8.1.1 User Categories

This section describes user categories. You need to familiarize yourself with these
user categories before managing users.

Software users: installers, guest users, and customers.

Third-party user: OpenAPI users.

Operation permissions vary by user. Table 4-17 lists the software users and their
operation permissions.

Table 4-17 User operation permissions

User Category Operation Permissions

Installers ● PV plant management: Allows you to create
and delete PV plants, set information of PV
plants, and view information about PV
plants, device lists, and current alarms.

● Device management: Allows you to
automatically connect devices, delete
devices, set information of devices, view
device details and current alarms, and
remotely control an inverter, SmartLogger
and PID.

● Historical data: Allows you to query alarm
logs, performance data, and data analysis,
synchronize historical performance data, and
export data.

● Device maintenance: Allows you to obtain
device logs, patrol to the inverter, replace
devices, manage device list, perform smart I-
V curve diagnosis, and manage device
licenses.

● System management: Allows you to manage
users and set remote notifications.
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User Category Operation Permissions

Guest users ● PV plant management: Allows you to modify
descriptions and parameters of PV plants,
upload and delete PV plant images, and view
information about PV plants, device lists, and
current alarms.

● Device management: Allows you to view
device details, device settings, and current
alarms.

● Historical data: Allows you to query alarm
logs, performance data, and data analysis,
and export data.

NOTE
● Historical data query permissions need to be

assigned by the installer to the guest user.
● After the installer modifies the permissions of the

guest user, the guest user needs to log in to the
NetEco 1000S again to refresh the permissions.

Customers Allows you to visit the Overview page to query
the overview of the plant.
● PV plant management: Allows you to create

PV plants, set information of PV plants, and
view information about PV plants and device
lists.

● Historical data: Allows you to export data
and query data analysis.
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User Category Operation Permissions

OpenAPI users
NOTE

● The OpenAPI users can only
be created by the installer.

● The OpenAPI users do not
have permission to access
the NetEco 1000S or query
other user information in the
NetEco 1000S.

● To improve system security
and prevent security risks
(for example, violent
password cracking), change
the initial password set upon
device delivery in a timely
manner and change the user
password periodically (for
example, every six months).
If the password is lost,
stolen, or cracked, the user
shall be liable for any loss
incurred.

● For account security
purposes, you are advised to
change the user password
periodically (for example, at
an interval of 3 months) to
avoid security risks, such as
violent key cracking.
If an installer creates the
OpenAPI user, only the
installer can reset the
password.

You can access the data query interface to
query the following data:
● PV plant list;
● Device list (only inverter and EMI data

included);
● Real-time monitoring data of a specific PV

plant;
● Real-time monitoring data of a device under

a specific PV plant (only inverter and EMI
data included);

● Yearly, monthly, and daily performance data
of a specific PV plant as well as its total
performance data.

 

4.1.8.1.2 Registering a User

You can register yourself as an installer or customer on the NetEco 1000S.

Prerequisites
● You have set the email server.
● You have enabled the self-registration account on the NetEco 1000S.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.
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Procedure

Step 1 Enter the login page, as shown in Figure 4-43.

Figure 4-43 Login page

Step 2 Click New Account on Figure 4-43.

The User Registration page is displayed, as shown in Figure 4-44.
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Figure 4-44 Registration

Step 3 Set the parameters, and click New Account.

The senior manager can manage the PV plant created by the registered user.

● If the registered user is Installer, enter the email address of an existing manager in the
system.

● If the registered user is Customer, enter the email address of an existing manager or
installer in the system.

A dialog box is displayed, reminding you to activate the registered account in your
mailbox.

NO TICE

● The activation link in the mailbox is valid for 24 hours. If the account is not
activated within 24 hours, you need to register a user again.

● The validity period of the activation link can be modified by changing the
configuration file.
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Step 4 Go to the mailbox and click the activation link to activate the NetEco 1000S
account.

After the account is activated, the login page is displayed, where you can log in
with the registered account name and password.

----End

4.1.8.1.3 Adding a User

This section describes how to add a user on the NetEco 1000S. You can add users
as required. The operation permissions of users vary according to user categories.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose User from the menu bar on the left.

The User page is displayed, as shown in Figure 4-45.

Figure 4-45 User

Step 3 Click Create User.

The Create User page is displayed.

Step 4 Set the user parameters according to Table 4-18.
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Table 4-18 Parameter description

Parameter Description

User Name Name of the new user.
The user name can only contain English characters (A
to Z and a to z), digits, hyphens, or underlines.
NOTE

The user name cannot be null or NULL.

Password Password of the new user. The password must comply
with the following rules:
● The password cannot be the same as the user

name or the user name in a reversed order.
● The password contains 8 to 32 characters.
● The password contains three of the following:

– Lowercase letters
– Uppercase letters
– Digits

● The password is advised to contain special
characters, which include !"#$%&'()*+,-./:;<=>?
@[\]^`{_|}~ and space.

Email Address Email address of the user.

User Type Type of the user.
● Guest
● Customer
● OpenAPI User.

User Status Status of the user. The status includes:
● Enable: The user can log in to the NetEco 1000S.
● Disable: The user is disabled and cannot log in to

the NetEco 1000S.

Optional Permissions
NOTE

This parameter would be
displayed only when the
created user is a guest
user.

The installer can assign the historical data query
permissions to the guest user.
● Select Query historical data: indicating that the

guest user has the historical data query
permissions.

● Clear Query historical data: indicating that the
guest user does not have the historical data query
permissions.

Email password
NOTE

This parameter would be
displayed only when the
created user is a
customer.

The status includes:
● Yes: The customer will receive an email informing

customer of the login account and password.
● No: The customer will not receive an email

informing customer of the login account and
password.
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Parameter Description

Company Company description of the user.

Select a PV plant that
can be accessed

Permission for the user to access the PV plant.

 

Step 5 Click OK

The added user is displayed in the user list in the User page.

----End

4.1.8.1.4 Modifying User Information

If user information changes, the user password is forgotten, or the account status
needs to be changed, the user information can be modified.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose User from the menu bar on the left.

The User page is displayed, as shown in Figure 4-46.

Figure 4-46 User

Step 3 In the User page, you can do the following operations in Table 4-19.

Table 4-19 operations

Operations Description

Enable If the Use Status is invalid, you can click  to
enable the account.

Disable If the Use Status is normal, you can click  to
disable the account.

Unlock If the Use Status is lock, you can click  to unlock
the account.
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Operations Description

Edit Click  to modify the user name, use status, guest
users' permissions on optional functions, company
information, and PV plant permissions.

Password reset When a user forgets the password for logging in to
the NetEco 1000S, the user can reset the password,
and then use the new password to log in to the
NetEco 1000S.
NOTE

● The password cannot be the same as the user name or
the user name in a reversed order.

● The password contains 8 to 32 characters.
● The password contains three of the following:

– Lowercase letters
– Uppercase letters
– Digits

● The password is advised to contain special characters,
which include !"#$%&'()*+,-./:;<=>?@[\]^`{_|}~ and
space.

1. Click .
2. In the displayed window, set New password and

Confirm password.
3. Click OK.

Delete
1. Click .
2. In the displayed window, click OK to delete the

account.

 

----End

Follow-up Procedure

In the User page, you can view the use list. The description of all parameter is as
shown in Table 4-20.

Table 4-20 GUI parameters

Parameter Description

User Name Displays names of all accounts in the system.

User Type Displays the type of an account. The type includes Installer,
Guest, Customer, and OpenAPI User.

PV Plant Displays the PV plant(s) to which the user belongs

Email address Email address of the user.
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Parameter Description

Company Displays the company description of an account.

Status Displays the status of an account. The status includes:
● normal: indicates that the account is properly used.
● invalid: indicates that the account is currently not used.
● lock: indicates that the account is automatically locked by

the system after the user enters the incorrect password
for multiple times or disobeys the password policy.

● Freeze: indicates that the account currently cannot be
used. You cannot log in to the NetEco 1000S. The state of
the remote notification rule you created is Freeze. You
cannot receive any emails or SMS notifications from the
NetEco 1000S.

 

4.1.8.1.5 Querying PV Plants to Which a User Belongs

This section describes how to query PV plants to which a user belongs. This helps
learn the PV plants that the user can operate and user information recorded in the
PV plants, facilitating the PV plant administrator's management operation.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose User from the menu bar on the left.

The User page is displayed, as shown in Figure 4-47.

Figure 4-47 User

Step 3 Set search criteria.
● PV plant: Enter the name of the to-be-queried PV plant. You can enter names

of multiple PV plants and separate them by semicolon (;).
● User Name: Enter the to-be-queried user name.

You can set PV plant or User Name as required.
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Step 4 Click Query.

----End

4.1.8.1.6 Modifying the Password of the Current User

This section describes how to modify the password of the current user. You are
advised to modify user password regularly to ensure system security.

Prerequisites

You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In to
the NetEco 1000S Client.

Procedure

Step 1 Click  from the main menu.

The Modify Password dialog box is displayed, as shown in Figure 4-48.

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Figure 4-48 Modify Password

Step 2 Enter the old password and new password and confirm the new password.
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● The password cannot be the same as the user name or the user name in a reversed
order.

● The password contains 8 to 32 characters.

● The password contains three of the following:

– Lowercase letters

– Uppercase letters

– Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

Step 3 Click OK.

----End

4.1.8.1.7 Setting an Account Policy

This topic describes how to set an account policy to improve access security of the
NetEco. The account policy settings include the length of the user name and the
policies related to user login.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
● The account policy applies to the following users after the account policy is

successfully set:
– New users.
– Users whose information is modified.

● Account policies apply to all accounts except system administrator.
● The NetEco provides the default account policy, and you can modify it as

required.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 In the navigation tree on the left, choose Account Policy.
● a manager, installer, guest user, or customer: The current login account will be

locked if the number of consecutive failed login attempts exceeds the preset
value within a certain period. For details about how to unlock the account,
see 4.1.8.1.4 Modifying User Information.

● the system administrator: The current login IP address will be locked 5
minutes if the number of consecutive failed login attempts more than 5
within 10 minutes.
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NO TICE

Restart the service will make the lock failed, please use caution.

Step 3 On the Account Policy page, set the account policy as required.

When Account disabling policy is selected, this policy is applicable to all users
except the admin user. If a user has not logged in for a consecutive period longer
than the period specified in The account has not been used for (consecutive
days), the account will be disabled.

To enable a disabled account, see 4.1.8.1.4 Modifying User Information and
perform the required operations.

Step 4 Click Apply.

----End

4.1.8.1.8 Setting a Password Policy

You can set a password policy to improve access security of the NetEco. The
password policy settings include the user password complexity rules, password
change interval, and character restriction.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
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Context
● A password policy applies to all users once it is configured. After the

minimum length of the user password is specified and validated, if an online
user wants to change the password, the user needs to set the new password
based on the specified minimum password length requirements.

● You need to set a password based on the password policy when you create a
user.

● A new password policy does not affect the configured password.
● The NetEco provides the default password policy, and you can modify it as

required.

NO TICE

Disabling the functions of password strength policies and password change
intervals will lower account security. You are advised to enable all password
security policies provided by the NetEco.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose Password Policy from the menu bar on the left, as shown in Figure 4-49.

Figure 4-49 Password Policy

Step 3 In the window shown in Figure 4-49, set Password Policy as required.

When you change the passwords of other users as system administrator, the value of
Enable account lock policy has no impact on the change. That is, the password change
interval is not limited when you change the passwords of other users as system
administrator.

Step 4 Click Apply.

----End
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4.1.8.1.9 Managing the Online Users

You can view online user to find unauthorized login users and log out these users,
which prevents unauthorized operations performed on the NetEco 1000S client.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 In the navigation tree on the left, choose View Online User.

Step 3 On the View Online User page, view online users, and their login time, login IP
addresses, and roles to which they belong. In addition, you can perform the
following operations:

Task Procedure

Update online user
information

Click Refresh to update the online user information.

Force a user to log out When viewing online users, you can force an
unauthorized user to log out. This prevents the
unauthorized user from performing unauthorized
operations on the NetEco 1000S client.

1. On the View Online User page, click  in the
Operation column where the required user
information is located.

2. In the Warning dialog box, click OK.
NOTE

You are advised to view the online users at regular time,
force the unauthorized users to log out in time.

Enter Single session
Mode

Users can enter the single-session mode to prevent
the interference from other users' operations.
1. Select Single session Mode.
2. In the Warning dialog box, click OK.
NOTE

● After entering the single-session mode, users can log in
to the NetEco 1000S only on one terminal.

● After entering the single-session mode, the logged-in
users are not affected.

● Single-session is a safe mode, recommended for use.
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Task Procedure

Exit Single session Mode 1. Deselect Single Session Mode .
2. In the Warning dialog box, click OK.
NOTE

After exiting the single-session mode, users can re-log in
to the NetEco 1000S on multiple terminals.

 

----End

4.1.8.1.10 Setting the Idle Logout Time

This topic describes how to set the client to be logged out automatically. To
prevent other users from performing unauthorized operations, the NetEco 1000S
allows you to set related idle parameters. The client is automatically logged out
after being left idle for a specified period of time.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
This operation applies to the system administrator, managers, installers, guest
users and customers. For OpenAPI users, the idle logout time is 20 minutes and
cannot be modified.

Procedure
Step 1 Choose System > User Management from the main menu.

Step 2 Choose Logout Time Setting on the left.

The Logout Time Setting page is displayed, as shown in Figure 4-50.

Figure 4-50 Logout Time Setting
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Step 3 Set the value of Logout time (minutes).

By default, NetEco 1000S enables the function of logging out users after timeout.
To disable this function, clear Logout Time Settings.

The logout time ranges from 1 to 1440 minutes. Setting the logout time within 3 minutes is
advised.

Step 4 Click Save.

----End

Follow-up Procedure
After the client is automatically logged out, the current user needs to log in to the
NetEco 1000S again.

4.1.8.1.11 Setting an IP Access Control Policy

This section describes how to set an access control policy. In this way, users can
only use the specified IP address to log in to the NetEco, ensuring the access
security of the NetEco.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
To ensure the access security of the NetEco, you are advised to set an access
control policy.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose Client IP Address from the menu bar on the left.

Step 3 In the displayed Client IP Address window, click Create, as shown in Figure 4-51.
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Figure 4-51 Client IP Address

Step 4 Set Start IP address, End IP address, and Description for accessing the client and
click OK.

----End

4.1.8.1.12 Setting Login Time Control Policies

After the login time control policies are set, users other than admin can log in to
the NetEco 1000S only at the specified control time, which ensures NetEco 1000S
access security.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the system administrator.

Context

If system administrator wants to control the time segment on which other users
can access the NetEco 1000S, login time control policies need to be set. After the
login time control policies are enabled, the following functions can be
implemented:

● Users other than admin can log in to the NetEco 1000S only on the control
time segment.

● The logged-in user will be forcibly logged out if the valid access time expires.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose Login Time Control from the menu bar on the left.

The Login Time Control page is displayed, as shown in Figure 4-52.
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Figure 4-52 Login Time Control

Step 3 Select Enable login time control.

Information shown in Figure 4-53 is displayed.

Figure 4-53 Login time control enabling prompt

Step 4 Set login time control policies according to Table 4-21.

Table 4-21 Setting login time control policies

Parameter Configuration Method

Start date Select the start date for the login from the drop-down
list.
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Parameter Configuration Method

End date Select the end date for the login from the drop-down
list.
The end date must be later than or equal to the start
date.

Start time Select the start time for the login from the drop-down
list. Other users are allowed to access the NetEco 1000S
since the start time.

End time Select the end time for the login from the drop-down
list. Other users are not allowed to access the NetEco
1000S after the end time.
The end time must be later than or equal to the start
time.

Description (Optional) Enter the description information about the
login time control policy. A maximum of 255 characters
are allowed.

 

----End

4.1.8.1.13 Setting Access Control Policies for Mobile Terminals

This section describes how to set access control policies for mobile terminals. In
this way, users can log in to the NetEco only from the specified mobile terminal,
ensuring the access security of the NetEco.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● You have obtained the identification number of the mobile terminal.

Identification number of the iOS mobile terminal is the IDFV identifier. Identification
numbers of other mobile terminals are IMEIs/MEIDs of mobile phones or MAC
addresses of tablets.

Context
● To ensure the access security of the NetEco, enable the access control policies

for mobile terminals is advised.
● The identification number of the mobile terminal has been anonymized on

the NetEco 1000S WebUI to protect user's privacy.

Procedure

Step 1 Choose System > User Management from the main menu.
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Step 2 Choose Mobile Terminal from the menu bar on the left.

Step 3 In the displayed Mobile Terminal page, click Create Mobile Terminal.

The Create Mobile Terminal page is displayed, as shown in Figure 4-54.

Figure 4-54 Mobile terminal access setting

Step 4 Enter the Identification Number of the mobile terminal that is allowed to access
the NetEco, set Description, and click OK.

After the access control policies are set, the page similar to Figure 4-55 is
displayed.

Figure 4-55 Access Control Policy

Step 5 Perform the following operations in the Figure 4-55 window.
● Select Enable Access Control: The access control policy for the mobile

terminal is enabled, and users can log in to the NetEco only from the
specified mobile terminal.

● Deselect Enable Access Control: The access control policy for the mobile
terminal is disabled, and users can log in to the NetEco from any mobile
terminals.

----End

Follow-up Procedure

● You can click  in Operation column to modify the specified mobile
terminal.

● You can click  in Operation column to delete the specified mobile
terminal.

● You can click  in Operation column to export the specified mobile terminal
information.

4.1.8.1.14 Changing the Privacy Policy and Terms of Use

The Privacy Policy and Terms of Use will be changed in compliance with local laws
and conditions. The NetEco 1000S provides the function of changing Privacy Policy
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and Terms of Use online. The system administrator is entitled to change the
Privacy Policy or Terms of Use file of any language on the Privacy Policy and
Terms of Use page as required.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● You have enabled the Privacy Policy or Terms of Use while installing the

NetEco 1000S.

Procedure

Step 1 Choose System > User Management from the main menu.

Step 2 Choose Privacy Policy and Terms of Use from the menu bar on the left.

The Privacy Policy and Terms of Use window is displayed.

Figure 4-56 Changing the Privacy Policy and Terms of Use

Step 3 Upload the Privacy Policy or Terms of Use file of the corresponding language as
required.

A message indicating that the file has been uploaded successfully is displayed on
the NetEco 1000S.

Step 4 Click Release.

The message The release will forcibly log out all online users. Continue? is
displayed on the NetEco 1000S.

● Click OK. All online users will be forcibly logged out of both the NetEco 1000S
client and the NetEco 1000S app. You must be authorized again on the
NetEco 1000S client upon re-login before you can continue using the NetEco
1000S.

● Click Cancel. Cancel the release.

----End
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4.1.8.2 Querying User Operation Logs
This section describes how to query user operation logs to know the operations
performed by users.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
The NetEco 1000S checks whether the operation log is out of the life cycle, or
whether the number of user operation logs exceeds the preset threshold, at the
specified time every day. If the operation log is out of the life cycle, the NetEco
1000S automatically deletes the exceeding logs. If the number exceeds the
threshold, the NetEco 1000S automatically deletes 20% of the operation logs.

● Check time: 01:00 every day.
● Life cycle: half a year by default. You can change the life cycle of operation

logs by referring to 4.1.9.23 What Do I Do to Change the Life Cycle of
Operation Logs?.

● Threshold: 100,000.

● The user operation logs about user authorization will not be deleted, unless this user is
deleted.

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you are obligated to take measures, in
compliance with the laws of the countries concerned and the user privacy policies of
your company, to ensure that the personal data of users is fully protected.

Procedure

Step 1 Choose System > Log Management from the main menu.

The Log Management window is displayed.

Figure 4-57 Log Management

Step 2 Optional: Set the query criteria by referring to Table 4-22.

Table 4-22 Query criteria parameters

Parameter Description

User name Name of a user.
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Parameter Description

Module Module in which an operation is performed, including:
● Device Management: involves plant creation,

modification, and deletion, device search, device access,
and device deletion.

● Configuration Management: involves device information
modification and control command delivery.

● Security Management: involves user login and logout,
and user creation, user information modification, and
user deletion.

● Software Management: involves software package
upload, device upgrade, and software package deletion.

● Device Maintenance: involves the obtaining of the
inverter patrol report, device name modification in batch,
device replacement.

● Device log: involves the obtaining of device logs.
● Remote Notification: involves email server parameter and

SMS message server parameter modification, and remote
notification rules creation, modification, deletion,
enabling, and disabling.

● System Settings: involves the clock synchronization, baud
rate modification, alarm resetting, benefit setting, and
collection period setting.

● Performance Management: involves historical
performance data synchronization.

● Smart I-V Curve Diagnosis: involves the start, execution,
and stop of smart I-V curve diagnosis tasks and export of
diagnosis reports.

● License Management: involves querying license
Information, importing or revoking a license and
obtaining an ESN.

● Device License Management: involves exporting, loading,
and revoking device license.

● Alarm Management: involves exporting historical alarm
information.

Object Object on which an operation is performed, including:
● Local NetEco
● NetEco 1000S user
● plant
● Device

Client IP address IP address of the PC client or identification number of the
mobile client used for the login.
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Parameter Description

Operation type Type of operation a user has performed, including:
● System login
● System logout
● Search
● Add
● Synchronize
● Upgrade
● Modify
● Delete
● Reset
● String scanning

Operation time The value must be a time segment.
The start time must be earlier than or equal to the end
time.

Contents Operation performed by a certain user.

Level Log level, including:
● Risk
● Minor
● Warning

Log type Log type, including:
● System Logs: record NetEco 1000S running exceptions,

network faults, and NetEco 1000S attacks.
● Operation Logs: record device addition and deletion.
● Security Logs: record NetEco 1000S security operation

information, such as logging in to the client, changing
the password, creating a user, and exiting the client.

 

Step 3 Click Query.

----End

Follow-up Procedure

You can click  in the upper right corner to export the personal data in the
queried user operation logs.

4.1.8.3 Setting Remote Notification

This section describes how to set remote notification. The NetEco 1000S notifies
users of information about alarms or generated power remotely based on remote
notification rules.
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4.1.8.3.1 Setting Parameters for the Email Server

This section describes how to set parameters for the email server for sending
emails to users.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● The PC on where the NetEco 1000S software is installed is properly connected

to the email server, and you have obtained the email server's IP address (or
domain name) and port number that are used for email transmission from
the email server OM personnel.

NO TICE

● TLS communication protocols include TLS1.0, TLS1.1, and TLS1.2. The
NetEco supports TLS1.1, and TLS1.2 protocols. TLS1.0 has security risks.
The NetEco uses TLS1.2 by default.

● If an email server supports only TLS1.0, the communication connection
may be insecure. In this case, replace the email server with one supporting
TLS1.1 or TLS1.2.

● The mail filtering function of the antivirus software has been disabled for the
operating system.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Choose System > Remote Notification from the main menu.

Step 2 Choose Email Server.

The Setting parameters for email server window is displayed, as shown in
Figure 4-58.
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Figure 4-58 Setting parameters for email server

Step 3 Setting parameters for email server by referring to Table 4-23.

Table 4-23 Setting parameters for email server

Parameters Description

Email sending
server

Enter the IP address or domain name of the SMTP email
server.
If the domain name of a website is
www.yourdomain.com, the domain name of the SMTP
email server for this website may be one of the following:
● smtp.yourdomain.com
● mail.yourdomain.com
● smtp.mail.yourdomain.com
For example, the domain name of the SMTP email server
for email@126.com is smtp.126.com.
If the domain name of the SMTP email server obtained
based on the preceding domain naming rule is invalid and
email-based remote notification fails to be enabled,
contact the email service provider to obtain the valid
domain name of the SMTP email server.
The domain names of the SMTP email servers for some
frequently used email boxes are as follows:
● 126.com: smtp.126.com.
● gmail(google.com): smtp.gmail.com.
● 21cn.com: smtp.21cn.com.
● 163.com: smtp.163.com.
● sohu.com: smtp.sohu.com.
● yahoo.com: smtp.mail.yahoo.com.
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Parameters Description

Email sending port
No.

Port of email server
NOTE

● Select SSL, the default port is 465.
● Select SSL, the default port is 587.
● Select SSL, the default port is 25.

Sender email
address

Enter the email address of the sender.

Check permission If the SMTP email server requires authentication, select
Check permission, and set the user name and password
for connecting to the SMTP email server.

Encryption ● If SSL or TLS is selected, the email is sent in an
encrypted manner.

● If Closed is selected, the email is sent in a non-
encrypted manner.

The encrypted transmission is recommended.

 

Step 4 Optional: Test whether the parameters for the email server are set correctly.

1. Click Test in the Setting parameters for email server page.
2. Enter the Recipient email address in the Test Email text box, and click OK.

The test mail is received.

Step 5 Click Save.

----End

Exception Handling

If The test email has been sent. Please check. is displayed on the NetEco 1000S
during testing whether the parameters configured for the email server are correct,
but the test mail is not received, check the following items:

● Select Check permission.
● Sender email address and User name are the same.

4.1.8.3.2 Setting Parameters for the SMS Modem

This section describes how to set parameters for the SMS modem for sending SMS
messages to users.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● NetEco 1000S is standard edition.
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● The SMS modem has been properly installed, and you have obtained the
serial port number used for communication between the PC and the SMS
modem.

● You have obtained the phone number of the SMS center from the telecom
operator providing the SMS service.

● You have enabled the function of serial ports.

NO TICE

To ensure NetEco 1000S system security, the NetEco 1000S shields the function of
serial ports by default. After completing the operation, disable this function
immediately. Perform the following operations to enable and disable the function:
● Enable the function: Navigate to the NetEco 1000S installation directory

\WebRoot\WEB-INF\classes directory, open the userManagement.properties
file, change the value of isStartCom to 1, and save the change result. Then,
restart the NetEco 1000S.

● Disable the function: Navigate to the NetEco 1000S installation directory
\WebRoot\WEB-INF\classes directory, open the userManagement.properties
file, change the value of isStartCom to 0, and save the change result. Then,
restart the NetEco 1000S.

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Choose System > Remote Notification from the main menu.

Step 2 Click SMS Modem.

The Setting parameters for SMS modem window is displayed, as shown in
Figure 4-59.
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Figure 4-59 Setting parameters for SMS modem

Step 3 Setting parameters for SMS modem by referring to Table 4-24.

Table 4-24 Setting parameters for SMS modem

Parameters Description

Serial port No. Enter the RS232 serial port number for
communication, through which the SMS modem
and the PC are connected.

Baud rate Choose a matching baud rate.

SMC No. Enter the number of the SMC which is obtained
from the SMC operator.
NOTE

SMC No. must be set according to the following
requirements:
● A country code must be added preceding the calling

number. For example, if the subscriber is located in
China, the entered calling number is in the following
format: +86Calling number.

● If short messages are successfully sent but the
subscriber does not receive the short messages, you
need to remove the country code.

 

Step 4 Optional: Test that parameters for the SMS modem are set correctly.

1. Click Test in the Setting parameters for SMS modem page.
2. Enter the test Phone NO. in the Receiver phone No. text box.
3. Click OK.

Step 5 Click Save.

----End
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4.1.8.3.3 Setting Alarm Sending Rules

This section describes how to set alarm sending rules. Based on the preset alarm
sending rules, the NetEco 1000S sends emails or SMS messages to notify users of
alarm information.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have set the email server.
● In the NetEco 1000S standard system, to send SMS messages, the GSM

modem must be set beforehand.

Context
● The NetEco 1000S notifies users of alarm information by email: After the

NetEco 1000S receives an alarm reported by a device, the NetEco 1000S waits
for 3 minutes, and then sends all alarm information received within 3 minutes
to users using one email.

Alarm send delay time specifies the time that the NetEco 1000S waits before sending
alarms. The default value of Alarm send delay time is 180s, that is, 3 minutes. After
the value of Alarm send delay time is changed, the waiting period changes
accordingly.

● The NetEco 1000S notifies users of alarm information by SMS: The NetEco
1000S sends the alarm information to users by SMS once receiving an alarm
reported by a device.

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Choose System > Remote Notification from the main menu.

Step 2 Click Alarm Send Settings.

Step 3 In the Alarm Send Settings page, you can perform the following operations.
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If You Need
To...

Then...

Create alarm
sending rules

An alarm notification rule is enabled by default once it is
created.
1. Click Create.
2. On the Create Rule page, set parameters and click Save.
NOTE

● You can select the alarm email and SMS language by setting Mail
language.
– Available languages include: Chinese, English, Japanese,

French, German, and Italian.
– The Mail language uses the display language on the NetEco

1000S by default.
● In the NetEco 1000S standard system, at least one of parameters

Recipient email address and Recipient phone No. must be set.

Enable alarm
sending rules

Enable a disabled alarm notification rule.
Select one or more alarm sending rules and click Enable to
enable the alarm sending rules.

Disable alarm
sending rules

Disable an alarm notification rule that is not used currently.
Select one or more alarm sending rules and click Disable to
disable the alarm sending rules.

Modify alarm
sending rules

Modify an alarm notification rule to meet management
requirements.

1. Click  in the Operation column where the required
alarm notification rule is located.

2. On the Modify Rule page, modify the alarm notification
rule information.

Delete alarm
sending rules

Delete an unused alarm notification rule to ensure sufficient
memory and proper running of tasks on the server.

1. Click  in the Operation column where the required
alarm notification rule is located.

2. In the Warning dialog box, click Yes.
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If You Need
To...

Then...

Export alarm
sending rules

1. Click Export drop-down list box.
– Select Export All from the Export drop-down list box

and save all the alarm notification rule to the PC.
– Select the target alarm notification rule in the

displayed operation area. Select Export Selected from
the Export drop-down list box and save the selected
alarm notification rule to the PC.

The message shown in Figure 4-60 is displayed.

Figure 4-60 Message for rule export

2. Select whether to export personal data in plaintext
format, and click OK.
Personal data refers to the email information or phone
number about recipients.

 

----End

4.1.8.3.4 Setting Report Sending Rules

This section describes how to set report sending rules. The NetEco 1000S sends
emails to users each day to notify users of day energy, income and total energy
generated by the plant based on rules.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the installer.
● You have set the email server.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.
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Procedure

Step 1 Choose System > Remote Notification from the main menu.

Step 2 Choose Report Send Settings.

Enter search criteria in Recipient email address or PV plant text box, and click
Query. Target reports sending rules meeting the preset condition are filtered out.

Figure 4-61 Report Send Settings

Step 3 In the Report Send Settings page, you can perform the following operations.

If You Need
To...

Then...

Create report
sending rules

A report sending rule is enabled by default once it is created.
1. Click Create.
2. Set Rule name, Mail language, Mail subject, PV plant,

Daily send time, and Recipient email address on the
Create Rule page.
NOTE

– Available mail languages include: Chinese, English, Japanese,
French, German, and Italian. The Mail language uses the
display language on the NetEco 1000S by default.

– The NetEco 1000S has a mail subject by default. The language
of the mail subject is the display language and changes with
the Mail language settings.

– The NetEco 1000S sends day energy and total energy
generated by the PV Plant from 00:00 of the current day to
Daily send time.

3. Click Save.

Enable report
sending rules

Enable a disabled report sending rule.
Select one or more report sending rules and click Enable to
enable the report sending rules.

Disable report
sending rules

Disable a report sending rule that is not used currently.
Select one or more report sending rules and click Disable to
disable the report sending rules.

Modify report
sending rules

Modify a report sending rule to meet management
requirements.

1. Click  in the Operation column where the required
report sending rule is located.

2. On the Modify Rule page, modify the report sending rule
information.
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If You Need
To...

Then...

Delete report
sending rules

Delete an unused report sending rule to ensure sufficient
memory and proper running of tasks on the server.

1. Click  in the Operation column where the required
report sending rule is located.

2. In the Warning dialog box, click Yes.

Export report
sending rules

Export report sending rules
1. Click Export drop-down list box.

– Select Export All from the Export drop-down list box
and save all the report sending rules that are queried
to the PC.

– Select the target device in the displayed operation area.
Select Export Selected from the Export drop-down list
box and save the selected report sending rules to the
PC.

The message shown in Figure 4-62 is displayed.

Figure 4-62 Message for rule export

2. Select whether to export personal data in plaintext
format, and click OK.
Personal data refers to the email information about
recipients.

 

----End

4.1.8.4 Setting System Parameters
This section describes how to set system parameters to modify communication
parameters, reset alarms, synchronize the clock time, and set the income unit.

4.1.8.4.1 Clock Synchronization

This section describes how to synchronizes the time on the monitoring PC on
which the NetEco 1000S is installed to devices. This ensures time consistency
between the devices and the NetEco 1000S.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context

By default, the time synchronization function is not started.

If the time synchronization function is started, the NetEco 1000S performs time
synchronization per hour to synchronize time from the NetEco 1000S server to
devices mounted to the plant.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Click Clock Synchronization.

Figure 4-63 Clock Synchronization

Step 3 Select Enable scheduled synchronization.

The message Are you sure you want to issue the command? is displayed.

Step 4 Click OK.

The message The synchronization command has been issued is displayed.

Step 5 Click OK.

----End

4.1.8.4.2 Setting Communication Parameters

This section describes how to set communication parameters. If a device is
connected to the monitoring PC using a serial port, the baud rate of the device
must be the same as that set on the NetEco 1000S. Otherwise, the device
communicates with the monitoring PC improperly. By default, the baud rates of
the device and NetEco 1000S are 9600. In normal cases, you can retain the default
settings unless the actual transmission rate is insufficient. After the baud rate is
changed, you need to restart the NetEco 1000S for the setting to take effect.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
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● You have logged in as the system administrator.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Click Communicate Parameter.

The Communicate Parameter window is displayed.

Step 3 Changing Baud rate

1. Select a baud rate from the Baud rate drop-down list and click Save.
The message To change the baud rate, you need to restart the NetEco service.
Do you want to continue? is displayed.

2. Click Yes.
The message Modification succeeded. Please restart the NetEco service. is
displayed.

3. Click OK.
4. See 4.1.1.2 Logging Out of the NetEco 1000S and 4.1.1.1 Logging In to the

NetEco 1000S to restart NetEco 1000S service.

Step 4 Set whether the SmartLogger supporting only SSL authentication is allowed to
access the NetEco 1000S.

The SmartLogger and NetEco 1000S use the following two authentication modes
by default: SSL authentication and user name/password authentication. The
NetEco 1000S can be compatible with the SmartLogger supporting only SSL
authentication, which has security risks. It is recommended that such SmartLogger
be replaced with the SmartLogger supporting both authentication modes or the
SmartLogger be upgraded to the version supporting both authentication modes.

● Select Compatible Access only supports SSL authentication NEs: The
SmartLogger supporting only SSL authentication is allowed to access the
NetEco 1000S, and the device connection is normal.

● Deselect Compatible Access only supports SSL authentication NEs: The
SmartLogger supporting only SSL authentication is allowed to access the
NetEco 1000S, but the device is disconnected. To ensure the access security of
the NetEco 1000S, you are advised to deselect Compatible Access only
supports SSL authentication NEs.

After installing and upgrading NetEco 1000S, Compatible Access only supports SSL
authentication NEs is selected by default.

----End

4.1.8.4.3 Resetting Alarms

This section describes how to reset alarms. When the target device restores its
factory defaults or changes its connection mode, you must reset alarms for the
target device on the NetEco 1000S. In this case, all the existing alarm records for
the target device will be deleted, and alarms are synchronized from the target
device to the NetEco 1000S again.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Click Reset Alarm.

The Reset Alarm window is displayed, as shown in Figure 4-64.

Figure 4-64 Reset Alarm

Step 3 Select the devices for which you want to reset alarms and click Reset Alarm.

The Warn dialog box is displayed.

If you select Synchronize and reset SmartLogger?, the command for resetting alarms will
be sent to the SmartLogger. The SmartLogger then clears all alarms of the device in it after
receiving the command.

Step 4 Click OK.

After alarms are reset, alarm records on the NetEco 1000S will be deleted.
However, all alarms of the device still exist on the device side.

----End

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 152



4.1.8.4.4 Setting Income

You can add the currency to collect statistics on the income of PV System or PV
plant.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose Income Settings.

The page as shown in Figure 4-65 is displayed.

Figure 4-65 Income Setting

Step 3 Click Add Currency.

The Add Currency Unit dialog box is displayed, as shown in Figure 4-66.
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Figure 4-66 Add currency unit

Step 4 Add the currency, and save the setting.

----End

Follow-up Procedure
In the Operation column of the Add Currency Unit dialog box, delete the
currency.

4.1.8.4.5 Setting Prompt Information

This section describes how to set whether to enable the prompt information
displayed after you log in to the client, access devices, and create a PV plant on
the NetEco 1000S client.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
After you log in to the NetEco 1000S, access devices, or create a PV plant, the
prompt information is displayed in the lower right corner of the NetEco 1000S
client.

You can enable or disable the prompt information as required.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose Tip Message Settings.

The Tip Message Settings page is displayed, as shown in Figure 4-67.
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Figure 4-67 Tip Message Settings

Step 3 Set whether to enable the prompt information.
● Enable the prompt information: select Enable tip message display.
● Disable the prompt information: deselect Enable tip message display.

Prompt information is enabled on the NetEco 1000S by default.

----End

4.1.8.4.6 Setting Maintenance Notifications

Set the maintenance notification to notify the users involved of the plant
maintenance in advance so that they can prepare for it.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Context
● After the maintenance notifications take effect, a maintenance notification

dialog box will be displayed in the lower right corner of the NetEco 1000S
client.

● The dialog box will not disappear until the user clicks I see.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose Maint. Notif to access the Maint. Notif page.

Step 3 You can perform the following operations on the Maint. Notif page.
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If You Need To... Then...

Creating
Maintenance
Notifications

1. Click Create.
2. Set Rule Name, Start time, End time, Content, Status

and Select plant or Select user.
NOTE

You can query the list of the target object by plant name or user
name.

3. Click OK.

Enabling
Maintenance
Notifications

Enable the disabled maintenance notification to resume
using it.

Click  in the Operation column of the target
maintenance notification to enable it.

Disabling
Maintenance
Notifications

Disable the maintenance notification to stop using it.

Click  in the Operation column of the target
maintenance notification to disable it.

Modifying
Maintenance
Notifications

Modify maintenance notifications to meet the latest
management requirements.

1. Click  in the Operation column of the target
maintenance notification.

2. Modify the maintenance notification.
3. Click OK.

Deleting
Maintenance
Notifications

Delete redundant maintenance notifications to ensure that
the server has sufficient space and runs smoothly.

1. Click  in the Operation column of the target
maintenance notification.

2. In the displayed Information dialog box, click OK.

 

----End

4.1.8.4.7 Setting Maintenance Emails

Set the maintenance notification to notify the users involved of the plant
maintenance by emails in advance so that they can prepare for it.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● You have set the email server.
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Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose Maint. Email to access the Maint. Email page, as shown in Figure 4-68.

Figure 4-68 Maint. Email page

Step 3 You can perform the following operations on the Maint. Email page.

If You Need
To...

Then...

Creating
Maintenance
Emails

By default, the status of maintenance emails is enabled after
maintenance emails are created.
1. Click Create.
2. Set Rule Name, Mail subject, Content, and Select plant

or Select user.
NOTE

You can query the list of the target object by plant name or user
name.

3. Click OK.
The Send now? dialog box is displayed.
– If the email needs to be sent promptly, click OK.
– If the email does not need to be sent promptly, click

Cancel. The email will be saved.

Sending
Maintenance
Emails

● Click  in the Operation column of the target
maintenance email to send it.

● While sending, click  in the Operation column of the
target maintenance email to cancel sending it.

NOTE
You can click Read the Details in the Progress State of Task column
to query the sending details of maintenance emails.

Modifying
Maintenance
Emails

Modify maintenance emails to meet the latest management
requirements.

1. Click  in the Operation column of the target
maintenance email.

2. Modify the maintenance email.
3. Click OK.
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If You Need
To...

Then...

Deleting
Maintenance
Emails

Delete redundant maintenance emails to ensure that the
server has sufficient space and runs smoothly.

1. Click  in the Operation column of the target
maintenance email.

2. In the displayed Information dialog box, click OK.

 

----End

4.1.8.4.8 Setting IP Address

This section describes how to set IP address. Ensure that the user receives the reset
password or the link in the self-registration activation email matches the IP
address or domain name of the NetEco 1000S server.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose IP Setting from the menu bar on the left, as shown in Figure 4-69.

Figure 4-69 IP setting

Step 3 Set the IP/domin name and port number of the NetEco 1000S server, and click
Save.

----End

4.1.8.4.9 Setting Self-Registration Account

After self-registration authorization is enabled, you can register an account on the
NetEco 1000S login page.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
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● You have logged in as the system administrator.

Procedure

Step 1 Choose System > System Settings from the main menu.

Step 2 Choose Self-Registration Account Settings from the menu bar on the left, as
shown in Figure 4-70.

Figure 4-70 Self-registration account settings

Step 3 Select Enable self-registration account to enable the self-registration account
function.

After the self-registration account function is enabled, the user authorization is
also enabled.

----End

4.1.8.5 License Management
License management includes querying license information, obtaining an ESN,
importing a license, and revoking a license. Manage the license to ensure that the
NetEco 1000S can be used normally.

4.1.8.5.1 License Usage Description

The license is used to enable or disable the inverter management function. After
the NetEco 1000S is installed, there is a license trial period of 90 days by default.
During the trial period, a license file needs to be imported so that all the functions
of the NetEco 1000S can be used.

If a license file is not imported when the trial period expires, login to the NetEco
1000S client will be limited. After login is limited, managers, installers, guest users,
and customers will not be able to visit the client. Only the system administrator
can visit the client. After login, the page requiring license import is displayed.

To ensure that you can use all the functions of the NetEco 1000S, check and
import a license file periodically.

How to Obtain a License
Obtain the ESN of the NetEco 1000S server or the license revocation code, and
then contact Huawei technical support to apply for a new license.

4.1.8.5.2 Querying License Information About the NetEco

Query the expiration date and function control of the current License routinely to
check whether the License is about to expire, and solve the problems in a timely
manner. In this way, the NetEco 1000S function can be used normally.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.

● You have logged in as the system administrator.

● The License has been imported to NetEco 1000S. If it has not been imported,
import it by referring to 4.1.8.5.3 Importing a License File.

Procedure

Step 1 Choose System > License Management from the main menu.

Step 2 Choose License Information.

The License Information page is displayed.

On the License Information page, check the basic information, function control
information, and ESN information about the License. For details, see Table 4-25.

Table 4-25 License information

Item Attribute Description

Basic License
Information

Expired on The License is valid until 03:00 this
date.

Function Control Function Name Functions provided by the NetEco
1000S.

Supported or Not Whether the function is supported by
the License file.

ESN Information ESN list ESNs of all the NICs managed by the
License. Each ESN is separated by a
comma (,).

ESN quantity The number of ESNs of all the NICs
managed by the License.

 

When the License is about to expire, a prompt will be displayed at the upper part of the
License Information page. Handle the problem by following the prompt.

----End

4.1.8.5.3 Importing a License File

When a License is not imported in NetEco 1000S, or NetEco 1000S License is
expires, or cannot meet network management requirements, you must import a
new License to the NetEco 1000S to ensure normal services of the NetEco.
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Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● A new License is obtained.

Procedure

Step 1 Choose System > License Management from the main menu.

Step 2 Choose Import License.

The Import License page is displayed.

Step 3 Click Browse and select a License file.

The License file must be less than 1 MB and the file format should be .dat.

Step 4 Click Upload.

A dialog box for activating the License is displayed.

Step 5 Click Yes.

----End

4.1.8.5.4 Revoking a License

If the NIC is faulty or a new NIC needs to be used, revoke the current license to
generate a revocation code which is used to apply for a new license file for free.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
● License usage is normal in the current environment.

Context
If a NIC is found faulty or the existing NIC needs to be replaced, revoke the
existing license to generate a revocation code that can be used for applying for a
new license file.

After NIC replacement, import the new license file to NetEco 1000S. After that, the
NetEco 1000S functions can be used properly. For details about how to import a
license file, see 4.1.8.5.6 Importing a License on the Page Requiring License
Import.

Procedure

Step 1 Choose System > License Management from the main menu.

Step 2 Choose Revoke License.

The Revoke License page is displayed.
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Step 3 Click Revoke.

A warning is displayed, as shown in Figure 4-71.

Figure 4-71 Revocation warning

Step 4 Click OK.

A dialog box is displayed, as shown in Figure 4-72.

Figure 4-72 Password confirming

Step 5 Enter the password of the user and click OK.

The generated revocation code will be displayed beside the Revocation code
parameter.

If the revocation code is not generated, contact Huawei technical support.

----End

4.1.8.5.5 Obtaining an ESN

If no license is available for the NetEco 1000S, obtain the equipment serial
number (ESN) of the NetEco 1000S server to apply for a license.

Prerequisites
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● You have logged in as the system administrator.
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● You have obtained the Media Access Control (MAC) address of the NetEco
server.

● No license is available or the license has expired.

Context
If no license file is found or the license has expired after the NetEco 1000S is
installed, obtain the ESN to apply for a new license.

Procedure

Step 1 Choose System > License Management from the main menu.

Step 2 Choose Obtain ESN.

The Obtain ESN page is displayed.

Step 3 Obtain the ESN.
● Obtain the ESN of the current logged-in server only.

a. Click Choose MAC address. In the drop-down list, select a MAC address
to generate an ESN.
The MAC addresses provided in the drop-down list are the MAC addresses
of the NetEco 1000S servers.

NO TICE

If there are multiple options, select each MAC address one by one and
obtain the ESN for each MAC address.

b. Click Obtain ESN.
● Obtain the ESNs of other servers by entering their MAC addresses.

a. Click Enter a MAC address, and enter a MAC address of the NetEco
server.
A maximum of 20 MAC addresses can be entered. Separate two MAC
addresses with a comma (,).

b. Click Obtain ESN.

The generated ESN is displayed at the lower part of the page, as shown in Figure
4-73.
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Figure 4-73 Generating an ESN

----End

Follow-up Procedure
When you need to apply for a new license file, contact Huawei technical support
and use the obtained ESN to apply for a new license file.

After the new license is issued, import the license to the NetEco 1000S. For details,
see 4.1.8.5.6 Importing a License on the Page Requiring License Import.

4.1.8.5.6 Importing a License on the Page Requiring License Import

If the license has expired or is invalid, import a new license file or obtain the ESN
of the NetEco 1000S on the page requiring license import.

Prerequisites
● You have logged in as the system administrator.
● You have logged in to the NetEco 1000S. For details, see 4.1.1.1.2 Logging In

to the NetEco 1000S Client.
● The trial period of the NetEco 1000S has expired, or the license has expired or

is invalid.

Context
If The trial period of the NetEco 1000S has expired, or the license has expired or is
invalid, log in to the NetEco 1000S client as a system administrator. The page
requiring license import is displayed.

Import a new license file.
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NO TICE

If you perform an operation after more than 10 minutes elapse since the page
requiring license import is displayed, the login page will be displayed again. To
ensure that you can perform operations successfully, perform the following steps
within 10 minutes after the page requiring license import is displayed.

Procedure

Step 1 Please check whether you have obtained a new license and perform appropriate
operations.
● If you have obtained a new license, perform Step 4 through Step 9.
● If no license file is available, perform Step 2 through Step 9.

Step 2 Obtain the ESN of the NetEco 1000S so that you can use the ESN to apply for a
new license.
● Obtain the ESN of the current logged-in server only.

a. Click Choose MAC address. In the drop-down list, select a MAC address
to generate an ESN.
The MAC addresses provided in the drop-down list are the MAC addresses
of the NetEco 1000S servers.

NO TICE

If there are multiple options, select each MAC address one by one and
obtain the ESN for each MAC address.

b. Click Obtain ESN. The generated ESN is displayed at the lower part of
the page.

● Obtain the ESNs of other servers by entering their MAC addresses.

a. Click Enter a MAC address, and enter a MAC address of the NetEco
server.
A maximum of 20 MAC addresses can be entered. Separate two MAC
addresses with a comma (,).

b. Click Obtain ESN. The generated ESN is displayed at the lower part of
the page.

Step 3 Contact Huawei technical support engineers to apply for a new license using the
obtained ESN.

Step 4 Click Browse on the right of License File.

A dialog box for selecting a file is displayed.

Step 5 Select the license file to be imported and click OK.

Step 6 Click Upload.

The dialog box shown in Figure 4-74 is displayed.
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Figure 4-74 Confirm

Step 7 Click Yes.

The dialog box shown in Figure 4-75 is displayed.

Figure 4-75 Information

Step 8 Click OK.

Step 9 Click Return on the right of License File.

The NetEco 1000S login page is displayed.

----End

4.1.9 FAQs

4.1.9.1 What Do I Do When Characters in a CSV File Are Displayed in
Disorder?

Symptom
When users open a CSV file exported from the NetEco 1000S, the characters in the
file are displayed in disorder.

Possible Causes
When data in a list is exported to a CSV file, the default separator used by the
operating system is not comma (,).
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Procedure

Step 1 Choose Start > Control Panel.

Step 2 In the displayed Control Panel window, click Region and Language.

Step 3 In the displayed Region and Language window, click the Formats tab.

Step 4 Click Additional settings.

Step 5 In the displayed dialog box, set List separator to comma (,) on the Numbers tab
page.

Step 6 Click OK.

----End
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4.1.9.2 What Do I Do When the NetEco 1000S Service Icon Is Not Displayed?

Symptom

On a PC running the Windows operating system, the NetEco 1000S service icon is
not displayed on the right of the taskbar when the NetEco 1000S service is
running.

Possible Causes

An exception occurs in the resource manager of the operating system.

This problem does not affect the functions of the NetEco 1000S. You can ignore it.

Procedure

To restart the NetEco 1000S service, perform the following steps:

Step 1 Log off the Windows operating system.

Step 2 Log in to the Windows operating system again and then start the NetEco 1000S
services.

----End

4.1.9.3 How Do I Solve the Problem that the Login Page Fails to Be
Displayed When I Access theNetEco 1000S Using a Web Browser?

Symptom

The login page fails to be displayed when I access NetEco 1000S using a web
browser.

Possible Causes
● Connection mode setting on the browser is not correct.

● The network is connected improperly.

● The PC where the NetEco 1000S is installed is powered off.

● The NetEco 1000S service has not been started on the PC.

Procedure

Step 1 Set the connection mode:

Choose Tools > Internet Options on the menu bar of the browser. On the
Advanced tab page, select Use TLS 1.2 and Use TLS 1.1 under Settings, do not
select Use TLS 1.0, Use SSL 2.0 or Use SSL 3.0. Click OK.
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Step 2 Choose Start > Search programs and files in the operating system. In the
displayed dialog box, enter cmd and press Enter. The command-line interface
(CLI) is displayed.

Step 3 Run the following command to check whether the network between the PC on
which users can log in to the NetEco 1000S and the PC where the NetEco 1000S is
installed is connected properly:

ping IP address

Replace IP address with the IP address of the PC on which the NetEco 1000S is installed.

● If the IP address cannot be pinged, go to Step 4.
● If the IP address can be pinged, go to Step 6.

Step 4 Check whether the PC on which the NetEco 1000S is installed is started.
● If the PC is started, go to Step 5.
● If the PC is not started, perform the following operations:

a. Start the PC on which the NetEco 1000S is installed.
b. Choose Start > All Program > NetEco 1000S > NetEco 1000S Service in

the operating system to start the NetEco 1000Sservice.
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Step 5 Check whether the network cable of the PC where the NetEco 1000S is installed is
loosened or disconnected.

In normal cases, the indicator of the network port where the network cable is
inserted is green. The indicator blinks when data is transmitted.

● If the network cable is loosened or disconnected, connect it again.
● If the network cable is connected properly but the IP address of the NetEco

1000S server still cannot be pinged, check whether network connection
problems occur on the user side.

Step 6 Check whether the NetEco 1000S service has been started on the PC.
● If the NetEco 1000S service is not started, choose Start > All Program >

NetEco 1000S > NetEco 1000S Service in the operating system to start the
NetEco 1000S service.

● If the NetEco 1000S service has been started but logging in to the NetEco
1000S using the web browser fails, please see 4.1.9.5 What Do I Do If the
NetEco 1000S Service Is Successfully Started Yet Its Login Page Cannot Be
Accessed?.

----End

4.1.9.4 What Do I Do If It Is Prompted that Port 443 or Port 8443 Is Occupied
When I Try to Start the NetEco 1000S Service?

Symptom
When you try to start the NetEco 1000S service, either of the following messages
is displayed on the server interface:
● Failed to start the NetEco service as port 443 has been occupied. Solve the

problem by referring to the user manual, and then restart the NetEco service.
● Failed to start the NetEco service as port 8443 has been occupied. Solve the

problem by referring to the user manual, and then restart the NetEco service.

Possible Causes
● Port 443 is occupied.
● Port 8443 is occupied.

Procedure
There are two solutions to the port occupation problem.

● Modify the port number in the system configuration file.

a. Access the NetEco 1000S software installation directory\WebRoot
\WEB-INF\classes directory.

b. Open the sslCertificate.properties file. Modify the occupied port number
to one that is available for the operating system, and save the
modification.

c. Restart the NetEco 1000S service.
● Release the occupied port number. For details, contact Huawei technical

support.
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4.1.9.5 What Do I Do If the NetEco 1000S Service Is Successfully Started Yet
Its Login Page Cannot Be Accessed?

Symptom
The NetEco 1000S service is successfully started, yet its login page cannot be
accessed.

Possible Causes
● Port 80 or port 8010 is occupied.
● Port 443, port 8443, port 80, or port 8010 is disabled by the operating system

because of the security policy.

Context
You can use any of the following methods to access the NetEco 1000S login page:

● IP address or domain name (recommended)
● https://IP address or domain name
● https://IP address or domain name:443
● https://IP address or domain name:8443
● http://IP address or domain name
● http://IP address or domain name:80
● http://IP address or domain name:8010

Procedure

Step 1 Determine using which of the following methods you cannot access the NetEco
1000S login page.
● https://IP address or domain name:8443. Port 8443 is disabled. Go to Step 5.
● http://IP address or domain name. Go to Step 2.
● http://IP address or domain name:80. Go to Step 2.
● http://IP address or domain name:8010. Go to Step 3.
● Any other methods in Context. Port 443 is disabled. Go to Step 5.

Step 2 Check whether port 80 is occupied.
● If so, go to Step 4.
● If not, port 80 is disabled. Go to Step 5.

Step 3 Check whether port 8010 is occupied.
● If so, go to Step 4.
● If not, port 8010 is disabled. Go to Step 5.

Step 4 There are two solutions to the port occupation problem.
● Modify the port number in the system configuration file.

a. Access the NetEco 1000S software installation directory\WebRoot
\WEB-INF\classes directory.
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b. Open the sslCertificate.properties file. Modify the occupied port number
to one that is available for the operating system, and save the
modification.

c. Restart the NetEco 1000S service and log in to the NetEco 1000S client.

● Release the occupied port number. For details, contact Huawei technical
support.

Step 5 Enable the port in the security policy of the operating system if the port is
disabled by the security policy.

----End

4.1.9.6 How Do I Solve the Problem that the Serial Port for the SMS Modem
to Connect to a PC Is Always Occupied After the SMS Is Enabled?

Question

How do I solve the problem that the serial port for the SMS modem to connect to
a PC is always occupied after the SMS is enabled?

After the serial cable between the SMS modem and the PC is disconnected or removed, the
serial port is still occupied.

The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you are obligated to take measures, in
compliance with the laws of the countries concerned and the user privacy policies of your
company, to ensure that the personal data of users is fully protected.

Personal data such as phone numbers and email addresses are masked in the NetEco GUI
and encrypted in the NetEco during batch data transmission to ensure data security.

Answer

Perform the following steps to restart the NetEco 1000S service:

Step 1 Right-click the NetEco 1000S service icon in the lower right corner of the taskbar
of the desktop and choose Exit to stop the NetEco 1000S service from the shortcut
menu.

Step 2 Choose Start > All Program > NetEco 1000S > NetEco 1000S Service to start the
NetEco 1000S service in the operating system.

----End

4.1.9.7 Verifying OpenPGP Signature

This section describes how to verify the integrity of an obtained software package,
thereby preventing network risks that may be caused by malicious alteration or
damage during the transmission of the software package. A software package can
be installed only after it passes the verification.
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Prerequisites
You have obtained the signature file for the NetEco 1000S software package. The
NetEco 1000S software package and its signature file are in a one-to-one
relationship, and are stored in the same directory.

Context
● The GNU Privacy Guard for Windows (Gpg4Win) is a free open-source GNU

tool. It can be used to verify OpenPGP signatures in the Windows operating
system.

● You can download the Gpg4Win software package used with the Windows
operating system from http://www.gpg4win.org/, and then double-click
gpg4win-2.2.1.exe to install the Gpg4Win tool by following the wizard. You
are advised to retain all the default settings during the installation.

Procedure

Step 1 Download the public key file.

Download the OpenPGP Signature Verification Guide package from http://
support.huawei.com/carrier/digitalSignatureAction (for carriers) or http://
support.huawei.com/enterprise/en/tool/software-digital-signature-validation-
tool--pgp-verify--TL1000000054 (for enterprises) and then decompress the
package to obtain the public key file KEYS.

Step 2 Import the public key file.

1. Log in to the server on which the software package to be verified is stored,
and enter the command-line interface (CLI).

2. Go to the directory (for example, C:\Users\) for storing the KEYS file, and
then import the KEYS file.
gpg --import "C:\Users\KEYS"
C:\Users\KEYS indicates the directory for storing the KEYS file. You need to
rename the directory based on site conditions.
The following information is displayed:
gpg: key 27A74824: public key "OpenPGP signature key for Huawei software (created on 30th Dec,
2013) <support@huawei.com>" imported 
gpg: Total number processed: 1  
gpg: imported: 1 (RSA: 1)

3. Check whether the public key file is successfully imported.
gpg --fingerprint
If the following information is displayed, the public key file is successfully
imported:
pub 2048R/27A74824 2013-12-30 Key fingerprint = B100 0AC3 8C41 525A 19BD C087 99AD 81DF 
27A7 4824 uid OpenPGP signature key for Huawei software (created on 30th Dec,2013) 
support@huawei.com

Step 3 Verify the public key.

In normal cases, the validity of the OpenPGP public key needs to be verified
according to the ID, fingerprint, and user ID (uid) of the public key published by
the involved entity. Huawei publishes the following information about the
OpenPGP public key:
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● Key ID: 27A74824
● Key fingerprint: B100 0AC3 8C41 525A 19BD C087 99AD 81DF 27A7 4824
● User ID (uid): OpenPGP signature key for Huawei software (created on 30th

Dec,2013) support@huawei.com

After the validity of the public key is verified, you can do as follows to set the trust
level of the public key:

1. Set the trust level of the public key.
gpg --edit-key "OpenPGP signature key for Huawei" trust
When the system displays Your decision?, enter 5. When the system displays
Do you really want to set this key to ultimate trust? (y/N), enter y.
1 = I don't know or won't say  
2 = I do NOT trust  
3 = I trust marginally  
4 = I trust fully  
5 = I trust ultimately  
m = back to the main menu 
Your decision? 5  
Do you really want to set this key to ultimate trust? (y/N) y

2. Run the following command to exit:
quit

Step 4 Verify the signature.

gpg --verify "C:\Users\NetEco1000SV100R003C00SPCXXX_win7_standard.zip.asc

● C:\Users\ indicates the path of the signature file. You need to change it based on site
conditions.

● iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip.asc indicates the
name of the signature file. You need to rename the file based on site conditions.

● Contact the Huawei technical support engineers and obtain the signature files
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip.asc or
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zip.asc.

– For carriers: To obtain the software package, Huawei technical support engineers
can choose Support > Software > Network Energy > PV Inverter > Smart PV
Plant System > iManager NetEco 1000S > V100R003C00 at http://
support.huawei.com/carrier/.

– For enterprises: To obtain the software package, Huawei technical support
engineers can choose SUPPORT > Network Energy > Energy Common >
iManager NetEco 1000S at http://support.huawei.com/enterprise.

– If the Windows Server 2012 OS is used, obtain the
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zip
installation package and
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zip.asc digital
signature file.

– If the Windows 7 or Windows 10 OS is used, obtain the
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip installation
package and
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip.asc digital
signature file.

The following information is displayed, where the RSA key ID in bold is the same
as the public key ID (if no error message, such as WARNING, The signature has
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expired, and The public key has been revoked is displayed for any other
information, the signature is valid):

gpg: Signature made Thu Jan 9 15:29:06 2014 CST using RSA key ID 27A74824  
gpg: Good signature from "OpenPGP signature key for Huawei software (created on  
30th Dec,2013) <support@huawei.com>"

When signatures of multiple files need to be verified for a software package, the software
package is safe only when the verification results of all the files are PASS. If the verification
result of any file is WARNING or FAIL, the software package fails the verification, and
security risks exist. If this occurs, you need to re-download the software package.

Table 4-26 Examples of signature verification results

Verification Result
Scenario

Output Information Example Verification
Result

The signature
verification is
successful without
any exceptions.

gpg: Signature made Thu Jan 9
15:29:06 2014 CST using RSA key ID
27A74824 gpg: Good signature from
"OpenPGP signature key for Huawei
software (created on 30th Dec,
2013) <support@huawei.com>

PASS

The signature
verification fails.

gpg: Signature made Thu Jan 9
15:29:06 2014 CST using RSA key ID
27A74824 gpg: BAD signature from
"OpenPGP signature key for Huawei
software (created on 30th Dec,
2013) <support@huawei.com>"

FAIL

The public key cannot
be found.

gpg: Signature made Thu Jan 9
15:20:01 2014 CST using RSA key ID
27A74824 gpg: Cannot check
signature: public key not found

FAIL

The signature
verification is
successful but the
public key is not set
to ultimate trust.

gpg: Signature made Thu Jan 9
15:29:06 2014 CST using RSA key ID
27A74824 gpg: Good signature from
"OpenPGP signature key for Huawei
software (created on 30th Dec,
2013) <support@huawei.com>" gpg:
WARNING: This key is not certified
with a trusted signature! gpg: There
is no indication that the signature
belongs to the owner. Primary key
fingerprint: B100 0AC3 8C41 525A
19BD C087 99AD 81DF 27A7 4824

WARNING

The corresponding
source file cannot be
found.

gpg: no signed data gpg: cannot
hash datafile: No data

FAIL
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Verification Result
Scenario

Output Information Example Verification
Result

The signature has
expired.

gpg: Signature made 04/24/13
10:50:29 CST using RSA key ID
133B64E5 gpg: Expired signature
from " OpenPGP signature test key
<support@huawei.com>" gpg:
Signature expired 04/25/13 10:50:29
CST

FAIL

The signature
verification is
successful but the
public key has been
revoked.

gpg: Signature made 06/13/13
11:14:49 CST using RSA key ID
133B64E5 gpg: Good signature from
" OpenPGP signature test key
<support@huawei.com>" gpg:
WARNING: This key has been
revoked by its owner! gpg: This
could mean that the signature is
forged. gpg: reason for revocation:
Key is no longer used gpg:
revocation comment:

WARNING

The corresponding
signature file cannot
be found for the
source file.

None WARNING

 

----End

4.1.9.8 How Do I Update the NetEco 1000S Software?

Question
How do I update the NetEco 1000S software?

Answer

Step 1 Contact Huawei technical support engineers to obtain the software package.
● For carriers: To obtain the software package, Huawei technical support

engineers can choose Support > Software > Network Energy > PV Inverter
> Smart PV Plant System > iManager NetEco 1000S > V100R003C00 at
http://support.huawei.com/carrier/.

● For enterprises: To obtain the software package, Huawei technical support
engineers can choose SUPPORT > Network Energy > Energy Common >
iManager NetEco 1000S at http://support.huawei.com/enterprise.
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● If the Windows Server 2012 OS is used, obtain the
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zip installation
package and
iManagerNetEco1000S_V100R003C00SPCXXX_win2012_enterprise.zip.asc digital
signature file.

● If the Windows 7 or Windows 10 OS is used, obtain the
iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip installation package
and iManagerNetEco1000S_V100R003C00SPCXXX_win7_standard.zip.asc digital
signature file.

You can check the integrity of the software package by referring to 4.1.9.7
Verifying OpenPGP Signature.

Software package integrity check is related to the software security. You must perform the
check to ensure the software security.

Step 2 Stop the service, process and close the installation directory of the NetEco 1000S.

If the service and process of the NetEco 1000S are not started, NetEco 1000S installation
directory is not opened, skip this step.

Step 3 Upgrade the NetEco 1000S by following the instructions provided in iManager
NetEco 1000S V100R003C00 Upgrade Guide.

----End

4.1.9.9 What Do I Do If a Certificate Error Message or a Security Alarm Is
Displayed on Internet Explorer?

Symptom

When log in to NetEco 1000S using Internet Explorer or Chrome, Internet Explorer
or Chrome displays a certificate error message similar to that shown in Figure
4-76 or Figure 4-77.

Figure 4-76 Certificate error message
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Figure 4-77 Website Security Certificate window (Chrome 50)

Possible Causes
Trusted certificate has not been loaded in the browser.

Procedure

Step 1 Log in to a PC as a user in the Administrators user group.

After the certificate is replaced on Internet Explorer, the certificate is also replaced
on Chrome. This section mainly describes how to replace the certificate on Internet
Explorer.

If you install only Chrome, choose Manage Certificate > Trusted Root Certification
Authorities > Import in the setting window of the Chrome browser and import the
certificate as prompted.

If you start Internet Explorer 11 in the Windows 7 operating system, you need to
log in a PC as a user in the Administrators user group and then start Internet
Explorer as user Administrator. Otherwise, you cannot properly set Internet
Explorer:

1. Choose Start > Internet Explorer.
2. In the displayed shortcut menu, choose Run as Administrator.

Step 2 View the certificate.

1. When the Internet Explorer displays the security certificate message as shown
in Figure 4-78, click Continue to this website.
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Figure 4-78 Security certificate

2. As shown in Figure 4-79, click Certificate Error.

Figure 4-79 Certificate Error

3. In the displayed dialog box, click View Certificate.

Step 3 In the displayed root certificate dialog box as shown in Figure 4-80, click Install
Certificate.
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Figure 4-80 Installing the root certificate

Step 4 In the displayed Certificate Import Wizard dialog box, click Next.

Step 5 Set the certificate store to Trusted Root Certification Authorities, as shown in
Figure 4-81.
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Figure 4-81 Setting the certificate store

Step 6 Click Next.

Step 7 After confirming the certificate import information, click Finish.

Step 8 If the system displays the Security Warning dialog box asking you whether to
install the certificate, click Yes. Otherwise, skip this step.

Step 9 In the displayed dialog box indicating the import is successful, click OK.

Step 10 Click OK to close the Certificate dialog box.

Step 11 In the window of Internet Explorer, choose Tools > Internet Options.

Step 12 In the displayed Internet Options dialog box, click Advanced.

Step 13 In the Settings group box, clear Warn about certificate address mismatch under
Security.

Step 14 Click OK to close the Internet Options dialog box.

Step 15 Restart the web browser and log in to NetEco 1000S again.

----End
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4.1.9.10 How Do I Manage the NetEco 1000S Through the Local IP Address
(127.0.0.1) If I Fail to Log In to the NetEco 1000S Client After Setting the
Client IP Address Policy?

Question

When the IP address you have set is not within the IP address range of the existing
network, you will fail to log in to the NetEco 1000S client through the existing
network.

Answer

For this problem, the NetEco 1000S allows you to enter https://127.0.0.1:8443 in
the address box of the browser only on the local PC where the NetEco 1000S
software is installed to log in to the NetEco 1000S client and set a proper IP policy
for the NetEco 1000S.

4.1.9.11 What Do I Do If the Software Cannot Be Properly Used After I Share
the Software Installation Directory?

Question

After you share the NetEco 1000S software installation directory with other users,
you cannot log in to the NetEco 1000S or you can log in to the NetEco 1000S but
the performance file cannot be exported.

NO TICE

You are not allowed to share the NetEco 1000S installation directory with other
system accounts or grant the NetEco 1000S permission to other system accounts.
Otherwise, security risks may occur.

Answer

When you share the NetEco 1000S software installation directory with other users,
the NetEco 1000S software deletes user NETWORK SERVICE that is automatically
generated during software installation and is used for accessing the NetEco 1000S
software installation directory to ensure security, causing the preceding problem.
You can perform the following operations to solve the problem.

Step 1 Cancel the sharing of the NetEco 1000S software installation directory.

1. Right-click the NetEco 1000S software installation directory and choose
Properties from the shortcut menu. The Properties dialog box is displayed.

2. Choose Sharing > Advanced Sharing. The Advanced Sharing dialog box is
displayed.

3. Deselect Share this folder and click OK.

Step 2 Add user NETWORK SERVICE.
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1. Right-click the NetEco 1000S software installation directory and choose
Properties from the shortcut menu. The Properties dialog box is displayed.

2. In the Properties dialog box, choose Security > Edit.
3. In the displayed dialog box, click Add. The dialog box shown in Figure 4-82 is

displayed.

Figure 4-82 Adding a user

4. Enter NETWORK SERVICE in Figure 4-82 marked in red and click OK. The
Properties dialog box is displayed again. Select FULL control and modify and
click OK.

NO TICE

After you click OK, the system might display a security warning dialog box.
Click Continue.

Step 3 Restart the NetEco 1000S.

----End

4.1.9.12 What Do I Do When Devices Fail to Be Detected?

Symptom

Devices fail to be detected based on serial port addresses.

Possible Causes
● The baud rate set on the NetEco 1000S is inconsistent with that of the device.
● The serial port addresses configured for the device are duplicate.
● The address of RS-485 serial port for the device is out of the default search

range (1 to 20) of the NetEco 1000S.

Procedure

Step 1 Check whether the baud rate setting on the device is consistent with that on the
NetEco 1000S.
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1. Obtain information about the baud rate set for the device by referring to User
Manual on the monitored device side.

2. Obtain information about the baud rate set on the NetEco 1000S by referring
to 4.1.8.4.2 Setting Communication Parameters.

3. Check whether the baud rate set for the device is the same as that set on the
NetEco 1000S.
– If the two baud rates are the same, go to Step 2.
– If the two baud rates are different, change the baud rate on either the

device or the NetEco 1000S.

Step 2 Check whether the value of RS485 Com Address for the device is duplicate by
referring to User Manual on the monitored device side.
● If the value of RS485 Com Address is unique, go to Step 3.
● If the value of RS485 Com Address is duplicate, change the parameter value

by referring to User Manual on the monitored device side.

Step 3 Check whether the value of RS485 Com Address for the device is within the
default search range (1 to 20) of the NetEco 1000S.

If value is out of the default search range, change the address search range on the
NetEco 1000S, or change the value of RS485 Com Address by referring to User
Manual on the monitored device side.

----End

4.1.9.13 How Do I Change the Password of the ftpuser user?
After the SmartLogger connects to the NetEco 1000S, log in to the FTPS server of
the NetEco 1000S as user ftpuser and upload performance data. You are advised
to change the password periodically to ensure system security.

Prerequisites
● You have obtained the password for ftpuser.

Please see Installation and Commissioning > Planning Operating System
Users and Their Initial Passwords for details about the password of ftpuser.

● You have started the NetEco services. For details about how to start the
services, see 4.1.1.1.1 Starting NetEco 1000S Services.

● The Smart Logger supports FTPS.

You are advised to change the password after you install the NetEco 1000S for the first
time, and change the password every three months.

Procedure

Step 1 Run the script NetEco software installation\tools\ConfigTools.bat. When the
following information is displayed, enter 1 and press Enter.
1) Change FTPServer password 
2) Change database password 
3) Change Modbus SSL config 
4) Change FTPS SSL config 
5) Change external IP of the NetEco 
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6) Change local IP of the NetEco 
7) Exit 
 
Please choose 1-7:

Step 2 When the following information is displayed, enter ftpuser, and press Enter.
Please input FTPserver username:

Step 3 When the following information is displayed, enter current password and press
Enter.
Please input the old password:

Step 4 When the following information is displayed, enter new password and press Enter.
Please input new FTPserver password:

● The password cannot be the same as the user name or the user name in a reversed
order.

● The password contains 8 to 32 characters.

● The password contains three of the following:

– Lowercase letters

– Uppercase letters

– Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

Step 5 When the following information is displayed, enter new password again and press
Enter.
Please confirm new FTPserver password:

Step 6 When the following information is displayed, the password is changed successfully.
FTPServer password changed. 
Change succeeded.

Password take effect after the next restart NetEco 1000S.

----End

4.1.9.14 How Do I Modify the Data or File Transmission Protocol?
This section describes how to modify the data or file transmission protocol. Data is
transmitted using the Modbus protocol and files are transmitted using the FTPS
between the NetEco 1000S and SmartLogger. Data and files are transmitted using
the Modbus protocol between the NetEco 1000S and the directly connected
inverters.

Context
The data or file transmission protocol needs to be modified, that is, modifying the
TLS protocol of the Modbus or FTP.

To be compatible with devices of earlier versions, the NetEco 1000S supports the
TLSv1.0, TLSv1.1, and TLSv1.2 at the same time by default. TLSv1.0 has security
risks. To ensure connection security, you are advised to use TLSv1.1 or TLSv1.2.
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NO TICE

If the SmartLogger or the directly connected inverters does not support
TLSv1.1/1.2, the SmartLogger or the directly connected inverters may be
disconnected after you change the protocol to TLSv1.1 or TLSv1.2. You are advised
to replace the SmartLogger or inverters directly connected to the FE with the one
supporting TLSv1.1/1.2 or upgrade the SmartLogger or inverters directly connected
to the FE to the version supporting TLSv1.1/1.2.

Procedure

Step 1 Logging Out of the NetEco 1000S services, for detailed operations, see 4.1.1.2.2
Logging Out of the NetEco 1000S Services.

Step 2 Run the script NetEco software installation\tools\ConfigTools.bat. The
following information is displayed:
1) Change FTPServer password 
2) Change database password 
3) Change Modbus SSL config 
4) Change FTPS SSL config 
5) Change external IP of the NetEco 
6) Change local IP of the NetEco 
7) Exit 
 
Please choose 1-7:

Step 3 Modify the transmission protocol.
● Modify the data transmission protocol.

a. Enter 3 and press Enter. The following information is displayed:
The old config is : TLSv1,TLSv1.1,TLSv1.2 
1) TLSv1,TLSv1.1,TLSv1.2 
2) TLSv1.1,TLSv1.2 
3) TLSv1.2 
4) Cancel 
 
Please choose 1-4:

b. Set the data transmission mode as required.
n Supporting TLS1.0, TLS1.1, and TLS1.2: Enter 1 and press Enter.

NO TICE

TLSv1.0 has security risks. To ensure connection security, you are
advised to use TLSv1.1 or TLSv1.2.

When the following information is displayed, the protocol type is
changed successfully:
Modbus SSL changed to TLSv1, TLSv1.1, TLSv1.2
Change succeeded.

n Supporting TLS1.1 and TLS1.2: Enter 2 and press Enter.
When the following information is displayed, the protocol type is
changed successfully:
Modbus SSL changed to TLSv1.1, TLSv1.2  
Change succeeded.
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n Supporting Only TLS1.2: Enter 3 and press Enter.

When the following information is displayed, the protocol type is
changed successfully:
Modbus SSL changed to TLSv1.2  
Change succeeded.

● Modify the file transmission protocol.

a. Enter 4 and press Enter. The following information is displayed:
The old config is : TLSv1,TLSv1.1,TLSv1.2 
1) TLSv1,TLSv1.1,TLSv1.2 
2) TLSv1.1,TLSv1.2 
3) TLSv1.2 
4) Cancel 
 
Please choose 1-4:

b. Set the file transfer mode as required.

n Supporting TLS1.0, TLS1.1, and TLS1.2: Enter 1 and press Enter.

NO TICE

TLSv1.0 has security risks. To ensure connection security, you are
advised to use TLSv1.1 or TLSv1.2.

When the following information is displayed, the protocol type is
changed successfully:
FTPS SSL config changed to TLSv1, TLSv1.1, TLSv1.2
Change succeeded.

n Supporting TLS1.1 and TLS1.2: Enter 2 and press Enter.

When the following information is displayed, the protocol type is
changed successfully:
FTPS SSL config changed to TLSv1.1, TLSv1.2  
Change succeeded.

n Supporting Only TLS1.2: Enter 3 and press Enter.

When the following information is displayed, the protocol type is
changed successfully:
FTPS SSL config changed to TLSv1.2  
Change succeeded.

Step 4 Restart the NetEco 1000S for the settings to take effect.

----End

4.1.9.15 How Do I Ensure that Performance Data Can Be Properly Reported
When the NetEco 1000S and SmartLogger Are Deployed On Different
Network Segments?

If the NetEco 1000S and SmartLogger are deployed on different network
segments, you need to set the external IP address of the NetEco 1000S using the
configuration file so that performance data can be properly reported between the
NetEco 1000S and SmartLogger.
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Procedure

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Step 1 Logging Out of the NetEco 1000S services, for detailed operations, see 4.1.1.2.2
Logging Out of the NetEco 1000S Services.

Step 2 Run the script NetEco software installation\tools\ConfigTools.bat. When the
following information is displayed, type 5 and press Enter.
1) Change FTPServer password 
2) Change database password 
3) Change Modbus SSL config 
4) Change FTPS SSL config 
5) Change external IP of the NetEco 
6) Change local IP of the NetEco 
7) Exit 
 
Please choose 1-7:

Step 3 When the following information is displayed, type the external IP address of the
NetEco and press Enter.
 Please input external IP of the NetEco:

Step 4 When the following information is displayed, the external IP address of the NetEco
is changed successfully.
External IP of the NetEco is changed to xxx.xx.xx.xx 
Change succeeded.

Step 5 Type 7 and press Enter to exit.

Step 6 Restart the NetEco 1000S for the settings to take effect.

----End

4.1.9.16 How Do I Replace the Key File of the NetEco 1000S?
To ensure the security and reliability of the NetEco 1000S key, the system
administrator needs to periodically replace the NetEco 1000S key to improve the
security of the NetEco 1000S.

Prerequisites
You have started the NetEco 1000S services. For details about how to start the
services, see 4.1.1.1.1 Starting NetEco 1000S Services.

Context
You are advised to replace the Key file every 3 months to improve the security of
the NetEco 1000S.
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Procedure

Step 1 Stop the NetEco 1000S services. For detailed operations, see 4.1.1.2.2 Logging
Out of the NetEco 1000S Services.

Step 2 Run the script NetEco 1000S software installation directory\tools
\KeysTools.bat.

The following information is displayed:

please input database username:

Step 3 Type dbuser and press Enter.

The following information is displayed:

please input database password:

Step 4 Type the password of dbuser user and press Enter.

The following information is displayed:

Do you want to start replacing the key?Y: start. N: cancel.

Step 5 Type Y and press Enter.

When the following information is displayed, the key is successfully replaced:

Starting database ... 
database started 
 
Change succedded

NO TICE

The command window is automatically closed after the key is replaced. You
cannot manually close the command window during the key replacement.
Otherwise, data interruption will occur.

If any statement indicating the replacement failure is displayed, perform the
operations as prompted or contact Huawei technical support.

Step 6 After the replacement is complete, restart the NetEco 1000S services.

----End

4.1.9.17 How Do I Change the Password of the plantcontroller user?
User plantcontroller is used for plant controller devices to transfer files to the
NetEco. You are advised to change the password periodically to ensure system
security.

Prerequisites
● You have obtained the password of plantcontroller user.

Please see User_Manual > Installation and Commissioning > Planning
Operating System Users and Their Initial Passwords for details about the
password of plantcontroller user.
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● You have started the NetEco 1000S services. For details about how to start the
services, see 4.1.1.1.1 Starting NetEco 1000S Services.

You are advised to change the password after you install the NetEco 1000S for the first
time, and change the password every three months.

Procedure

Step 1 Run the script NetEco software installation\tools\ConfigTools.bat. When the
following information is displayed, type 1 and press Enter.
1) Change FTPServer password 
2) Change database password 
3) Change Modbus SSL config 
4) Change FTPS SSL config 
5) Change external IP of the NetEco 
6) Change local IP of the NetEco 
7) Exit 
 
Please choose 1-7:

Step 2 When the following information is displayed, type plantcontroller, and press
Enter.
Please input FTPserver username:

Step 3 When the following information is displayed, type current password and press
Enter.
Please input the old password:

Step 4 When the following information is displayed, type new password and press Enter.
Please input new FTPserver password:

● The password cannot be the same as the user name or the user name in a reversed
order.

● The password contains 8 to 32 characters.

● The password contains three of the following:

– Lowercase letters

– Uppercase letters

– Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

Step 5 When the following information is displayed, enter new password again and press
Enter.
Please confirm new FTPserver password:

Step 6 When the following information is displayed, the password is changed successfully.
FTPServer password changed. 
Change succeeded.

Password take effect after the next restart NetEco 1000S.

----End
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4.1.9.18 What Do I Do If the Email Server Fails to Send an Email?
This section describes how to solve the problem that the email server fails to send
an email.

Possible Causes
The possible causes of the failure are as follows:

● Incorrect network configuration
● Incorrect IP address or domain name of the email sending server
● Incorrect port number for email sending
● Incorrect user name or password
● Incorrect sender or recipient email address

Procedure

Step 1 Check the network configuration.

1. Choose Start > Control Panel > Network and Internet > Network and
Sharing Center > Network Connections in the operating system.

The navigation path of Network Connections on the Control Panel may vary
depending on the OS version. Choose the corresponding path as required.

The Network Connections dialog box is displayed.
2. Click Properties.

The Local Area Connection Properties dialog box is displayed, as shown in
Figure 4-83.
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Figure 4-83 Local area connection properties

3. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

4. Select Obtain an IP address automatically and Obtain DNS server address
automatically, and click OK.

5. Check whether the problem has been resolved.

– If the problem has been resolved, no further operation is required.

– If the problem persists, go to the next step.

Step 2 Check Email sending server.

1. Check whether the IP address or domain name configured for Email sending
server is correct.

If the configuration is correct, go to the next step. Otherwise, configure the
correct IP address or domain name by referring to 4.1.8.3.1 Setting
Parameters for the Email Server.

2. Check whether the problem has been resolved.

– If the problem has been resolved, no further operation is required.

– If the problem persists, go to the next step.

Step 3 Check Email sending port No.

1. Check whether the setting of Email sending port No is correct.
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If the configuration is correct, go to the next step. Otherwise, configure the
correct port number by referring to 4.1.8.3.1 Setting Parameters for the
Email Server.

2. Check whether the problem has been resolved.
– If the problem has been resolved, no further operation is required.
– If the problem persists, go to the next step.

Step 4 Check User name and Password.

1. Check whether User name and Password are correctly configured.
If the configuration is correct, go to the next step. Otherwise, configure the
correct user name and password by referring to 4.1.8.3.1 Setting Parameters
for the Email Server.

2. Check whether the problem has been resolved.
– If the problem has been resolved, no further operation is required.
– If the problem persists, go to the next step.

Step 5 Check Sender email address and Recipient email address.

1. Check whether Sender email address and Recipient email address are
correctly configured.
If the configuration is correct, go to the next step. Otherwise, configure the
correct email address by referring to 4.1.8.3.1 Setting Parameters for the
Email Server.

2. Check whether the problem has been resolved.
– If the problem has been resolved, no further operation is required.
– If the problem persists, go to the next step.

Step 6 If the problem persists after the preceding possible causes are ruled out, contact
Huawei technical support engineers.

----End

4.1.9.19 How Do I Solve the Problem that the Calculated Performance Ratio
Is Inaccurate?

This section describes how to locate the cause of performance ratio inaccuracy
and solve this problem.

Possible Causes
The total component capacity is not configured for inverters.
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Procedure

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Step 1 Check whether total component capacity is configured for all inverters.

1. Log in to the NetEco 1000S client as the system administrator, a manager, or
an installer.

2. Click the Monitor tab.
3. Choose the inverter to be checked from the navigation tree in the left pane

and click the Settings tab in the right pane.
The Device Information page is displayed.

4. Check whether Total string capacity is configured.
– If it is configured, view the configuration pages of all inverters in

sequence and check whether Total string capacity has been configured
for all inverters.

If any inverters are not configured with Total string capacity, configure Total
string capacity for them.

– If it is not configured, enter the target value in the Total string capacity
text box and click Save in the upper right corner.

To change the total string capacity of multiple inverters to the value set in last
step, click Batch Apply and select target devices.

5. Check whether the problem has been resolved.
– If the problem has been resolved, no further operation is required.
– If the problem persists, go to the next step.

Step 2 If the problem persists after the preceding possible causes are ruled out, contact
Huawei technical support engineers.

----End

4.1.9.20 Failure to Receive Emails

Symptom

After the alarm or report sending rules are configured on the NetEco 1000S client,
no alarm or report emails are received.
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Possible Causes
● Reasons related to the sender's server: The sender's server categorizes the

emails as junk emails and therefore does not send the emails.

An email may be categorized as a junk email for the following reasons:

– The number of emails sent in a day exceeds the limit.

– The content of the email is the same as or similar to that of another
email.

● Reasons related to the recipient's server:

– The emails are categorized as junk emails and therefore cannot be
received.

– In Windows Server 2012, the email server is used for email receiving by
default. The cause may be that the default host name or domain name
of the email server is not recognized. As a result, the emails fail to be
received.

This problem may occur if customers use the email server installed by
themselves.

Procedure

Step 1 Check the sender's email server.

● In Windows Server 2012, enable the SMTP server for email sending.

● In Windows 7 or Windows 10, upgrade the mailbox to a VIP mailbox for email
sending. For detailed operations, contact Huawei technical support engineers.

Step 2 Check whether the problem has been resolved.

● If the problem has been resolved, no further operation is required.

● If the problem persists, go to the next step.

Step 3 Check the recipient's mailbox.

Check whether junk emails contain emails from the NetEco 1000S. If yes, set the
mailbox so that emails from the NetEco 1000S are not categorized as junk emails.

Step 4 Check whether the problem has been resolved.

● If the problem has been resolved, no further operation is required.

● If the problem persists, go to the next step.

Step 5 If the operating system is Windows Server 2012, change the email server attribute.

Set the host name or domain name of the email server to a value in the
****.****.**** format, such as mail.neteco.com.

Step 6 Check whether the problem has been resolved.

● If the problem has been resolved, no further operation is required.

● If the problem persists, contact Huawei technical support.

----End
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4.1.9.21 What Do I Do If the Client Does Not Display the Language Selected
During Last Access After Access to the NetEco 1000S Using a Web Browser?

Symptom

When a user accesses the NetEco 1000S using a web browser again, the client
does not display the language selected during last access.

Possible Causes
● The browser has been configured to delete browsing history on exit.
● Cookies have been disabled for the browser.
● The URL entered in the address box of the browser for accessing the client

carries a language attribute.

Procedure

Step 1 Cancel browsing history deletion upon exit for the browser.

1. Choose Tools > Internet Options from the main menu of the browser.
2. On the General tab page, clear Delete browsing history on exit.

Step 2 Allow cookies.

1. Choose Tools > Internet Options from the main menu of the browser.
2. On the Privacy tab page, click Advanced.

The Advanced Privacy Settings dialog box is displayed.
3. Select Override automatic cookie handing, select Accept under First-party

Cookies and Third-party Cookies, select Always allow session cookies, and
click OK.

Step 3 Delete the language attribute (webLang=xxx) carried in the client access URL.

For example, if the client access URL is https://IP address/index.action?
webLang=zh_CN, delete the language attribute from the URL. That is, use
https://IP address/index.action to access the client.

----End

4.1.9.22 What Should I Do When Running the SSLTools.bat Script to
Generate a New Certificate Fails?

Symptom

Running the SSLTools.bat script to generate a new certificate fails, and the
following information is displayed.

Create keystore file failed.

Possible Cause

vcredist.x86.exe is not installed for the current operating system.
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Procedure

Step 1 Obtain vc_redist.x86.exe from the Microsoft official website and save it to the
current operating system.

Step 2 Double-click vcredist.x86.exe and install it.

Step 3 Run the SSLTools.bat script again to generate a new certificate.

----End

4.1.9.23 What Do I Do to Change the Life Cycle of Operation Logs?
The life cycle of operation logs is half a year by default. You can run the
LogTools.bat script to change the life cycle of operation logs.

Prerequisites
The NetEco 1000S is of V100R002C70 or a later version.

Procedure

Step 1 Go to NetEco 1000S software installation directory\tools, and run the
LogTools.bat script.

The following information is displayed:
1 Change life cycle of operatelog<1~3650>.
2 Exit.
Please Choose:

Step 2 Enter 1 and press Enter.

The following information is displayed:
Please input the life cycle of operatelog:

Step 3 Enter the number of days as required and press Enter.

User-defined life cycle of operation logs ranges from 1 to 3650, indicating 1–3650
days.

Step 4 Restart the NetEco 1000S to validate the settings.

----End

4.1.9.24 How Do I Disable the Display of the Remote Control Function?
To disable the display of the remote control function, modify the
userManagement.properties file as required.

Prerequisites
The NetEco 1000S is of V100R003C00CP1104 or a later version.

Procedure

Step 1 Go to NetEco 1000S software installation directory\WebRoot\WEB-INF
\classes, and open the userManagement.properties file.
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The following information is displayed:
loginErrorMaxNum=5
loginErrorLockTime=5
NetEcoIP=
isShowThirdEquipment=0
isStartCom=0
queryNum=15
blockedIP=
PrivacyStatementType=1
isShowUseTerms=1
selfRegister=1
isShowFunsion=0
publicNetworkIP=
#0: Not display 1: Display
remoteControlSwitch=1

Step 2 Change the value of remoteControlSwitch to 0 and save the modification.

Step 3 Restart the NetEco 1000S to validate the settings.

----End

4.2 NetEco 1000S App Operation

4.2.1 Registering a User
You can register yourself as an installer or customer on the NetEco 1000S app.

Prerequisites
● You have added the identification number of the mobile terminal in the

NetEco 1000S system. For details, see 3.2.3 Security Configuration for
NetEco 1000S App.

● You have installed the NetEco 1000S app software on the mobile terminal.
For details, see 3.2.2 Installing the NetEco 1000S App Software.

● You have set the email server.
● You have enabled the self-registration account on the NetEco 1000S. For

details, see 3.1.2 Installing the NetEco 1000S Software or 4.1.8.4.9 Setting
Self-Registration Account.

Context

● The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

● Personal data such as phone numbers and email addresses are anonymized in the
NetEco GUI and encrypted in the NetEco during batch data transmission to ensure data
security.

Procedure

Step 1 Tap the NetEco 1000S app icon on the desktop of the mobile terminal to open the
login screen, as shown in Figure 4-84.
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Figure 4-84 Login screen

Step 2 Specify the IP address or domain name of the NetEco 1000S server.

● Before Server IP/Domain Name is set, New Account is not displayed.
● If New Account is not displayed after you set Server IP/Domain Name, the self-

registration account is not enabled for NetEco 1000S. In this case, enable the self-
registration account function on the WebUI. For details, see 4.1.8.4.9 Setting Self-
Registration Account.

Step 3 On the screen shown in Figure 4-84, tap New Account.

The New Account screen is displayed, as shown in Figure 4-85.
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Figure 4-85 Registration

Step 4 Set the parameters, and click New Account.

The senior manager can manage the PV plant created by the registered user.

● If the registered user is installer, enter the email address of an existing manager in
the system.

● If the registered user is customer, enter the email address of an existing manager or
installer in the system.

A dialog box is displayed, asking you to go to the mailbox to activate the
registered account.

NO TICE

● The default validity period of the activation link in the mailbox is 24 hours. If
the account is not activated within 24 hours, register the user again.

● You can modify the validity period of the activation link by modifying the
configuration file.

Step 5 Go to the mailbox and tap the activation link to activate the NetEco 1000S
account.
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Once activated, the registered account can be used to log in to the NetEco 1000S
app.

----End

4.2.2 Logging In to the NetEco 1000S App
Before using the NetEco 1000S app, you must log in to it.

Prerequisites
● You have added the identification number of the mobile terminal in the

NetEco 1000S system. For details, see 3.2.3 Security Configuration for
NetEco 1000S App.

● You have installed the NetEco 1000S app software on the mobile terminal.
For details, see 3.2.2 Installing the NetEco 1000S App Software.

● You have obtained the user Account/Email and password for logging in to
NetEco 1000S app.

● The mobile terminal has been connected to the network.

Context
The NetEco 1000S app can be installed on mobile terminals running IOS 6.0,
Android 5.0, and later versions. The NetEco 1000S app supports the TLSv2
communication protocol.

Procedure
Step 1 Tap the NetEco 1000S app icon on the desktop of the mobile terminal to open the

login screen, as shown in Figure 4-86.

Figure 4-86 Login screen
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Step 2 Optional: Specify the IP address or domain name of the NetEco 1000S server if
this is the first time that you log in to the NetEco 1000S app.

Step 3 Enter the user's Account/Email and password.

If you select Remember password, you can log in to the home page of the app next time
simply by tapping Login.

Step 4 Tap Login.

NO TICE

If you are redirected to the User Authorization page, you need to select I have
read and agree to the Privacy Policy and Terms of Use before tapping OK to
proceed to the next step. To decide whether to enable the User authorization, see
3.1.2 Installing the NetEco 1000S Software for details.

After the login is successful, the home page of the NetEco 1000S app is displayed.

----End

4.2.3 Creating a PV Plant
You can create a PV plant in the NetEco 1000S app and connect to the residential
inverter that has been registered in the FusionHome app.

Prerequisites
● You have logged in to the NetEco 1000S app. For details, see 4.2.2 Logging In

to the NetEco 1000S App.
● You have logged in as the system administrator, manager, installer, or guest

user.
● The IP address of the NetEco 1000S has been registered with the device, and

the device has been successfully registered with the management system. For
details, see the device user manual.

Context

The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

Procedure

Step 1 On the home page, tap the Set tab.

Step 2 On the Set page, tap New PV Plant.

Step 3 On the New PV Plant page, set parameters and tap Next.

Step 4 Perform operations based on the actual scenario.
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● To connect a device to a new PV plant, performs Step 5~Step 6.
● If you need only to create a PV plant, go to Step 7.

Step 5 Perform the following operations on the Selecte Device page and click Next:
● Select a target device in the device list.
● Enter the SN and name of the target device and click Add.

● Click  to scan the QR code on the device to identify the device.

Step 6 Set device information and tap Next. The device will be connected to the new PV
plant.

Step 7 On the Selecte Device page, tap Skip to finish creating the PV plant.

----End

4.2.4 Connecting Devices
In the NetEco 1000S app, you can connect the residential inverter registered in the
FusionHome app to the existing PV plant.

Prerequisites
● You have logged in to the NetEco 1000S app. For details, see 4.2.2 Logging In

to the NetEco 1000S App.
● You have logged in as the system administrator, manager, installer, or guest

user.
● The IP address of the NetEco 1000S has been registered with the device, and

the device has been successfully registered with the management system. For
details, see the device user manual.

Context

The product feature you have purchased may use personal information of users when
providing services or maintenance. Therefore, you need to configure such information in
accordance with the requirements on personal data in local laws and regulations.

Procedure

Step 1 On the home page, tap the Set tab.

After you use the FusionHome app to perform quick setting, you can click the icon in the
upper right corner of the app home page to enter into the Selecte Device page.

Step 2 On the Set page, tap Device Access.

Step 3 Perform the following operations on the Selecte Device page and click Next:
● Select a target device in the device list.
● Enter the SN and name of the target device and click Add.

● Click  to scan the QR code on the device to identify the device.
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Step 4 Set device information.

Step 5 Perform operations based on the actual scenario.
● To connect a device to an existing PV plant, performs Step 6~Step 8.
● To connect a device to a new PV plant, performs Step 9~Step 11.

Step 6 Tap Add to Existing PV Plant.

Step 7 Select the target plant, and tap Next.

The Configuration Successful page is displaed.

Step 8 Click Finish.

Step 9 Tap Add to New PV Plant.

Step 10 Set PV plant parameters and tap Next.

The Configuration Successful page is displaed.

Step 11 Click Finish.

----End

4.2.5 Viewing the Overview of the PV System
You can view the PV system overview on the Overview page of the NetEco 1000S
app.

Prerequisites
You have logged in to the NetEco 1000S app. For details, see 4.2.2 Logging In to
the NetEco 1000S App.

Procedure

Step 1 On the home page, tap the Overview tab. The PV System Overview page is
displayed.
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Figure 4-87 PV System Overview page

Step 2 On the PV System Overview page, you can perform the following operations.

If You Need To... Then...

View PV system KPIs. On the upper part of the PV System Overview page,
view KPIs such as Income and Daily Energy.
NOTE

If the Income pane displays Set the exchange rate, perform
the following operations:
1. Tap Set the exchange rate link. The PV System Currency

Settings page is displayed.
2. Set the currency for the PV system and the exchange rates

for the PV plants as required, and click Save.

View the energy yield
and revenue report of
the PV system.

View the energy yield and revenue report of the PV
system in the lower part of the PV System Overview
page.
Meanings of the coordinates are as follows:
● Left vertical coordinate: Energy yield statistics
● Right vertical coordinate: Income statistics
● Horizontal coordinate: data collection period.

Tap  to switch between
the time periods.
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If You Need To... Then...

View the PV plant list. Tap  next to the Total number of PV plants.... The
PV Plant List page is displayed.

 

----End

4.2.6 Viewing Plant and Device Details
You can view the information about each PV plant and devices connected to the
plant in the NetEco 1000S app. You can learn about the running status of the PV
plant and devices.

Prerequisites
You have logged in to the NetEco 1000S app. For details, see 4.2.2 Logging In to
the NetEco 1000S App.

Procedure

Step 1 Tap the Plant tab in the lower part of the home page to view the PV plant list.
See Figure 4-88.
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Figure 4-88 PV plant list

Step 2 Tap the target PV plant. The PV Plant Overview page is displayed. See Figure
4-89.
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Figure 4-89 PV plant overview

Step 3 You can perform the following operations on the PV Plant Overview page.

If You Need To... Then...

View all KPIs of the PV
plant.

On the upper part of the PV Plant Overview page,
view KPIs such as Income and Daily Energy.
Tap  to view more KPIs.

View the device energy
flow diagram.

● You can view the device energy flow diagram of
the plant in the middle of the PV Plant
Overview page.

● If a battery or meter is connected to the
residential inverter, you can click the battery or
meter icon to view its details.
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If You Need To... Then...

View the energy yield and
revenue report of the PV
plant.

In the lower part of the PV Plant Overview page,
view the energy yield and revenue report of the
plant.
● When the time dimension is day, the vertical

coordinate displays only the power.
● When the time dimension is month, year, or

total, the vertical coordinate is on the left and
right sides.
– Left vertical coordinate: Energy yield statistics
– Right vertical coordinate: Income statistics

● Horizontal coordinate: data collection period.
Tap  to switch
between the time periods.

View the device list. ● On the PV Plant Devices page, you can view the
device list of the plant.

● Tap the target device. The Device Overview
page is displayed.
On the Device Overview and Alarms pages,
you can view device details and alarm
information.

View the PV plant alarm
list.

On the PV Plant Alarms page, you can view the
alarm information of the PV plant.

 

----End

4.2.7 Basic Settings
On the Set page, you can set the NetEco 1000S app and view the basic
information about the NetEco 1000S app.

Prerequisites
You have logged in to the NetEco 1000S app. For details, see 4.2.2 Logging In to
the NetEco 1000S App.

Procedure

Step 1 Tap the Set tab in the lower part of the home page. The Set page is displayed, as
shown in Figure 4-90.
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Figure 4-90 settings

Step 2 On the Set page, you can perform the following operations.

If You Need To... Then...

Create a PV plant. For details, see 4.2.3 Creating a PV Plant.

Connect devices. For details, see 4.2.4 Connecting Devices.

Set the PV system
currency.

1. Tap PV System Currency Settings. The PV
System Currency Settings page is displayed.

2. Set the currency for the PV system and the
exchange rates for the PV plants as required,
and click Save.

View the privacy policy,
terms of use, or version
information.

Tap the related content to view the privacy policy,
terms of use, or version information.

Log out. You can tap Log Out to exit the NetEco 1000S app.

 

----End

4.3 NetEco 1000S Maintenance
This section describes how to manage NetEco 1000S users and logs.

iManager NetEco 1000S
User Manual 4 Operation and Maintenance

Issue 02 (2019-12-30) Copyright © Huawei Technologies Co., Ltd. 210



4.3.1 Managing Users
This section describes how to manage the NetEco 1000S users, which involve
MySQL users and NetEco 1000S users. You can manage the accounts and
authority of these users and monitor user operations.

4.3.1.1 Managing MySQL Users

This section describes the MySQL users that are required for the NetEco 1000S
and how to change the password of the MySQL administrator.

4.3.1.1.1 MySQL Users and User Authority

This section describes the MySQL users used by the NetEco 1000S and the related
authority.

Only the MySQL user is authorized to use the MySQL database. After the MySQL
database is installed, the system Create the default user administrator and
dbuser.

For details about the MySQL user accounts, see Table 4-27.

Table 4-27 MySQL user accounts

User Function Authority

administra
tor

Management user of the
MySQL database.

User administrator has the
highest authority of the
database.

dbuser Operation user of the MySQL
database.

User dbuser has the permission
to the database.

 

4.3.1.1.2 Changing the Passwords of MySQL Users

Change the user passwords of the databases during routine maintenance, which
ensures database user password security.

Prerequisites
● The old password of the MySQL user is available.

● The new password of the MySQL user is available.

● You have started the NetEco 1000S services. For details, see 3.1.3 Starting
NetEco 1000S Services.

Context

To ensure user password security, plan user passwords that meet password policy
and change passwords periodically.
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● The password cannot be the same as the user name or the user name in a reversed
order.

● The password contains 8 to 32 characters.

● The password contains three of the following:

● Lowercase letters

● Uppercase letters

● Digits

● The password is advised to contain special characters, which include !"#$%&'()*
+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure

NO TICE

To improve system security and prevent security risks (for example, violent
password cracking), change the initial password set upon device delivery in a
timely manner and change the user password periodically (for example, every six
months). If the password is lost, stolen, or cracked, the user shall be liable for any
loss incurred.

Step 1 Changing the passwords of MySQL users: Run the script NetEco software
installation\tools\ConfigTools.bat, When the following information is displayed,
enter 2 and press Enter.
1) Change FTPServer password 
2) Change database password 
3) Change Modbus SSL config 
4) Change FTPS SSL config 
5) Change external IP of the NetEco 
6) Change local IP of the NetEco 
7) Exit 
 
Please choose 1-7:

Step 2 When the following information is displayed, enter database username and press
Enter.

Please input database username :database username

Step 3 When the following information is displayed, enter password of the database
user and press Enter.

Please input old database password : password of the database user

Step 4 When the following information is displayed, enter new password of the
database user and press Enter.

Please input new database password :new password of the database user

Step 5 When the following information is displayed, enter new password of the
database user again and press Enter.

Please confirm new database password:new password of the database user
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Step 6 When the following information is displayed, the password is changed successfully.

Change succeeded.

Step 7 Restart the NetEco 1000S services.

When the password is changed successfull, you must restart the NetEco 1000S
services. Otherwise, an exception may occur.

----End

4.3.1.2 Managing NetEco 1000S Users
This section describes the roles of NetEco 1000S users and the related authority.
For details about users and the related authority, see 4.1.8.1 Managing User
Information.

4.3.2 Management Logs
This section describes management logs. You can learn about the NetEco 1000S
running status and operations through management logs.

4.3.2.1 NetEco 1000S Log Types
NetEco 1000S logs record important user operations. You can view the log list or
details about a log, or export operation logs, operation logs, or system logs. The
NetEco 1000S provides information about logs with three levels (warning, minor,
and critical).

Security Log
Security logs record the security operations that are performed on the eSight
client, such as logging in to the client, changing the password, creating a user, and
exiting the client.

You can query security logs to understand the information about NetEco 1000S
security operations.

System Log
System logs record the events that occur on the NetEco 1000S. For example,
NetEco 1000S running exceptions, network faults, and NetEco 1000S attacks.
System logs help analyze the operating status of the NetEco 1000S and rectify
faults.

You can query system logs to understand the information about NetEco 1000S
system operations.

Operation Log
Operation logs record the operations that are performed on the NetEco 1000S,
such as device addition and deletion.

You can query operation logs to understand the information about user
operations.
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4.3.2.2 Managing the Binary Log of the Database

The binary log of the database records the ciphertext information about database
password changing, which may introduce security risks.

The binary log of the MySQL database is a function of the MySQL database. It is used for
storing data for database backup. For details, see the official website of the MySQL
database http://www.mysql.com/.

Enabling the Binary Log of the Database

If you enable the binary log of the database, the system records the ciphertext
information generated when you change the database password, which may
introduce security risks. If the ciphertext information does not need to be recorded,
you are advised to disable the binary log of the database.

● Use the Notepad to open the NetEco 1000S installation directory\mysql
\oms_mysql\my.ini file.

● In the opened file, find the log-bin field, delete # before this field, and save
and close the file. Then, restart the service.

Press Ctrl+F to quickly locate the log-bin field.

Disabling the Binary Log of the Database

If you disable the binary log of the database, the system disables the function of
saving the binary log. As a result, you cannot use the binary log to back up data.

● Use the Notepad to open the NetEco 1000S installation directory\mysql
\oms_mysql\my.ini file.

● In the opened file, find the log-bin field, add # before this field, and save and
close the file. Then, restart the service.

4.3.3 Replacing Certificate of the NetEco 1000S System
The NetEco 1000S system provides the default Huawei-preconfigured certificate
for security connection. This certificate applies only to the commissioning scenario.
Huawei-preconfigured certificate cannot ensure the information transmission
security. When users need to ensure information security, they must apply for a
legal and valid certificate from the CA and replace the preconfigured certificate
with the applied one. The certificate cracking possibility increases if one certificate
is used for a long period. Therefore, replace the certificate periodically.

4.3.3.1 Viewing Certificates

Prerequisites

JavaKeysotre (JKS) certificates have been obtained.

You are authorized to access the NetEco 1000S installation directory.
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Context
The Keytool provided by Java can be used to view JKS certificate information.

Check the validity period of the certificate and ensure that the certificate is used in
the period of validity.

Procedure

Step 1 Copy the certificate neteco.jks to NetEco 1000S installation directory\uninstall
\jre\jre_win\bin.

By default, after the NetEco 1000S is installed, the preconfigured certificates neteco.jks are
saved in the NetEco 1000S software installation directory\WebRoot\WEB-INF
\workspace.
The certificate password provided by the NetEco 1000S by default is Changeme_123.

Step 2 Open the DOS command interface and run the following commands to navigate
to the keytool installation directory. Assume that the software is installed in the D:
\NetEco1000S directory.

C:\Users>D:

D:\>cd NetEco1000S\uninstall\jre\jre_win\bin

Step 3 Run the following command to view the certificate information:
keytool -v -list -keystore neteco.jks -storepass Changeme_123 -storetype jks

----End

4.3.3.2 Replacing a Certificate for the NetEco 1000S Client Communicating
with the Server

This section describes how to replace the HTTPS protocol certificate preconfigured
for the web-based NetEco 1000S client communicating with the server.

Prerequisites
● You have installed the NetEco 1000S.
● You are authorized to access the NetEco 1000S installation directory.
● You have applied for a new digital certificate from the Certificate Authority

(CA).

The name of a certificate applied for from the CA may be different from the following
certificate name. Change the certificate name to be the same as the following
certificate name.

– Device certificate: NetEco.cer
– Private key of the device certificate: NetEco_Key.pem

If a password has been configured for the private key of the device
certificate, the password must also be obtained.

– Certificate issued by a subordinate CA: NEPL_PKI.cer (there may be
multiple or no such certificates)
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– Root CA certificate: Huawei_Equipment_CA.cer

If the certificate is a .p7b file, you must export the certificate. This section uses the
operations of user.p7b as an example.
1. Double-click the user.p7b to open the certificate.
2. Select the Certificates folder from the Certificates - Current User drop-down list

to expand the folder.
3. Right-click the certificate and choose All Tasks > Export from the shortcut menu.

Click Next in the prompt dialog.
4. Select Base64 encoded X.509(.CER), and click Next.
5. Click Browse, type the certificate file name and the export directory. Click Save.

Click Next.
6. Click Finish.

Context
● By default, after the NetEco 1000S is installed, the preconfigured certificate

neteco.jks is saved in the NetEco 1000S software installation directory
\WebRoot\WEB-INF\workspace\Certificate directory.

The certificate for enabling SSL has been incorporated to the neteco.jks certificate. When
you enable SSL on the 4.1.8.3.1 Setting Parameters for the Email Server, you do not need
to replace the SSL certificate.

● To replace the digital certificates, you must manually prepare digital
certificates, replace Huawei certificates with these certificates.

● The password of certificates must be set according to the following
requirements:
– The password contains 8 to 32 characters.
– The password contains three of the following:

n Lowercase letters
n Uppercase letters
n Digits

– The password is advised to contain special characters, which include !"#$
%&'()*+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure

Step 1 Copy the certificates.

Copy the new digital certificates to the NetEco 1000S software installation
directory\tools\bin\generateCer\certificate directory.

Step 2 Prepare new certificates.

1. Copy the contents of NEPL_PKI.cer and Huawei_Equipment_CA.cer to
NetEco.cer.

You can open NEPL_PKI.cer, Huawei_Equipment_CA.cer, and NetEco.cer in text
mode to copy their contents.
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2. Generate the certificate file neteco.jks.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 1 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 1 and press Enter.
0)Quit
1)Generate Jetty Certificate 
2)Generate Modbus/TCP<port:16100>, FTPs Certificate 
3)Generate Modbus/TCP<port:27250>, Certificate
4)Generate Email Certificate
5)Generate APP Certificate
6)Generate openAPI Certificate
Please choose:

c. When the following information is displayed, enter the obtained private
key password and press Enter.
Enter pass phrase for .\tools\bin\generateCer\certificate
\NetEco_Key.pem:obtained password of the private key

d. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter Export Password:password of the new certificate

e. When the following information is displayed, enter the password of the
new certificate again and press Enter.
Verifying - Enter Export Password:confirm the password of the new
certificate

f. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter pass phrase for .\tools\bin\generateCer\keystore
\neteco.p12:password of the new certificate

g. When the following information is displayed, the certificate file
neteco.jks is successfully created.
Create keystore file success.

3. Replacing the certificate.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 2 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 1 and press Enter.
0)Quit
1)Update Jetty Certificate 
2)Update Modbus/TCP<port:16100>, FTPs Certificate 
3)Update Modbus/TCP<port:27250>, Certificate
4)Update Email Certificate
5)Update APP Certificate
6)Update openAPI Certificate
Please choose:
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c. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current
certificate

The certificate password provided by the NetEco 1000S by default is
Changeme_123.

d. When the following information is displayed, the certificate is successfully
replaced.
Update certificate success. 
The old keystore file was backed up in folder 
.\tools\bin\generateCer\backup     

After the certificate is successfully replaced, the old certificate was backed up in folder
NetEco 1000S software installation directory\tools\bin\generateCer\backup.

4. Effective the new certificate password.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 3 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 1 and press Enter.
0)Quit
1)Change Jetty Certificate Key In Config 
2)Change Modbus/TCP<port:16100>, FTPs Certificate Key In Config 
3)Change Modbus/TCP<port:27250>,Certificate Key In Config
4)Change Email Certificate Key In Config
5)Change APP Certificate Key In Config
6)Change openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
old certificate and press Enter.
Please input old ssl key password:password of the old certificate

d. When the following information is displayed, enter the new password of
the certificate and press Enter.
Please input new ssl key password:new password of the certificate

e. When the following information is displayed, enter the new password of
the certificate again and press Enter.
Please confirm the new ssl key password:new password of the
certificate

f. When the following information is displayed, the password is changed
successfully.
Modification success, please restart the service to take effect.     

Step 3 Optional: Restore the certificate.

When an exception occurs in the new certificate or the old certificate is required,
you can run the following command to restore the certificate to the last status.
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1. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 4 and press
Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

2. When the following information is displayed, enter 1 and press Enter.
0)Quit
1)Restore Jetty Certificate 
2)Restore Modbus/TCP<port:16100>, FTPs Certificate 
3)Restore Modbus/TCP<port:27250>,Certificate
4)Restore Email Certificate
5)Restore APP Certificate 
6)Restore openAPI Certificate
Please choose:

3. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current certificate

4. When the following information is displayed, the certificate is successfully
restored.
Restore certificate success!     

Step 4 Restart the NetEco 1000S for the settings to take effect.

If you can access NetEco 1000S services properly, the security certificate is
replaced successfully. Otherwise, contact Huawei technical support.

----End

4.3.3.3 Replacing a Certificate for the NE Communicating with the Server
This section describes how to replace the Modbus/TCP protocol certificates
preconfigured for the NE communicating with the server.

Prerequisites
● You have installed the NetEco 1000S.
● You are authorized to access the NetEco 1000S installation directory.
● You have applied for a new digital certificate from the Certificate Authority

(CA).

The name of a certificate applied for from the CA may be different from the following
certificate name. Change the certificate name to be the same as the following
certificate name.

– Device certificate: NetEco.cer
– Private key of the device certificate: NetEco_Key.pem

If a password has been configured for the private key of the device
certificate, the password must also be obtained.

– Certificate issued by a subordinate CA: NEPL_PKI.cer (there may be
multiple or no such certificates)

– Root CA certificate: Huawei_Equipment_CA.cer
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If the certificate is a .p7b file, you must export the certificate. This section uses the
operations of user.p7b as an example.

1. Double-click the user.p7b to open the certificate.

2. Select the Certificates folder from the Certificates - Current User drop-down list
to expand the folder.

3. Right-click the certificate and choose All Tasks > Export from the shortcut menu.
Click Next in the prompt dialog.

4. Select Base64 encoded X.509(.CER), and click Next.

5. Click Browse, type the certificate file name and the export directory. Click Save.
Click Next.

6. Click Finish.

Context
● By default, after the NetEco 1000S is installed, the preconfigured certificates

server_keystore.jks and HX_server_keystore.jks are saved in the NetEco
1000S software installation directory\WebRoot\WEB-INF\workspace
\Certificate directory.

HX_server_keystore.jks is a preconfigured certificate especially for residential
inverters.

● To replace the digital certificates, you must manually prepare digital
certificates, replace Huawei certificates with these certificates.

● The password of certificates must be set according to the following
requirements:
– The password contains 8 to 32 characters.
– The password contains three of the following:

n Lowercase letters
n Uppercase letters
n Digits

– The password is advised to contain special characters, which include !"#$
%&'()*+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure

Step 1 Copy the certificates.

Copy the new digital certificates to the NetEco 1000S software installation
directory\tools\bin\generateCer\certificate directory.

Step 2 Prepare new certificates.

1. Copy the contents of NEPL_PKI.cer and Huawei_Equipment_CA.cer to
NetEco.cer.

You can open NEPL_PKI.cer, Huawei_Equipment_CA.cer, and NetEco.cer in text
mode to copy their contents.
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2. Generate the certificate file server_keystore.jks or HX_server_keystore.jks.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 1 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 2 or 3 and press
Enter.

n Enter 2, and the certificate file generated is server_keystore.jks.
n Enter 3, and the certificate file generated is HX_server_keystore.jks.

0)Quit
1)Generate Jetty Certificate 
2)Generate Modbus/TCP<port:16100>, FTPs Certificate 
3)Generate Modbus/TCP<port:27250>, Certificate
4)Generate Email Certificate
5)Generate APP Certificate
6)Generate openAPI Certificate
Please choose:

c. When the following information is displayed, enter the obtained private
key password and press Enter.
Enter pass phrase for .\tools\bin\generateCer\certificate
\NetEco_Key.pem:obtained password of the private key

d. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter Export Password:password of the new certificate

e. When the following information is displayed, enter the password of the
new certificate again and press Enter.
Verifying - Enter Export Password:confirm the password of the new
certificate

f. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter pass phrase for .\tools\bin\generateCer\keystore
\neteco.p12:password of the new certificate

g. When the following information is displayed, enter Y and adding the
certificate to keystore.
Trust this certificate? [no]:

h. When the following information is displayed, the certificate was added to
keystore successfully.
Certificate was added to keystore

i. When the following information is displayed, enter Y and press Enter.
Trust this certificate? [no]:

j. When the following information is displayed, the certificate file
server_keystore.jks or HX_server_keystore.jks is successfully created.
Create keystore file success.

3. Replace the certificates.
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a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 2 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 2 or 3 and press
Enter.
0)Quit
1)Update Jetty Certificate 
2)Update Modbus/TCP<port:16100>, FTPs Certificate 
3)Update Modbus/TCP<port:27250>, Certificate
4)Update Email Certificate
5)Update APP Certificate
6)Update openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current
certificate

The password of the old certificate is the password of the certificate to be
replaced. The certificate password provided by the NetEco 1000S by default is
NetEco123.

d. When the following information is displayed, the certificate is successfully
replaced.
Update certificate success. 
The old keystore file was backed up in folder 
.\tools\bin\generateCer\backup 
     

After the certificate is successfully replaced, the old certificate was backed up in folder
NetEco 1000S software installation directory\tools\bin\generateCer\backup.

4. Effective the new certificate password.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 3 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 2 or 3, and press
Enter.
0)Quit
1)Change Jetty Certificate Key In Config 
2)Change Modbus/TCP<port:16100>, FTPs Certificate Key In Config 
3)Change Modbus/TCP<port:27250>,Certificate Key In Config
4)Change Email Certificate Key In Config
5)Change APP Certificate Key In Config
6)Change openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
old certificate and press Enter.
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Please input old ssl key password:password of the old certificate
d. When the following information is displayed, enter the new password of

the certificate and press Enter.
Please input new ssl key password:new password of the certificate

e. When the following information is displayed, enter the new password of
the certificate again and press Enter.
Please confirm the new ssl key password:new password of the
certificate

f. When the following information is displayed, the password is changed
successfully.
Modification success, please restart the service to take effect.     

Step 3 Optional: Restore the certificate.

When an exception occurs in the new certificate or the old certificate is required,
you can run the following command to restore the certificate to the last status.

1. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 4 and press
Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

2. When the following information is displayed, enter 2 or 3 and press Enter.
0)Quit
1)Restore Jetty Certificate 
2)Restore Modbus/TCP<port:16100>, FTPs Certificate 
3)Restore Modbus/TCP<port:27250>,Certificate
4)Restore Email Certificate
5)Restore APP Certificate 
6)Restore openAPI Certificate
Please choose:

3. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current certificate

4. When the following information is displayed, the certificate is successfully
restored.
Restore certificate success!     

Step 4 Restart the NetEco 1000S for the settings to take effect.

If you can access NetEco 1000S services properly, the security certificate is
replaced successfully. Otherwise, contact Huawei technical support.

----End

4.3.3.4 Replacing a Certificate for the Email Server
This section describes how to replace the certificates for NetEco 1000S email
server.

Prerequisites
● You have installed the NetEco 1000S.
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● You are authorized to access the NetEco 1000S installation directory.
● You have set the email server, and select Enable SSL. For details, see 4.1.8.3.1

Setting Parameters for the Email Server.
● You have applied for a new digital certificate from the Certificate Authority

(CA).
Device certificate: EmailServerTrustKeystore.cer

The name of a certificate applied for from the CA may be different from the preceding
certificate name. Change the certificate name to be the same as the preceding certificate
name.

Context
● By default, after the NetEco 1000S is installed, the preconfigured certificates

email.jks are saved in the NetEco 1000S software installation directory
\WebRoot\WEB-INF\workspace\Certificate directory.

The certificate for enabling SSL has been incorporated to the email.jks certificate. When
you enable SSL on the 4.1.8.3.1 Setting Parameters for the Email Server, you do not need
to replace the SSL certificate.

● To replace the digital certificates, you must manually prepare digital
certificates, replace Huawei certificates with these certificates.

● The password of certificates must be set according to the following
requirements:
– The password contains 8 to 32 characters.
– The password contains three of the following:

n Lowercase letters
n Uppercase letters
n Digits

– The password is advised to contain special characters, which include !"#$
%&'()*+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure

Step 1 Copy the certificates.

Copy the new digital certificates to the NetEco 1000S software installation
directory\tools\bin\generateCer\certificate directory.

Step 2 Prepare new certificates.

1. Generate the certificate file email.jks.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 1 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:
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b. When the following information is displayed, enter 4 and press Enter.
0)Quit
1)Generate Jetty Certificate 
2)Generate Modbus/TCP<port:16100>, FTPs Certificate 
3)Generate Modbus/TCP<port:27250>, Certificate
4)Generate Email Certificate
5)Generate APP Certificate
6)Generate openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
new certificate and press Enter.
Please set a new password for .\tools\bin\generateCer\certificate
\EmailServerTrustKeystore.cer:password of the new certificate

d. When the following information is displayed, enter the password of the
new certificate again and press Enter.
Please confirm the password for. \tools\bin\generateCer\certificate
\EmailServerTrustKeystore.cer:confirm the password of the new
certificate

e. When the following information is displayed, enter Y and adding the
certificate to keystore.
Trust this certificate? [no]:

f. When the following information is displayed, the certificate file email.jks
is successfully created.
Create keystore file success.

2. Replacing the certificate.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 2 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 4 and press Enter.
0)Quit
1)Update Jetty Certificate 
2)Update Modbus/TCP<port:16100>, FTPs Certificate 
3)Update Modbus/TCP<port:27250>, Certificate
4)Update Email Certificate
5)Update APP Certificate
6)Update openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current
certificate

The certificate password provided by the NetEco 1000S by default is
Changeme_123.

d. When the following information is displayed, the certificate is successfully
replaced.
Update certificate success. 
The old keystore file was backed up in folder 
.\tools\bin\generateCer\backup     
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After the certificate is successfully replaced, the old certificate was backed up in folder
NetEco 1000S software installation directory\tools\bin\generateCer\backup.

3. Effective the new certificate password.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 3 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 4 and press Enter.
0)Quit
1)Change Jetty Certificate Key In Config 
2)Change Modbus/TCP<port:16100>, FTPs Certificate Key In Config 
3)Change Modbus/TCP<port:27250>,Certificate Key In Config
4)Change Email Certificate Key In Config
5)Change APP Certificate Key In Config
6)Change openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
old certificate and press Enter.
Please input old ssl key password:password of the old certificate

d. When the following information is displayed, enter the new password of
the certificate and press Enter.
Please input new ssl key password:new password of the certificate

e. When the following information is displayed, enter the new password of
the certificate again and press Enter.
Please confirm the new ssl key password:new password of the
certificate

f. When the following information is displayed, the password is changed
successfully.
Modification success, please restart the service to take effect.     

Step 3 Optional: Restore the certificate.

When an exception occurs in the new certificate or the old certificate is required,
you can run the following command to restore the certificate to the last status.

1. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 4 and press
Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

2. When the following information is displayed, enter 4 and press Enter.
0)Quit
1)Restore Jetty Certificate 
2)Restore Modbus/TCP<port:16100>, FTPs Certificate 
3)Restore Modbus/TCP<port:27250>,Certificate
4)Restore Email Certificate
5)Restore APP Certificate 
6)Restore openAPI Certificate
Please choose:
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3. When the following information is displayed, enter the password of the
current certificate and press Enter.

Please input current ssl key password:password of the current certificate
4. When the following information is displayed, the certificate is successfully

restored.
Restore certificate success!     

Step 4 Restart the NetEco 1000S for the settings to take effect.

----End

4.3.3.5 Replacing a Certificate for the NetEco 1000S App Communicating
with the Server

This section describes how to replace the HTTPS protocol certificates
preconfigured for the NetEco 1000S app communicating with the server.

Prerequisites
● You have installed the NetEco 1000S.

● You are authorized to access the NetEco 1000S installation directory.

● You have applied for a new digital certificate from the Certificate Authority
(CA).

The name of a certificate applied for from the CA may be different from the following
certificate name. Change the certificate name to be the same as the following
certificate name.

– Device certificate: NetEco.cer

– Private key of the device certificate: NetEco_Key.pem

If a password has been configured for the private key of the device
certificate, the password must also be obtained.

– Certificate issued by a subordinate CA: NEPL_PKI.cer (there may be
multiple or no such certificates)

– Root CA certificate: Huawei_Equipment_CA.cer

If the certificate is a .p7b file, you must export the certificate. This section uses the
operations of user.p7b as an example.

1. Double-click the user.p7b to open the certificate.

2. Select the Certificates folder from the Certificates - Current User drop-down list
to expand the folder.

3. Right-click the certificate and choose All Tasks > Export from the shortcut menu.
Click Next in the prompt dialog.

4. Select Base64 encoded X.509(.CER), and click Next.

5. Click Browse, type the certificate file name and the export directory. Click Save.
Click Next.

6. Click Finish.
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Context
● By default, after the NetEco 1000S is installed, the preconfigured certificate

app.jks is saved in the NetEco 1000S software installation directory
\WebRoot\WEB-INF\workspace\Certificate directory.

The certificate for enabling SSL has been incorporated to the app.jks certificate. When you
enable SSL on the 4.1.8.3.1 Setting Parameters for the Email Server, you do not need to
replace the SSL certificate.

● To replace the digital certificates, you must manually prepare digital
certificates, and replace Huawei certificates with these certificates.

● The password of certificates must be set according to the following
requirements:
– The password contains 8 to 32 characters.
– The password contains three of the following:

n Lowercase letters
n Uppercase letters
n Digits

– The password is advised to contain special characters, which include !"#$
%&'()*+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure
Step 1 Copy the certificates.

Copy the new digital certificates to the NetEco 1000S software installation
directory\tools\bin\generateCer\certificate directory.

Step 2 Prepare new certificates.

1. Copy the contents of NEPL_PKI.cer and Huawei_Equipment_CA.cer to
NetEco.cer.

You can open NEPL_PKI.cer, Huawei_Equipment_CA.cer, and NetEco.cer in text
mode to copy their contents.

2. Generate the certificate file app.jks.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 1 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 5 and press Enter.
0)Quit
1)Generate Jetty Certificate 
2)Generate Modbus/TCP<port:16100>, FTPs Certificate 
3)Generate Modbus/TCP<port:27250>, Certificate
4)Generate Email Certificate
5)Generate APP Certificate
6)Generate openAPI Certificate
Please choose:
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c. When the following information is displayed, enter the obtained private
key password and press Enter.
Enter pass phrase for .\tools\bin\generateCer\certificate
\NetEco_Key.pem:obtained password of the private key

d. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter Export Password:password of the new certificate

e. When the following information is displayed, enter the password of the
new certificate again and press Enter.
Verifying - Enter Export Password:confirm the password of the new
certificate

f. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter pass phrase for .\tools\bin\generateCer\keystore
\neteco.p12:password of the new certificate

g. When the following information is displayed, the certificate file app.jks is
successfully created.
Create keystore file success.

3. Replacing the certificate.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 2 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 5 and press Enter.
0)Quit
1)Update Jetty Certificate 
2)Update Modbus/TCP<port:16100>, FTPs Certificate 
3)Update Modbus/TCP<port:27250>, Certificate
4)Update Email Certificate
5)Update APP Certificate
6)Update openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current
certificate

The certificate password provided by the NetEco 1000S by default is
Changeme_123.

d. When the following information is displayed, the certificate is successfully
replaced.
Update certificate success. 
The old keystore file was backed up in folder 
.\tools\bin\generateCer\backup     

After the certificate is successfully replaced, the old certificate was backed up in folder
NetEco 1000S software installation directory\tools\bin\generateCer\backup.
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4. Effective the new certificate password.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 3 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 5 and press Enter.
0)Quit
1)Change Jetty Certificate Key In Config 
2)Change Modbus/TCP<port:16100>, FTPs Certificate Key In Config 
3)Change Modbus/TCP<port:27250>,Certificate Key In Config
4)Change Email Certificate Key In Config
5)Change APP Certificate Key In Config
6)Change openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
old certificate and press Enter.
Please input old ssl key password:password of the old certificate

d. When the following information is displayed, enter the new password of
the certificate and press Enter.
Please input new ssl key password:new password of the certificate

e. When the following information is displayed, enter the new password of
the certificate again and press Enter.
Please confirm the new ssl key password:new password of the
certificate

f. When the following information is displayed, the password is changed
successfully.
Modification success, please restart the service to take effect.     

Step 3 Optional: Restore the certificate.

When an exception occurs in the new certificate or the old certificate is required,
you can run the following command to restore the certificate to the last status.

1. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 4 and press
Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

2. When the following information is displayed, enter 5 and press Enter.
0)Quit
1)Restore Jetty Certificate 
2)Restore Modbus/TCP<port:16100>, FTPs Certificate 
3)Restore Modbus/TCP<port:27250>,Certificate
4)Restore Email Certificate
5)Restore APP Certificate 
6)Restore openAPI Certificate
Please choose:

3. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current certificate
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4. When the following information is displayed, the certificate is successfully
restored.
Restore certificate success!     

Step 4 Restart the NetEco 1000S for the settings to take effect.

Step 5 Replace the certificate of the NetEco 1000S app in the iOS/Android system. For
detailed operations, see 4.3.4 Replacing App Secure Certificates.

----End

4.3.3.6 Replacing a Certificate for the OpenAPI User Communicating with
the Server

This section describes how to replace the HTTPS protocol certificates
preconfigured for the OpenAPI User communicating with the server.

Prerequisites
● You have installed the NetEco 1000S.

● You are authorized to access the NetEco 1000S installation directory.

● You have applied for a new digital certificate from the Certificate Authority
(CA).

The name of a certificate applied for from the CA may be different from the following
certificate name. Change the certificate name to be the same as the following
certificate name.

– Device certificate: NetEco.cer

– Private key of the device certificate: NetEco_Key.pem

If a password has been configured for the private key of the device
certificate, the password must also be obtained.

– Certificate issued by a subordinate CA: NEPL_PKI.cer (there may be
multiple or no such certificates)

– Root CA certificate: Huawei_Equipment_CA.cer

If the certificate is a .p7b file, you must export the certificate. This section uses the
operations of user.p7b as an example.

1. Double-click the user.p7b to open the certificate.

2. Select the Certificates folder from the Certificates - Current User drop-down list
to expand the folder.

3. Right-click the certificate and choose All Tasks > Export from the shortcut menu.
Click Next in the prompt dialog.

4. Select Base64 encoded X.509(.CER), and click Next.

5. Click Browse, type the certificate file name and the export directory. Click Save.
Click Next.

6. Click Finish.
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Context
● By default, after the NetEco 1000S is installed, the preconfigured certificate

openapi.jks is saved in the NetEco 1000S software installation directory
\WebRoot\WEB-INF\workspace\Certificate directory.

The certificate for enabling SSL has been incorporated to the openapi.jks certificate. When
you enable SSL on the 4.1.8.3.1 Setting Parameters for the Email Server, you do not need
to replace the SSL certificate.

● To replace the digital certificates, you must manually prepare digital
certificates, and replace Huawei certificates with these certificates.

● The password of certificates must be set according to the following
requirements:
– The password contains 8 to 32 characters.
– The password contains three of the following:

n Lowercase letters
n Uppercase letters
n Digits

– The password is advised to contain special characters, which include !"#$
%&'()*+,-./:;<=>?@[\]^`{_|}~ and space.

Procedure
Step 1 Copy the certificates.

Copy the new digital certificates to the NetEco 1000S software installation
directory\tools\bin\generateCer\certificate directory.

Step 2 Prepare new certificates.

1. Copy the contents of NEPL_PKI.cer and Huawei_Equipment_CA.cer to
NetEco.cer.

You can open NEPL_PKI.cer, Huawei_Equipment_CA.cer, and NetEco.cer in text
mode to copy their contents.

2. Generate the certificate file openapi.jks.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 1 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 6 and press Enter.
0)Quit
1)Generate Jetty Certificate 
2)Generate Modbus/TCP<port:16100>, FTPs Certificate 
3)Generate Modbus/TCP<port:27250>, Certificate
4)Generate Email Certificate
5)Generate APP Certificate
6)Generate openAPI Certificate
Please choose:
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c. When the following information is displayed, enter the obtained private
key password and press Enter.
Enter pass phrase for .\tools\bin\generateCer\certificate
\NetEco_Key.pem:obtained password of the private key

d. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter Export Password:password of the new certificate

e. When the following information is displayed, enter the password of the
new certificate again and press Enter.
Verifying - Enter Export Password:confirm the password of the new
certificate

f. When the following information is displayed, enter the password of the
new certificate and press Enter.
Enter pass phrase for .\tools\bin\generateCer\keystore
\neteco.p12:password of the new certificate

g. When the following information is displayed, the certificate file
openapi.jks is successfully created.
Create keystore file success.

3. Replacing the certificate.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 2 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 6 and press Enter.
0)Quit
1)Update Jetty Certificate 
2)Update Modbus/TCP<port:16100>, FTPs Certificate 
3)Update Modbus/TCP<port:27250>, Certificate
4)Update Email Certificate
5)Update APP Certificate
6)Update openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current
certificate

The certificate password provided by the NetEco 1000S by default is
Changeme_123.

d. When the following information is displayed, the certificate is successfully
replaced.
Update certificate success. 
The old keystore file was backed up in folder 
.\tools\bin\generateCer\backup     

After the certificate is successfully replaced, the old certificate was backed up in folder
NetEco 1000S software installation directory\tools\bin\generateCer\backup.
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4. Effective the new certificate password.

a. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 3 and
press Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

b. When the following information is displayed, enter 6 and press Enter.
0)Quit
1)Change Jetty Certificate Key In Config 
2)Change Modbus/TCP<port:16100>, FTPs Certificate Key In Config 
3)Change Modbus/TCP<port:27250>,Certificate Key In Config
4)Change Email Certificate Key In Config
5)Change APP Certificate Key In Config
6)Change openAPI Certificate
Please choose:

c. When the following information is displayed, enter the password of the
old certificate and press Enter.
Please input old ssl key password:password of the old certificate

d. When the following information is displayed, enter the new password of
the certificate and press Enter.
Please input new ssl key password:new password of the certificate

e. When the following information is displayed, enter the new password of
the certificate again and press Enter.
Please confirm the new ssl key password:new password of the
certificate

f. When the following information is displayed, the password is changed
successfully.
Modification success, please restart the service to take effect.     

Step 3 Optional: Restore the certificate.

When an exception occurs in the new certificate or the old certificate is required,
you can run the following command to restore the certificate to the last status.

1. Run the script NetEco 1000S software installation directory\tools
\SSLTools.bat, When the following information is displayed, enter 4 and press
Enter.
1)Generate SSL certificate 
2)Update SSL certificate 
3)Change SSL certificate password 
4)Restore SSL certificate 
Please choose:

2. When the following information is displayed, enter 6 and press Enter.
0)Quit
1)Restore Jetty Certificate 
2)Restore Modbus/TCP<port:16100>, FTPs Certificate 
3)Restore Modbus/TCP<port:27250>,Certificate
4)Restore Email Certificate
5)Restore APP Certificate 
6)Restore openAPI Certificate
Please choose:

3. When the following information is displayed, enter the password of the
current certificate and press Enter.
Please input current ssl key password:password of the current certificate
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4. When the following information is displayed, the certificate is successfully
restored.
Restore certificate success!     

Step 4 Restart the NetEco 1000S for the settings to take effect.

----End

4.3.4 Replacing App Secure Certificates
The app server and app provides the default Huawei-preconfigured certificate for
security connection. This certificate applies only to the commissioning scenario.
Huawei-preconfigured certificate cannot ensure the information transmission
security. When users need to ensure information security, they must apply for a
legal and valid certificate from the CA and replace the preconfigured certificate
with the applied one. The certificate cracking possibility increases if one certificate
is used for a long period. Therefore, replace the certificate periodically.

4.3.4.1 Updating an App Certificate (iOS)

This section describes how to replace the preconfigured certificate of the NetEco
1000S app in the iOS system.

Prerequisites
● The NetEco 1000S app has been installed on your mobile device.

● You have obtained the new digital certificate that is manually prepared.

● You have replaced the app server certificate in the NetEco 1000S System,
which matches with the new certificate in the NetEco 1000S app. For detailed
operations, see 4.3.3.5 Replacing a Certificate for the NetEco 1000S App
Communicating with the Server.

Context

After the NetEco 1000S app is installed, the preconfigured Huawei digital
certificate is used by default. If you do not want to use the preconfigured
certificate, manually replace it with a required certificate.

Procedure

Step 1 Name the obtained new certificate client.cer.

Step 2 Import client.cer to the NetEco 1000S using iTunes.

The operations on an iPhone and iPad are similar. This section uses the operations
on an iPhone as an example.

1. On your PC, connect the mobile device to iTunes.

Figure 4-91 shows the iTunes GUI after the connection.
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Figure 4-91 iTunes GUI

2. In the left navigation tree, choose APPs.
The APPs page is displayed.

3. Select NetEco in the File sharing area of the APPs page, as shown in Figure
4-92.

Figure 4-92 File sharing

4. Click Add file in the NetEco Documents area, and add the client.cer
certificate of the Step 1.
The client.cer certificate has been imported into the iTunes, as shown in
Figure 4-93.
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Figure 4-93 Importing a new certificate

Step 3 Tap the NetEco icon on the mobile client.

The NetEco 1000S app login window is displayed, as shown in Figure 4-94.
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Figure 4-94 NetEco 1000S app login window

Step 4 Click the Set button in the lower right corner of the page to enter the set page.

Step 5 Click Cert Change.

If information showing the certificate replacement success is displayed, the
certificate has been replaced.

Step 6 Restart the NetEco 1000S app to make the new certificate take effect.

----End

4.3.4.2 Updating an App Certificate (Android)

This section describes how to replace the preconfigured certificate of the NetEco
1000S app in the Android system.

Prerequisites
● The NetEco 1000S app has been installed on your mobile device.
● You have obtained the new digital certificate that is manually prepared.
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● You have replaced the app server certificate in the NetEco 1000S System,
which matches with the new certificate in the NetEco 1000S app. For detailed
operations, see 4.3.3.5 Replacing a Certificate for the NetEco 1000S App
Communicating with the Server.

Procedure

Step 1 Connect the mobile device to your PC, and save the obtained new certificate to
the mobile device.

Step 2 Tap the NetEco 1000S app icon on the mobile client.

The NetEco 1000S app login window is displayed, as shown in Figure 4-95.

Figure 4-95 NetEco 1000S app login window

Step 3 Click the Set button in the lower right corner of the page to enter the set page.

Step 4 Click Cert Change.

The page for replacing a certificate is displayed.
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Step 5 Select the new certificate. In the displayed dialog box, click Confirm to complete
the certificate replacement.

Step 6 Restart the NetEco 1000S app to make the new certificate take effect.

----End

4.3.5 Data backup and restoration
dataBase_backup.bat script is executed by the NetEco 1000S automatically to
back up databases and NetEco 1000S software installation directory\WebRoot
directory at 04:00 every day. When NetEco 1000S data becomes abnormal, you
can manually restore the backup file.

Backup
Table 4-28 lists the backup content, backup mode, backup file name, and backup
file save path of the NetEco 1000S data.

NO TICE

You are obligated to take measures, in compliance with the laws of the countries
concerned and the user privacy policies of your company, to ensure that the
personal data of users is fully protected.

Table 4-28 Description of MySQL database backup

Item Description

Backup content ● All data in the MySQL database.
● NetEco 1000S software installation directory

\WebRoot folder.

Backup mode Automatic backup: dataBase_backup.bat script is
executed by the NetEco 1000S automatically to back
up databases and NetEco 1000S software
installation directory\WebRoot directory at 04:00
every day.
After the automatic backup, only two copies of the
backup file in the backup directory are saved. When
more than two copies exist, the earliest copies will be
deleted.

Backup file name YYYY-MM-DD.zip
YYYY-MM-DD is the backup time, for example,
2015-09-16.zip.
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Item Description

Backup file save path The automatic backup files are saved in the following
directories:
● MySQL database: NetEco 1000S software

installation directory\backup\mysqlBackUp
\Backup file name\data directory.

● WebRoot folder: NetEco 1000S software
installation directory\backup\mysqlBackUp
\Backup file name\WebRoot directory.

 

Restoration
When NetEco 1000S data becomes abnormal, you can perform the following
operations to restore the backup file to restore the NetEco 1000S data to the
status upon system backup:

The restoration is recommended only when data is abnormal.

1. Stop NetEco 1000S services.
Right-click the NetEco 1000S service icon in the lower right corner of the
taskbar of the desktop and choose Exit from the shortcut menu.

2. Navigate to the NetEco 1000S software installation directory\backup
\mysqlBackUp directory and decompress the backup file to be restored.
The automatic backup files are named as YYYY-MM-DD.zip, YYYY-MM-DD is
the backup time. The automatic backup files are saved in NetEco 1000S
software installation directory\backup\mysqlBackUp directory. The
WebRoot and data folders are generated after the decompression.

● The WebRoot folder contains data in the NetEco 1000S software installation
directory\WebRoot directory.

● The data folder contains MySQL database data.

3. Restore the backup file.
– Restore the WebRoot file: Delete all files from the NetEco 1000S

software installation directory\WebRoot directory and copy the files
from the WebRoot folder generated after the decompression in 2 to the
NetEco 1000S software installation directory\WebRoot directory.

– Restore database data: Delete all files from the NetEco 1000S software
installation directory\mysql\oms_mysql\data directory and copy the
files from the data folder generated after the decompression in 2 to the
NetEco 1000S software installation directory\mysql\oms_mysql\data
directory.

4. Start NetEco 1000S services.
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4.3.6 Command Reference
This section describes commands for installing, running, and maintaining the
NetEco 1000S system.

For details about the functions of the commands in the third-party component MySQL
database, Java and Openssl used in the NetEco 1000S system, see the corresponding
official websites.

Command names, addresses, and functions of the NetEco 1000S system, as
shown in Table 4-29, Table 4-30 and Table 4-31.

Table 4-29 Command reference (Software Installation)

Command Name Command Address Command
Function

setup.bat NetEco 1000S software installation
directory\setup.bat

Used for installing
the software.

setup_install.bat NetEco 1000S software installation
directory\scripts\setup_install.bat

Used for installing
the software
(system
invocation).

 

Table 4-30 Command reference (manual execution is allowed)

Command Name Command Address Command
Function

ConfigTools.bat NetEco 1000S software installation
directory\tools\ConfigTools.bat

Used for changing
the database
password or
binding the IP of
the server.

SSLTools.bat NetEco 1000S software installation
directory\tools\SSLTools.bat

Used for operating
a certificate.

KeysTools.bat NetEco 1000S software installation
directory\tools\KeysTools.bat

Used for replacing
keys.

Client.bat NetEco 1000S software installation
directory\Client.bat

Used for starting
the NetEco 1000S
client.

startup.bat NetEco 1000S software installation
directory\startup.bat

Used for starting
all the service and
system processes.
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Command Name Command Address Command
Function

autoRecovery.bat NetEco 1000S software installation
directory\uninstall\scripts
\autoRecovery.bat

Used for executing
backup files for
recovery after
upgrading the
NetEco 1000S
fails.

LogTools.bat NetEco 1000S software installation
directory\tools\LogTools.bat

Used for changing
the life cycle of
operation logs .

 

Table 4-31 Command reference (system invocation)

Command Name Command Address Command
Function

UninstallForWin-
dowsControlPanel.
bat

NetEco 1000S software installation
directory\uninstall\UninstallForWin-
dowsControlPanel.bat

Used for invoking
the software
uninstallation.

uninstall.bat NetEco 1000S software installation
directory\uninstall\uninstall.bat

Used for
uninstalling the
software.

setup_uninstall.bat NetEco 1000S software installation
directory\uninstall\scripts
\setup_uninstall.bat

uninstallall.bat NetEco 1000S software installation
directory\uninstall\scripts
\uninstallall.bat

startup.bat NetEco 1000S software installation
directory\bin\startup.bat

Used for checking
if there is an
administrative
authority, then
invoking the
startup_NetEcoTr
ay.bat.

ClientInfo.exe NetEco 1000S software installation
directory\bin\ClientInfo.exe

Used for
discovering the IP
address of the
remote execution
of scripts.

NetEcoUPSService.
exe

NetEco 1000S software installation
directory\bin\NetEcoSUNService.exe

Used for starting
the service-
related .exe file.
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Command Name Command Address Command
Function

startup_NetEcoTra
y.bat

NetEco 1000S software installation
directory\bin\startup_NetEcoTray.bat

Used for starting
the NetEcoTray
service and the
database service.

log4operation.bat NetEco 1000S software installation
directory\tools\bin\log4operation.bat

Used for recording
logs.

7za.exe NetEco 1000S software installation
directory\uninstall\scripts\7za.exe

Used for
compressing and
decompressing
files in .7z and .tar
formats.

alluninstallInner.b
at

NetEco 1000S software installation
directory\uninstall\scripts
\alluninstallInner.bat

Used for
uninstalling all
products.

copy_uninstallall.b
at

NetEco 1000S software installation
directory\uninstall\scripts
\copy_uninstallall.bat

Used for copying
scripts for one-
click uninstallation
to the software
installation
directory.

copyCompInsEnv.b
at

NetEco 1000S software installation
directory\uninstall\scripts
\copyCompInsEnv.bat

Used for copying
extension
packages to an
extension
repository and
copying an
installation disk
framework to the
software
installation
directory.

delete_files.bat NetEco 1000S software installation
directory\uninstall\scripts
\delete_files.bat

Used for deleting
unnecessary files
after the software
is installed.

delete_service.bat NetEco 1000S software installation
directory\uninstall\scripts
\delete_service.bat

Used for deleting
the NetEco 1000S
and database
services and the
shortcut icon
generated when
installing or
upgrading the
NetEco 1000S.
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Command Name Command Address Command
Function

prebackupfile.bat NetEco 1000S software installation
directory\uninstall\scripts
\prebackupfile.bat

Used for copying
source files to a
target location.

process.bat NetEco 1000S software installation
directory\uninstall\scripts\process.bat

Used for checking
whether any
application is in
use under the
target installation
directory.

setup_install.bat NetEco 1000S software installation
directory\uninstall\scripts
\setup_install.bat

Used for installing
the software
(upgrade scene).

ChangeCerKeyPass
word.bat

NetEco 1000S software installation
directory\tools\bin
\ChangeCerKeyPassword.bat

Used for changing
the password of a
certificate.

generateCer.bat NetEco 1000S software installation
directory\tools\bin\generateCer.bat

Used for
generating a new
certificate.

restoreCer.bat NetEco 1000S software installation
directory\tools\bin\restoreCer.bat

Used for restoring
a certificate.

updateCer.bat NetEco 1000S software installation
directory\tools\bin\updateCer.bat

Used for replacing
a certificate.

run.vbs NetEco 1000S software installation
directory\uninstall\scripts\run.vbs

Used for obtaining
more Windows
2008 rights.

NetEco1000S.exe NetEco 1000S software installation
directory\uninstall\jre\jre_win\bin
\NetEco1000S.exe

Used for starting
the NetEco 1000S
process.

NetEcoSUNTray.ex
e

NetEco 1000S software installation
directory\uninstall\jre\jre_win\bin
\NetEcoSUNTray.exe

Used for starting
the system tray.

hiddenKey.bat NetEco 1000S software installation
directory\tools\bin\hiddenKey.bat

Used for not
showing
passwords.

hiddenKey.exe NetEco 1000S software installation
directory\tools\bin\hiddenKey.exe

Used for not
showing
passwords.
hiddenKey.exe is
generated only
after you
manually execute
SSLTools.bat.
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Command Name Command Address Command
Function

delete_shortcut.vb
s

NetEco 1000S software installation
directory\uninstall\scripts
\delete_shortcut.vbs

Invoked by the
delete_service.bat
script
automatically to
delete the
shortcut icon after
uninstalling the
NetEco 1000S.

installNetEcoPost.
bat

NetEco 1000S software installation
directory\uninstall\scripts
\installNetEcoPost.bat

Invoked by the
system
automatically to
initialize
databases after
installing or
upgrading the
NetEco 1000S.

dataBase_backup.
bat

NetEco 1000S software installation
directory\bin\dataBase_backup.bat

dataBase_backup.
bat script is
executed by the
NetEco 1000S
automatically to
back up databases
and NetEco 1000S
software
installation
directory
\WebRoot
directory at 04:00
every day.
The automatic
backup files are
named as YYYY-
MM-DD.zip, YYYY-
MM-DD is the
backup time. The
automatic backup
files are saved in
NetEco 1000S
software
installation
directory\backup
\mysqlBackUp
directory.

fix_mysql.bat NetEco 1000S software installation
directory\mysql\oms_mysql\bin
\fix_mysql.bat

Used for fixing
database table
index problems.
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Command Name Command Address Command
Function

zip_licenseFile.bat NetEco 1000S software installation
directory\bin\zip_licenseFile.bat

Used for loading
the device license.

 

4.3.7 Performance Specifications

Table 4-32 Performance Specifications

Module Function
Description

Performance
Specifications

Specification
Description

Installation
CD-ROM

NetEco 1000S
inverters
management
capacity

● Number of devices:
1860
– Inverter: 1500
– SmartLogger:

300
– EMI and Meter:

30
– PID: 30

● Number of PV
plants: 300
For each PV plant,
the total number of
devices directly
connected to the
NetEco 1000S
cannot exceed 25.

Standard edition

● Number of devices:
12000
– Inverter: 10000
– Optimizer: 2000

● Number of PV
plants: 10000

Enterprise edition
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Module Function
Description

Performance
Specifications

Specification
Description

Database Performance
data storage

The maximum number
of devices whose data
can be collected is as
follows:

● Standard edition:
1860

– Inverter: 1500

– SmartLogger:
300

– EMI and Meter:
30

– PID: 30

● Enterprise edition :
13200

● Inverter: 10000

● Optimizer: 2000

● SmartLogger: 1000

● EMI and Meter: 100

● PID: 100

The relationships
between collection
period and data
storage durations are
as follows:

● 5-minute data of
the EMIs is saved
for one year. 5-
minute data of
other devices is
saved for one
month.

● Data collected on a
15-minute basis is
saved for two years.

● Data collected by
day, month, or year
is saved for 20
years.

Size of a daily
dumped file for each
device: 10 KB
NOTE

● The dumped file
for 5-minute
performance data
of PV plants is
saved to NetEco
1000S software
installation
directory\backup
\PowerdataTransf
er. The file is
named
Plantdaydata_time
stamp.zip.

● The dumped files
for 5-minute
performance data
of inverters are
saved to NetEco
1000S software
installation
directory\backup
\PowerdataTransf
er and NetEco
1000S software
installation
directory\backup
\PMDataTransfer.
The files are
named
Powerdaydata_tim
estamp.zip and
InveterPmdata_ti
mestamp.zip.

● The dumped file
for 5-minute
performance data
of other devices is
saved to NetEco
1000S software
installation
directory\backup
\PMDataTransfer.
The file is named
device
typePmdata_timest
amp.zip.
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Module Function
Description

Performance
Specifications

Specification
Description

Alarm data
storage

Historical alarm log
storage specification:
3,000,000 logs

The system checks
data every early
morning. If the
number of data
records reaches
1,000,000, the
database will dump
the earliest 50,000
records. The dumped
records cannot be
queried on the client.

Active alarm storage
specification: 30,000
logs

The system checks
alarms upon the
reporting. If the
number of alarms
reaches the upper
limit, the earliest
1000 alarms will be
automatically
cleared.

Audit log
storage

Logs in the latest six
months are stored by
default. You can
change the
configuration in the
background.

Logs over six months
earlier will be deleted
automatically.

Number of
database
connections

● Performance
module: 32

● Log module: 16
● Configuration

module: 8
● Common module: 8
● Alarm module: 16

It indicates the
maximum number of
databases that can
be connected with
each module.
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Module Function
Description

Performance
Specifications

Specification
Description

User
management

● Maximum number
of users: 5000

● Maximum number
of concurrent online
users: 3000

NOTE
If multiple users need to
log in to the client, you
are advised to use the
following mode of the
browser for login.
Otherwise, an error may
occur.
● Internet Explorer:

Create a session.
● Chrome 50: Open a

new incognito
window.

● Number of IP
address whitelists:
500

-

Browser Browser of the
following
version is
supported:

● Internet Explorer 11
● Chrome 50

-

Monitor
resolution

Optimal
resolution

1280*1024 The display effect is
the best in this
resolution.

Minimum
resolution

1024*768 All functions are
available in the
resolution higher
than this one.

 

4.3.8 Customizing the Logo on the Home Page of the NetEco
1000S Client

This section describes how to customize the logo on the home page of the NetEco
1000S client based on the actual project information.

Prerequisites
● You have logged in to the NetEco 1000S client. For detailed operations, see

3.1.4 Logging In to the NetEco 1000S Client.
● You have the permission to read and write NetEco 1000S installation path

on the NetEco 1000S server host.
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● You have prepared the customized logo.

Context
The logo in the red box in Figure 4-96 is the default logo on the home page of
the NetEco 1000S. You can customize a new logo as required.

Figure 4-96 Default logo

Procedure

Step 1 Archive the customized logo picture to the NetEco 1000S software installation
path\WebRoot\common\userLogo directory.

The logo picture customized for the NetEco 1000S must meet the following requirements:
● The pixel is 234 x 60.
● The size of the logo picture cannot exceed 5 MB.
● The logo picture supports only the jpg, jpeg, png, and gif formats. You can archive at

most one picture in each format, and the four formats are sorted by priority in
descending order. For example, when the logo pictures in jpeg and png formats are
archived at the same time, replace the logo in jpeg format preferentially.

Step 2 Rename the file archived in the Step 1 LOGO.

The jpeg file is used as an example. The new name of the customized picture is
LOGO.jpeg.

Step 3 Refresh the NetEco 1000S client and observe whether the logo in the upper-left
corner is updated.

----End
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A Abbreviations

F

FE Fast Ethernet

FTPS File Transfer Protocol over SSL

H

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol Secure

K

KPI Key Performance Indicator

N

NMS Network Management System

R

RSA Revist-Shamir-Adleman Algorithm

S

SMTP Simple Mail Transfer Protocol

SSH Secure Shell

SSL Secure Sockets Layer

SFTP Secure File Transfer Protocol

T

TLS Transport Layer Security

TCP Transmission Control Protocol

V

VLAN Virtual Local Area Network
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